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LEARNING TO USE 
THE VISIWORD™ PROGRAM 

The VisiWord™ program is as easy to learn as it is to use. You 
have at your command a set of four important learning tools: 

The VisiWord Help Instructions 
The VisiWord QuickStart™ Course 
The VisiWord User's Guide 
The VisiWord Pocket Reference 

Figure A shows you how each of these tools should be used for 
maximum efficiency and effectiveness. 

Necessary 

VisiWord Help Instructions 
On Screen Instructions 
Select ?~HELP 

VisiWord OuickStart'" Course 
Teaches Basic Features Ouickly 
o Entering Text • Saving a Document 
o Editing Text • Printing a Document 

VisiWord User's Guide 
• Go directly to the Unit for the task you want to do and for 

details on how to do it. 

Optional 

• Practice editing and formatting sample documents. 

• Find information on printers, other Visi products, error 
messages, useful facts, and startup settings. 

• Find any topic in the User's Guide or any special term. 

VisiWord Reference Card 
• Quick Refresher of Program Options 

Figure A. The VisiWord™ Learning Tools 
021-001 
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THE VISIWORD HELP INSTRUCTIONS: The VisiWord program 
is self-teaching. You can ask to see help instructions on the screen 
at any point. Simply select? = help from the list of options 
(choices) you have. The help instructions may be all you need to 
learn the program. You can experiment using the help instructions 
to get started on your own memos or letters. You won't hurt the 
program! 

THE VISIWORD QUICKST ARTTM COURSE: For a short struc­
tured approach to learning the program, you should use the 
VisiWord QuickStart Course. You will be productive (create your 
own memo, edit it, do elementary formatting, and print it) in a 
very short time. Together with the help instructions of the pro­
gram, this short course should be enough to comfortably start you 
on your own. You do not need to read the User's Guide, except 
for clarifying points, for more practice, or for more advanced 
features of the program. 

THE VISIWORD USER'S GUIDE: The User's Guide is not 
intended to be read sequentially. Each chapter is a collection of 
related topics; for example, Chapter 5 has all of the topics related 
to formatting your document. Each unit in a Chapter is task­
related and is self-contained; for example, "Using the Ruler" in 
Chapter 5 contains all you need to know to change your right 
margin setting, to set required indents, and to change Ruler stops. 
You can go' directly to "Using the Ruler" without reading any 
other chapter or unit. 

THE VISIWORD POCKET REFERENCE: This reference card sum­
marizes what the VisiWord program does. Use this card any time 
you want to refresh your memory about any VisiWord operation. 

ORGANIZA TION OF THE VISIWORD 
USER'S GUIDE 

The VisiWord User's Guide has seven chapters, six appendices, 
and a combined index and glossary. The chapters have self­
contained units that you can read when you need or want specific 
information. Each unit gives a complete description of a specific 
task you want to do. 

CHAPTER 1: "About This Program" is an overview of the 
VisiWord program. It describes the equipment you need and the 
basic features of the VisiWord program. 

CHAPTER 2: "Basic Information" shows you how to load the 
VisiWord program and describes the VisiWord menus, the editing 
screen, the program help instructions, the VisiWord special keys, 
and how to initialize (format) disks for storing your documents. 



Learning the VisiWord Program xiii 

CHAPTER 3: "Working With Documents" describes how to load, 
save, delete, and rename documents, and how to insert one docu­
ment into another (include), ~nd add one document to another 
(append). 

CHAPTER 4: "Editing Documents" describes how to enter, delete 
and restore text; move and copy text; search for and replace 
characters; and split the screen into two windows. 

CHAPTER 5: "Formatting Documents" describes how to set 
margins, lines per page, line and character spacing, and headers 
and footers; justify (align the right margin); set tabs; indent and 
center text; and highlight characters. 

CHAPTER 6: "Printing Documents" describes how to print 
directly or print while continuing to type (spool); print a docu­
ment to a disk; stop the printer temporarily; change print formats; 
and send special instructions to the printer. 

CHAPTER 7: "Sample Applications" is different from chapter 1 
through 6. This chapter is for practice editing and formatting. The 
sample applications give you two-page illustrated examples of 
ways you can edit and format your own documents. Brief instruc­
tions show you how each part of a document was created using 
the VisiWord program. Use these illustrated examples for quick 
reference on how to achieve a special effect for your document. 

The Appendixes cover related topics, such as, special printers 
(Appendix A), using the VisiWord program with the VisiFile™ 
-program (Appendix B) and with the VisiCalc® program (Appendix 
C), error messages (Appendix D), useful facts you may want to 
have about the VisiWord program (Appendix E), startup settings 
that you can change (Appendix F) and procedures to use if you 
wish to create large documents (Appendix G). 

The Index/Glossary is especially useful for finding any topic 
quickly or for finding the meaning of special terms used in the 
manual. 
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TEXT REFERENCES TO THE KEYBOARD 
AND THE SCREEN 

The keys that you type appear in 'the manual in boldface type. If 
the first letter of a choice (option) appears in bold, it means that 
you can type that letter to select that option. 

Note: 

If you don't want to type the first letter of the option to select it, 
you can also move the cursor and use the c;:D key to select it 
(see Unit 2, Chapter 2 for details), 

For some keys, such as Esc, the special font ~ will be used. 
This means that you should press that key, not type the sequence 
of letters. 

This manual represents the keyboard symbols as follows: 

Key Meaning Manual Representation 

<- backspace (B K S P) 

.J Enter c;:D 

~ tab G:l 
t up arrow OJ 
t down arrow rn 
<- left arrow G 
---> right arrow G 
.0- shift (SHIFT) 

The characters that you see on the screen appear in this manual in 
light type. 
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About This Program 

Chapter Outline 
Overview .............................................. 1-3 

Equipment You Need ................................... 1-4 
Handling Disks ...................................... 1-5 
The Keyboard ....................................... 1-6 
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OVERVIEW 
The VisiWord program is a word processor designed to help you 
write, edit, and format documents quickly and efficiently. A 
VisiWord document consists of both text and simple formatting 
instructions. Figure 1-1 shows the relationships between the text 
and the formatting instructions that make up a document. 

• :.=::':,::..-' ........ ~ -" .... _ .... -'" 

. :.=::-._ .. " .. _.-............ _.-

___ n,' 

.. 

Formatted Document 
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Figure 1-1. A VisiWord™ Document 

The VisiWord program lets you do complex word processing 
functions simply. On-screen help text and descriptive messages 
make the VisiWord program easy to learn. You don't need to 
memorize keystroke combinations. Single keystroke editing and 
formatting functions make the program easy to use. The program 
is. designed to make you feel comfortable using it in the briefest 
time. Table 1-1 describes the key VisiWord features and their 
benefits to you. 
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Table 1-1. VisiWord™ Features and Benefits 

Feature 

Descriptive command menus with 
on-screen help instructions. 

Single key commands for cursor 
movement, inserting, deleting, 
tabbing, indenting, and centering. 

Automatic text formatting for 
margins, headers and footers, page 
numbers, justification, centering, 
and text highlighting. 

Large or small text moving, 
copying, or deleting. 

Simultaneous viewing of two 
sections of the same document or 
of two different documents. 

Simultaneous printing of one 
document while editing another 
(spooling). 

Global or selective search and 
replace. 

Putting documents together. 

Equipment You Need 

Benefit 

You learn what you need when 
you need it. 

You create and revise documents 
quickly and efficiently. 

You get professional document 
appearance with minimum effort. 

You rearrange your document 
with no special formatting. 

You compare and contrast 
documents and formats for 
combining or separating them. 

You save valuable time. 

You make tedious corrections 
simply and quickly. 

You put one file into another or 
one after the other to create larger 
documents. 

The VisiWord program requires the following equipment: 

C) An IBM Personal Computer or an IBM Personal Computer 
XT with at least 192K of memory. 

o An IBM Disk Operating System (DOS) disk version 1.1 or 
2.0. 

o At least one disk drive. 

o A video monitor (color or black-and-white). 

o A printer. 

o The VisiWord program disk. 

o At least one blank 5 114" flexible disk if you have only flex­
ible disk drives. 
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Note: 

If you have a single disk drive system, you must change the 
Document Path and Spool Path startup settings to drive A. See 
"Single Drive Systems" in Appendix F for details. 

In addition, the following optional equipment can increase your 
word processing effectiveness: 

G Additional disk drives. 

G Additional memory. 

Although the above equipment can be used with the VisiWord 
program, the following equipment is considered the standard 
equipment. When you first load the program, it has certain 
startup settings. These startup settings are based on the standard 
equipment configuration. (See Appendix F to change startup set­
tings for nonstandard equipment.) 

o An IBM Personal Computer with 192K of memory. 

o Two disk drives. 

o An IBM Monochrome Display. 

I) An IBM 80-Character-Per-Second Matrix Printer. 

Note: 

If you installed the VisiWord program on a hard disk (see the 
VisiWord Setup Information Guide), the startup settings were 
automatically set to the drive letter of that hard disk. 

Handling Disks 
You can't be too careful with your flexible disks. Each disk is 
magnetically coated and sealed in a protective square plastic 
cover . You can see the magnetic surface of the disk through the 
oval cutout in the square cover. 

Never touch the exposed magnetic surface with your fingers or 
any implement. Protect disks from dust by storing them in the 
paper sleeves. Do not store them within six inches from magnetic 
fields generated by a TV, speakers, or other magnetic devices. 
Temperature extremes (such as in a car trunk on a warm day) 
destroy disks. 

Never fold, bend, or staple a disk. Do not write on the square 
plastic cover with a hard pen or pencil (use only the soft felt tip 
pens). Store disks in a special disk binder or disk case. 



1-6 Chapter 1. About This Program 

The Keyboard 
Most of the characters on the keyboard are self-explanatory. 
However, a few keys need more explanation. Also, to help you 
remember the special function key operations, be sure the 
VisiWord Function Key Overlay supplied in this package is over 
the function keys pad (CETI through c:EIID) at the left side of the 
keyboard. Figure 1-2 shows the IBM keyboard and the keys that 
the VisiWord program uses for special purposes. 

Note: 

The VisiWord program does not use the ( C T R L ) key, the 
c::AIT) key, or any combination of these keys with any other 
key. If you use these keys the program does not respond. 

VISIWORDTM 
CVisiCorp 1982 

Figure 1-2. The IBM® Keyboard 
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WARNING: 

DO NOT PRESS THE (N U M L 0 C K) KEY. PRESSING 
( N U M L 0 C K ) DEACTIVATES THE ARROW KEYS, THE 
( HOM E ) KEY, THE ~ KEY, THE ( P G Up) AND 
( P G D N ) KEYS. IF YOU TRY TO USE ANY OF THESE KEYS 
AFTER PRESSING ( N U M L 0 C K ), EITHER THE NUMBER 
PRINTED ON THE KEY APPEARS OR THE COMPUTER 
BEEPS. TO REACTIVATE THE ABOVE KEYS, PRESS 
( N U M L 0 C K ) AGAIN. 

Required 
return 

Backspace 

Move to 
beginning of 
line/screenl 
document 

Move to 
next screen 

Move to 
end of line/ 
screen/ 
document 

Insert 
Over·Type 
key 

Delete 
character 

021003 
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UNIT 1 
LOADING THE VISIWORD PROGRAM 

Loading the VisiWord program puts it into the computer memory. 
When the program is in memory, you can do any VisiWord 
operation. When you turn off the computer or leave the program 
to use another programi the VisiWord program is no longer in 
memory. 

If you installed the VisiWord program on a hard disk {refer to the 
VisiWord Setup Information Guide}, follow these steps to load the 
program: 

1. Load the DOS program from your hard disk. If you do not 
know how to load the DOS program, see the instructions in 
the IBM Disk Operating System Manual. 

2. The C> prompt appears. If you installed the DOS program 
onto a different hard disk drive {named d:, e:, or the like}, 
that drive letter shows in place of the C. 

3. If you installed the VisiWord program in its own directory on 
the hard disk, use the CHOIR command to transfer into that 
directory. 

4. Type vw and press GIl. 

To load the VisiWord program from the flexible disk, follow these 
steps: 

1. Load your DOS disk. If you do not know how to load your 
DOS disk, see the instructions in the IBM Disk Operating 
System Manual. The screen displays A> when ready. 

2. Remove the DOS disk, return it to its protective sleeve, and 
replace it with the VisiWord program disk in drive A. Close 
the drive door firmly. 

3. Type vw and press GIl. 

The VisiWord program loads automatically. 
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When the program is loaded, your screen should look like Figure 2-1. 

Figure 2-1. The VisiWord™ Screen After Loading 

WARNING: 

IF YOU LOADED THE VISIWORD PROGRAM FROM DRIVE 
A, LEAVE YOUR VISIWORD PROGRAM DISK IN DRIVE A 
UNLESS OTHERWISE INSTRUCTED. THE ENTIRE PRO­
GRAM IS NOT LOADED INTO MEMORY AT THE SAME 
TIME. IF YOUR PROGRAM DISK IS NOT IN DRIVE A, 
YOU WILL HAVE TO SWITCH DISKS TO DO CERTAIN 
ACTIONS. 

021-001IP 
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Menus 2-5 

A menu is a list of optional tasks that a program can do. In the 
VisiWord program, the menu appears at the bottom of the screen. 
You can choose an option from the menu to do a word-processing 
task or to go on to another menu. Figure 2-2 illustrates the 
VisiWord menu structure. 





Text 
Column 
Memory 

Text 
Column 

Initial Menui 

Create 
·"~~~i~e/i 

Text 
Column 

Format 
Ruler 
Header 
Footer 
Append 
Message 
Char 

Next 
Prev 
Replace 
All-replace 
Define-

replacement 
Ignore 
Exact 

Emphasis 
Underline 
Above 
Below 
Overstrike 
Hyphen 
1 
2 
3 
4 

Open 
Close 
Switch 
Z=Clear 

Printer 
Disk 
Spool 
Format 
Model 
Path 

Figure 2-2_ VisiWord™ Menu Structure 

Load 
Save 
Include 
Append 
Maintenance 

VisiSpeWM 

List 
Path 
Delete 
Rename 
Initialize 
Usage 

Menus 
Keys 
Quit 

2-7/2-8 

Start-new­
product 

Retu rn-to-cu 
product 

Exit-to-system 

021004 
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Most VisiWord menus have two or more menu options, the 
? = help option, and the Quit option. The line above the menu 
gives the menu path, and a brief description of the menu option 
that is highlighted. The menu path shows you what menu options 
you selected to get to the current menu. From the editing screen, 
you always start from the Main menu (VW). For example, the 
menu path VW / P r in t means that from the Main menu you selected 
Print to reach the current menu, the Print menu. Figure 2-3 uses 
the Print menu to show the typical elements of a menu. 

A brief description 

name option 
L Prompt message: 

Menu ~ of the highlighted 

---------- ----~----------------------, 
VW/Print: Print the document on a printer 

fl Printer Disk Spool Format Model Z=Path ?=help Quit 

L Menu 7 ~ options Help option: Quit option: 
Explains menu Return to 
options previous menu 

021·005 

Figure 2-3. A Typical VisiWord™ Menu: The Print Menu 

A menu is active when one of its options is highlighted with 
inverse video (dark characters on a light background). The 
highlighted area is called the menu cursor. The menu cursor is on 
the first option in the list, or on the option you used last. 

SELECTING A MENU OPTION 
When you select a menu option, you make the program go to 
another menu or do a task; for example, selecting Print from the 
Print menu prints your document. 

You can select a menu option in two ways: 

• Type the first letter of the option. The menu cursor can be on 
any option in the menu. 

• Use the G and G keys to position the menu cursor on the 
option you want ; then press GIl. 
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You can select a menu option either way. Either method causes 
the program to do the same thing. For example, selecting Delete 
from the Main menu, displays the Text, Co lumn, and Memory 
options regardless of the method you use to select Delete. In this 
manual, the word select means to use one of these two methods to 
choose an option. Also, in this manual, the first letter of the 
option appears as bold, corresponding to the letter you can type 
to select the option. 

At first, you might find it easier to learn the program by using the 
arrow keys because you can read the line above the menU for each 
option description. After you become familiar with the options, 
you can increase your speed and save time by typing the first 
letter of the option. 

ENTERING AND LEAVING A MENU 
From the editing screen, you enter the Main menu by pressing 
~. Once you are in a menu, you can enter another menu by 
selecting an option. Or you can return to the editing screen by 
pressing ~ again. For example, if you select Print from the 
Main menu, you enter the Print menu. If you press ~ from 
the Print menu, you return to the editing screen. 

You leave a VisiWord menu, except the Main menU, by selecting 
Quit. When you select Quit, you return to the menu that has the 
current menu as one of its options. For example, if you select Quit 
from the Print menu, you return to the Main menu. You leave the 
Main menu by selecting Exit. 

The VisiWord program lets you change document settings by fill­
ing out special document sheets and by changing the Ruler (see 
Chapter 5 "Formatting Documents" for details). When you are 
finished filling out a Format, Header, Footer, Append, or Message 
Sheet, you press ~ and the cursor moves to the menu. Press­
ing ~ again moves the cursor to the editing screen. Pressing 
~ from the Ruler, moves the cursor directly to the editing 
screen. 



Editing Screen 2-11 

UNIT 3 
THE EDITING SCREEN 

After you load the program, you select Create to reach the editing 
screen. The editing screen is where you enter text, edit text, and 
view the format of your text. Figure 2-4 shows a blank editing 
screen. 

~ ~ 
'------------~~ ~---------=--~ 

® 

CD Shadow Cursor 

CD Stops for tabs, indents, and decimal tabs 

® Center of Ruler 

CD The Ruler 

® End of document marker 

® Border for special characters 

CD Can insert text without erasing 

® Line indicator for cursor 

® Main menu 

@) Border for special characters 

® Text cursor 

Figure 2-4. The Editing Screen 

021002IP 
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The editing screen is 80 columns wide and 22 rows deep. The first 
column (column 1) and the last column (column 80) cannot be 
used to enter text because they are used by the program to display 
special symbols (see Table 2-1). These columns appear in inverse 
video and are called the border. 

Special symbols appear in the border on the editing screen. These 
symbols indicate format options you have chosen or that text is 
off the screen. Table 2-1 lists the symbols, their location, and their 
meaning on the screen. 

Table 2-1. Editing Screen Border Symbols 

Symbol 

< 

> 

•••••••• 

•••••••• 

e 

Screen Location 

column 1 

column 80 

column 80 

columns 1 through 80 

columns 2 through 79 

column 1 

column 80 

columns 2 and 79 

appears in the column 
you were in when you 
pressed~, the 
Indent key 

Meaning 

More text is off the 
screen to the left. 

More text is off the 
screen to the right. 

Required Return 
(ends the line). 

Page Break (generated 
by pressing New Page 
key (EID): starts a 
new page after this 
symbol. 

Page Break (generated 
by the program): 
starts a new page after 
this symbol. 

Format Sheet, Ruler, 
Header jFooter Sheet, 
Append Sheet, or 
Message Sheet settings 
take affect from here 
till the next sheet or to 
the end of the docu­
ment. To see which 
settings are in effect, 
select Layout and 
look at the line above 
the menu for the 
indicators F R H A 
orM. 

End of Document. 

Centered text. 

Indicates that test will 
be indented to the 
next stop on the 
Ruler. New lines of 
text continue to indent 
till you press GIl. 
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UNIT 4 
THE HELP INSTRUCTIONS 

The VisiWord program provides on-screen help messages that give 
you important information or instructions on how to use the 
VisiWord program. These help messages are displayed: 

• on the initial VisiWord screen to get you started, 

• in the prompt messages that describe on the line above the 
menu what the highlighted menu option does, 

• on separate help screens that you select as an option in a 
menu to get instructions on how to do various tasks. 

If you need help with any menu, select? =help. The help instruc­
tions for that menu are displayed. At the bottom of each help 
screen are the Men us, Key s, and [} u it options. You select these 
options as you do any VisiWord option. 

Men us 

Keys 

[} u it 

Displays an overview diagram of all 
VisiWord menus. Use this screen to see 
where any option or menu is located and 
how you can get to it. 

Displays what each VisiWord special key 
does. 

Returns you to the menu you were in when 
you selected? = help. 
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UNIT 5 
THE SPECIAL FUNCTION KEYS 

You can perform many VisiWord functions by pressing one key. 
Table 2-2 lists each function key, the special function, and a brief 
description of what each function does. 

Table 2-2. Table of Special Function Keys 

Key Function 

CED Decimal Tab 

CUJ Again 

c:r:::ID New Page 

c:£I) Indent 

Delete Line 

Delete to End of Line 

Underline 

Undelete 

Center Line 

Description 

Aligns a column of 
numbers at the 
decimal point. 

Repeats the last 
function. 

Inserts a page break to 
begin the next line on 
a new page. 

Indents text to the 
next stop and con­
tinues indenting lines 
until the next required 
return. Text formats 
automatically. 

Deletes the line the 
cursor is on. 

Deletes from the cur­
sor to the end of the 
line and reformats 
subsequent text if 
necessary. 

Underlines the 
character the cursor is 
on/Removes the 
underline if already 
underlined. 

Restores deleted text. 

Centers the line the 
cursor is on/Returns 
the line to the left 
margin if already 
centered. 
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Key Function Description 

~ Return to Editing Returns the cursor 
Screen/Move to Menu directly to the editing 

screen from a menu, 
or moves the cursor 
from the editing 
screen to a menu. 

Gl Tab Moves the cursor to 
the next stop to the 
right. 

(B K S P) Backspace Deletes the character 
to the left of the 
cursor. 

CJ) Required Return Stops text wraparound 
and moves cursor to 
the beginning of the 
next line. 

o:NID Insert / Over-Type Insert adds text to 
existing text/Over-
Type types over and 
erases existing text. 

( HOME) Home Pressing Home once 
moves the cursor to 
the beginning of a 
line, twice moves the 
cursor top-left corner 
of the screen, and 
three times moves the 
cursor to the begin-
ning of a document. 

CE:N::ID End Pressing End once 
moves the cursor to 
end of a line, twice 
moves the cursor to 
the last character on 
the screen, and three 
times moves the cur-
sor to the last char-
acter in a document. 

(P GO N) Next Page Displays the next 
screen of text on the 
screen. 

(p G UP) Previous Page Displays the previous 
screen of text on the 
screen. 

OITD Delete Character Deletes the character 
at the cursor. 
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Notes: 

The (IT) key is not used by the VisiWord program. If you 
press (IT), the computer beeps. 

The Again key, ct:2J, can be used to repeat character attributes 
or searches for words. For additional 'information, see 
"Highlighting" in Chapter 5 or "Looking For Characters, Words 
of Phrases" in Chapter 4. 

The Insert/Over-Type, Center Line, and Underline keys switch 
between two functions depending on their current meaning to 
the program. 

If the screen displays INSERT on the line above the menu, press­
ing c::rNID changes INSERT to OVER-TYPE and allows you to 
type directly over existing text. If the screen displays OVER-TYPE 
on the line above the menu, pressing c::rNID changes a V E R -TY P E 
to INSERT and allows you to add new text without erasing ex­
isting text. Insert and Over-Type are active only on the editing 
screen. 

If you type a line of text, and press CEI::QJ (the Center Line 
key), the line is centered. If the line is already centered and you 
press CEI::QJ, the line returns to the left edge of the screen. 

If you put the cursor on a character and press CEID (the 
Underline key), the character is displayed in inverse video ( a 
dark character on a light background) and will be underlined 
when printed. If the character is already underlined and you 
press CEID, the character is displayed in normal video and will 
not be underlined when printed. 
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UNIT 6 
PREP ARING DOCUMENT DISKS 

(INITIALIZING) 

MENU PATH: VW/Storag e/Ma i ntenance/ln iti a I i ze 

To store your documents, you need to use a document disk. If 
you installed the VisiWord program on a hard disk, you can use 
the hard disk for your document disk. The hard disk is already in­
itialized. 

Before you can use a flexible disk to store VisiWord documents, 
you have to initialize it (format it for storing data). You initialize 
a flexible disk with the Initialize option on the Maintenance menu. 
This option performs a similar function to the IBM DOS Format 
command. Therefore, you can use any disk that has been format­
ted uSing IBM DOS to store documents. 

Note: 

The Initialize option formats the flexible disk according to the 
drive the document disk is in when the command is issued. You 
should remember what type of drive that is. It can be either a 
single-sided drive or a double-sided drive. Disks initialized on a 
double-sided drive do not work on a single-sided drive. 

WARNING: 

IF YOU INITIALIZE A DISK THAT ALREADY CONTAINS 
DATA, YOU WILL LOSE ALL OF THE DATA ON THAT 
DISK. 

To initialize a flexible disk, follow these steps: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Storage. The editing screen 
clears, and the Storage menu appears. 

3. Select Maintenence. 

4. Select Initialize. 
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5. Type the letter of the drive you want to use followed by a 
colon (:), then GJ), for example, b: GJ). 

6. Put the disk to be initialized in that drive, and select Yes. 

7. If the disk has already been formatted, you are asked if 
you want to continue. Select No to return to the 
Maintenance menu. Select Yes to initialize the disk. 

The initialization process begins. When initialization is completed, 
the screen displays the Maintenance menu. Press ~ to return 
to the editing screen or select Quit twice to return to the Main 
menu. 
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UNIT 7 
LEAVING THE VISIWORD PROGRAM 

MENU PATH: VW/ExitlExit-to-system 
VW lEx i tiS ta rt- n ew- p ro duct 

When you are finished using the VisiWord program, you can 
leave it and begin a new program without turning off the com­
puter. You do this using the Exit menu. 

If you want to return to IBM DOS: 

1. From the editing screen, press ~. 

2. From the Main menu, select Exit. The editing screen 
clears. 

3. From the Exit menu, select Exit-to-system. The screen clears, 
and the DOS prompt A > (or the hard disk drive letter 
followed by » appears. In rare cases, a message may appear 
that tells you to insert a DOS disk or a COMMAND.COM 
disk in drive A. Both messages refer to a disk with DOS on it. 
Follow the instructions on the screen. 

If you want to start another program: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Exit. 

3. Select Start-new-product. 

4. Remove your VisiWord program disk from drive A, and 
replace it with another program disk (for example, the 
VisiCalc® program) or IBM DOS. Press ~. 

The program that you put in drive A loads automatically. 

Note: 

If the disk you put in drive A has not been made self-loading 
(for example, you cannot put the disk in drive A and load the 
program without loading IBM DOS first), you are prompted to 
insert your IBM DOS disk into drive A. 
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If you decide you want to return to the VisiWord program instead 
of exiting, select Return-to-current-product from the Exit menu. 
The editing screen and Main menu appear. If you had a document 
on the screen when you selected Exit, it too reappears. 
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UNIT 1 
CREATING A NEW DOCUMENT 

MENU PATH: VW/Create 
VW/De lete/Memory 

You create a new document simply by typing it on the editing 
screen. You can use any of the VisiWord formatting or editing 
functions as you type. For details on a specific function, see the 
appropriate unit in this manual. 

The VisiWord program gives you startup format settings that are 
in effect when you load the program. The VisiWord program 
startup settings for your document are: 

o Line spacing is single spaced. 

e Text is not justified (not aligned at the right margin). 

o You get 10 characters per inch. 

o Your first page will print starting at page 1 if you set a header 
or footer page number symbol. 

" Your document will print 50 lines per page. 

o Your document's right margin is set at 65. 

o Your document's Ruler stops (1) for tabbing, indenting, and 
decimal tabbing are set every 5 columns up to column 45. 

You can change any or all of these settings now or after any 
required return (See Chapter 5 or Appendix F for details). Or, you 
can accept these settings by simply proceeding to type. 

To create a new document at the beginning of an editing session: 

1. Load the VisiWord program. See "Loading the VisiWord Pro­
gram" in Chapter 2 for details. 

2. From the Initial menu, select Create. The editing screen 
appears. 

3. Type, edit, and format your document. 
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To create a new document during an editing session, you must 
first clear computer memory, then type the document. To do this: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Delete. 

3. Select Memory. If you have already saved your document, the 
screen clears. If not, you are prompted to save it. 

4. If you want to save your document, select Yes. (See the 
instructions in "Saving A Document" in the following 
section). If not, select No. The screen clears. 

5. Type your document. (If you have a long document, save it 
periodically in case a power failure occurs.) 

The new document is created. If you turn off the computer or 
clear the memory, the document you created is gone. Save the 
document on disk if you want to use it again in the future. To 
save it, see the following section, "Saving A Document." 
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UNIT 2 
SAVING A DOCUMENT 

MENU PATH: VW/Storage/Save 

Saving your document puts it safely on your document disk where 
you can retrieve it at any time. When you type, you are entering 
characters into computer memory. You can lose your document if 
you clear the memory (Delete/Memory), turn off the computer, or 
have an accidental power failure. Saving your document as you 
type it, change it, or finish it is simply good practice. Do it 
periodically. 

Note: 

If you have a single drive system, you must change the Docu­
ment Path and the Spool Path startup settings to disk drive A. 
See "Single Drive Systems" in Appendix F for details. 

In the VisiWord program, every document you save must have a 
name which is used to identify the document to the computer. A 
name can have: 

• Up to 8 characters followed by a period (.) and an optional 3 
character extension. 

• The letters a through z in upper, lower, or upper and lower 
case. 

o The digits 0 through 9. 

Upper-case letters and lower-case letters are treated as the same 
letter. For example, Memo.ext and memo.ext refer to the same 
document. If you supply a name that contains too many 
characters, the program automatically corrects it for you. For 
example, if you give memorandum.out as your name, the pro­
gram corrects it to be memorand.out. 
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Your document will be saved on the disk in drive B or on the 
hard disk drive on which you installed the program unless you 
specify another drive as the Document Path (see Appendix F for 
details), or select Type-In (in step 5 below) and prefix the docu­
ment name with a disk drive name. 

For example, C:MEMO 

T .... 1 _____ Document name 

1 .... ________ Disk drive name 

WARNING: 

YOU CANNOT SAVE TWO DOCUMENTS USING THE 
SAME NAME. IF A DOCUMENT ALREADY HAS A NAME, 
AND YOU STORE ANOTHER DOCUMENT USING THAT 
NAME, YOU DELETE THE ORIGINAL DOCUMENT FROM 
THE DISK. THE VISIWORD PROGRAM DOES NOT 
AUTOMATICALLY SAVE THE NEW DOCUMENT IN PLACE 
OF THE OLD DOCUMENT. THE PROGRAM FIRST ASKS IF 
YOU WANT TO REPLACE THE CONTENTS OF THE 
ORIGINAL DOCUMENT. 

If you want to save both the original document and the updated 
version, give the updated document a name different from the 
original. Numbering successive versions of the same document lets 
you keep track of revised documents; for example, agenda 1 and 
agenda2. 

To save a document: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Storage. The editing screen clears, 
and the storage screen appears. The storage screen shows you 
the Document Path (the drive the computer uses for any 
document disk operations), Spool Path (the drive the com­
puter uses temporarily for storing your document if you want 
to print a document while doing other VisiWord functions), 
and the current document name. If you decide not to save the 
document and return to the editing screen, press ~. 

3. Select Save. 
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4. If the document you want to save was saved previously, the 
program displays its name. If no name is displayed, go on to 
step 5. If a document name is displayed, the program asks if 
you want to save your document using that name. If you 
select No, go on to step 5. If you select Yes, the program asks 
if you want to overwrite the existing file. If you select Yes 
again, the new document is saved immediately, overwriting 
and erasing the old document. If you select No, the Storage 
menu appears. 

5. If no document name is displayed or you don't want to use 
the name of the document that is displayed, two options 
appear: List and Type-In. Use Type-In if you are naming a new 
document. Use List if you want to use a name that is already 
on the disk. 

a) If you select List, use the CD and CIJ keys to put the cur­
sor on the name you want from the list. Use the ( P G UP) 
and ( P G 0 N ) keys to see a list that is longer than one 
page. Press GD to choose the name, or press ~ to 
return to the menu without selecting a name. 

b) If you select Type-In, type the name of the document, and 
press GD. 

6. If a document exists with the name you chose, you must 
verify that you want to use the name. If you select No, the 
document is not saved, and you are returned to the Storage 
menu. If you select Yes, the document is saved, and you are 
returned to the Storage menu. 

Select Quit to return to the Main menu or press ~ to return 
to the editing screen. The document will remain on the editing 
screen until you clear the screen with Delete/Memory or turn off 
the computer. 
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UNIT 3 
LOADING A DOCUMENT 

MENU PATH: VW/Revise 
VW/Storage!Load 

Before you can use a document saved on a disk, you have to put 
it into the computer's memory using the Load option. Putting the 
document into memory does not remove it from your disk. You 
can load a document immediately after you load the program or 
from the editing screen. 

Loading a document: 

• Clears the current document from memory, 

• Puts the new document into computer memory, 

• Enters the new document name as the name of your file for 
the Save option. 

Note: 

The document you want to load may be too large for the 
VisiWord program. If it is, the program warns you, and then 
only loads as much of the document as possible. Although you 
cannot use the rest of the document, no data is lost. 

In the VisiWord program, every document must have a name 
which is used to identify the document to the computer. These 
names can be: 

• Up to 8 characters followed by a period (.) and an 
optional 3 character extension. 

• Any letters a through z in upper, lower, or upper and 
lower case. 

• Any digits (2) through 9. 
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Upper-case letters and lower-case letters are treated as the same 
letter. For example, Memo.ext and memo.ext refer to the same 
document. If you supply a name that contains too many 
characters, the program automatically corrects it for you. For 
example, if you give memorandum. out as your name, the pro­
gram corrects it to be memorand.out. 

Your document is loaded from the disk in drive B or from the 
hard disk drive on which you installed the program unless you 
specify another drive as the Document Path (see Appendix F for 
details), or select Type-In (in step 2 below) and prefix the docu­
ment name with a disk drive name. 

LOADING FROM THE INITIAL MENU 
To load a document immediately after you load the program: 

1. From the Initial menu, select Revise. 

2. Two options appear: List and Type-ln. 

a) If you select List, use the CD and CD keys to put the cur­
sor on the name you want from the list. Use the ( P G UP) 
and ( P G 0 N ) keys to see a list that is longer than one 
page. Press GIl to choose the name, or press CITQJ to 
return to the menu without choosing a name. 

b) If you select Type-In, type the name of the document, and 
press GIl. 

3. When you have chosen a document, the Storage menu 
appears. Press CITQJ. 

The document is loaded into memory and appears on the editing 
screen with the cursor in the upper-left corner ready for editing. 
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LOADING FROM THE MAIN MENU 
To load a different document when you are actively using the 
editing screen: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Storage. The editing screen clears, 
and the storage screen appears. The storage screen shows you 
the Document Path (the drive the computer uses for any docu­
ment disk operations), the Spool Path (the drive the computer 
uses temporarily for storing your document if you want to 
print a document while doing other VisiWord functions), and 
the current document name. 

3. Select Load. If you have already saved the document, go to 
step 4. If you have not saved your document, you are asked if 
you want to continue with the load. If you select Yes, go on to 
step 4. If you select No, the Storage menu reappears so you car 
now save the document. See "Saving a Document" earlier in 
this chapter for details. 

4. Two options appear: List and Type-In. 

a) If you select List, use the CD and OJ keys to put the cur­
sor on the name you want from the list. Use the ( P G UP) 
and ( P G 0 N ) keys to see a list that is longer than one 
page. Press Gdl to choose the name, or press ~ to 
return to the menu without choosing a name. 

b) If you select Type-In, type the name of the document, and 
press Gdl. 

5. After you have chosen a document for loading, the Storage 
menu appears. Press ~ to return to the editing screen. 

The document is loaded into memory and appears on the editing 
screen with the cursor in the upper-left co~er ready for editing. 
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UNIT 4 
DELETING A DOCUMENT 

MENU PATH: VWI St 0 ra 9 el Ma i nte nan eel 0 e I ete 

Periodically, you should review the contents of your data disks to 
eliminate unnecessary documents. You can remove up to ten 
documents from a disk at the same time using the Delete option. 

The document(s) you delete will be deleted from the disk in drive B 
or from the hard disk drive on which you installed the program 
unless you specify another drive as the Document Path (see Appen­
dix F for details), or select Type-In (in step 5 below) and prefix the 
document name with a disk drive name. 

To delete a document: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Storage. The editing screen clears, 
and the storage screen appears. The storage screen shows you 
the Document Path (the drive the computer uses for any docu­
ment disk operations), the Spool Path (the drive the computer 
uses temporarily for storing your document if you want to 
print a document while doing other VisiWord functions), and 
the current document name. 

3. Select Maintenance. 

4. Select Delete. 

S. Two options appear: List and Type-In. If you want to delete 
more than one document at a time, choose Lis t. If you want 
to delete one document, choose either List or Type-In. 

a) If you select List, use the CD or CD keys to put the cursor 
on the name you want from the list. Use the ( P G UP) and 
( P G 0 N ) keys to see a list that is longer than one page. 
Press the space bar to mark each name with an asterisk 
(*). You can erase the asterisk by moving the cursor to 
that name and pressing the space bar again. You can 
mark up to 10 documents. When you have finished mark­
ing documents to be deleted, press GD. 

b) If you select Type-In, type the name of the document, and 
press GD. 

If you do not provide a document name and press 
~, the screen displays List and Type-In. You can 
return to the Storage menu by selecting Quit. 
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6. When you finish marking documents, you must verify that you 
want to delete each document. If you select Yes, the document 
is deleted immediately. If you select No, it is not. 

When you have selected Yes or No for each document, the screen 
displays the Maintenance menu. You can press ~ to return to 
the editing screen or select Quit twice to return to the Main menu. 
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UNIT 5 
RENAMING A DOCUMENT 

MENU PATH: VW/Storage/Maintenance/Rename 

You change the name of a document by using the Rename option. 
This is helpful when you want to save a new document under a 
currently used name. You can rename the existing document and 
use the old name. You will not lose any of your text. You can only 
rename one file at a time. 

In the VisiWord program, every document must have a name 
which is used to identify the document to the computer. These -
names can have: 

• Up to 8 characters followed by a period (.) and an optional 3 
character extension. 

• Any letters a through z in upper, lower, or upper and lower 
case. 

• Any digits 0 through 9. 

Upper-case letters and lower-case letters are treated as the same 
letter. For example, Memo.ext and memo.ext refer to the same 
document. If you supply a name that contains too many 
characters, the program automatically corrects it for you. For 
example, if you give memorandum. out as your name, the pro­
gram corrects it to be memorand.out. 

To rename a file: 

1. From the editing screen, press ~. 

2. From the Main menu, select Storage. The editing screen clears, 
and the storage screen appears. The storage screen shows you 
the Document Path (the drive the computer uses for any 
document operations), the Spool Path (the drive the computer 
uses temporarily for storing your document if you want to 
print a document while doing any other VisiWord function), 
and the current document name. 

3. Select Maintenance. 

4. Select Rename. 
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s. Two options appear: List and Type-In. 

a) If you select List, use the OJ or CD keys to put the cursor 
on the name you want from the list. Use the ( P G up) and 
( P G D N ) keys to see a list that is longer than one page. 
Press W to choose a document or press ~ to return 
to the menu without choosing a document. 

b) If you select Type-In, type the name of the document you 
want to rename, and press w. 

6. When prompted, type in the new name of the document and 
press w. 

The file is renamed immediately, and the screen displays the 
Maintenance menu. You can press ~ to return to the editing 
screen or select Quit twice to return to the Main menu. 
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UNIT 6 
VIEWING DOCUMENT SIZE 

MENU PATH: VW/Storage/Maintenance/Usage 

The Document Statistics screen helps you keep track of your 
document size as shown in Figure 3-1. The information always 
refers to the document on the editing screen. If two documents are 
on the editing screen, it refers to the active one. 

021·003/P 

Figure 3-1. Document Statistics Screen 

The Document Statistics screen displays the document name, the 
size of the document in words, the size of the document in words 
above the cursor and in words below the cursor, and the percent­
age of memory the document uses. 
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To see the document statistics: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Storage. The editing screen dears, 
and the storage screen appears. The storage screen shows you 
the Document Path (the drive the computer uses for any 
document disk operations), the Spool Path (the drive the com­
puter uses temporarily for storing your document if you want 
to print a document while doing other VisiWord functions), 
and the current document name. 

3. Select Maintenance. 

4. Select Usage. 

The document statistics appear on the screen. Press ~ to 
return to the editing screen, or select Ouit twice to return to the 
Main menu. 

Note: 

The amount of time it takes for the document statistics screen to 
appear depends on the size of your document. 
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UNIT 7 
VIEWING ALL DOCUMENT NAMES 

ON A DISK 

MENU PATH: VW/Stora ge/Ma i ntenance/L i st 

There are several ways to view a list of all the document names 
stored on a disk depending on what you want to do once you see 
the list. You can choose names from a list to save, load, delete, 
rename, include or append documents. See the appropriate section 
in this chapter for details. If you only want to view the documents 
to determine the contents ofa disk, follow these steps: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Storage. The editing screen clears, 
and the storage screen appears. The storage screen shows you 
the Document Path (the drive the computer uses for any 
document disk operations), the Spool Path (the drive the com­
puter uses temporarily for storing your document if you want 
to print documents while doing other VisiWord functions), 
and the current document name. 

3. Select Maintenance. 

4. Select List. 

A list of the document names on the disk appears on the screen. If 
the list is longer than one screen, use the ( P G UP) and the 
( P G D N ) keys to view the entire list. When you are finished view­
ing the list, press ~. The screen displays the Maintenance 
menu. You can return to the editing screen by pressing ~ or 
return to the Main menu by selecting Quit twice. 
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UNIT 8 
APPENDING ONE DOCUMENT 

TO ANOTHER 

MENU PATH: VW/LayoutiAppend 
VW / S tor age / A p pen d 

You can link documents so that the VisiWord program considers 
them as one document. This allows you to create parts of a large 
document separately, but edit or print them as one document. 
This action is called appending. You do not have to put all of the 
parts of the appended document on the same disk. Figure 3-2 illus­
trates how one document is appended to another. 

021·006 

Figure 3-2. An Appended Document 
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DEFINING AN APPEND SHEET 
If you want to load or print appended documents in sequence, 
you must direct the VisiWord program from one document to the 
next. You do this by specifying on an Append Sheet the name of 
the document that is appended to the first document and by 
inserting this sheet at the end of the first document. Figure 3-3 
shows a sample Append Sheet. 

APPEHDED FILE SHEET 

Mess'age' (I ine 1f: This doctltlcnt contains tne'--stats,tOl" 
(line 2): ,deuol 
(line 3): 

02J.O04/P 

Figure 3-3. A Sample Append Sheet 

An Append Sheet must be inserted on the last line of the docu­
ment. If the Append Sheet is not on the last line, it is ignored. 

To define an Append Sheet: 

1. Type your text. After the last character, press c;;o to insert a 
required return. 

2. Press ~ to use the menu. 

3. From the Main menu, select Layout. 

4. Select Append. The editing screen clears and an Append Sheet 
appears. 

5. Type the name of the document you want to add to the end 
of the document on the editing screen. For example, 
memo2.doc. 
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6. If you want a message to appear on the screen before the 
second document is loaded, such as a short reminder of what 
the document contains, position the cursor over one of the 
three message lines using the OJ or OJ keys, and type the 
message. You can type a message of up to 60 characters. This 
message will not appear on the printout when the appended 
document is printed. 

7. If you want to comment on this Append Sheet, position the 
cursor over the line that reads Comment, and type the com­
ment. You can type up to 60 characters. The comment does 
not appear on the editing screen nor on the printed document. 
It only appears on the Append Sheet. 

8. Press ~ to return to the menu. 

9. Press ~ to return to the editing screen, or select Quit 
twice to return to the Main menu. 

When you return to the editing screen, a theta (8) appears in the 
left border indicating that the Append Sheet is a part of the docu­
ment. The Append Sheet is saved with the document and loaded 
every time you load the document. 

When you have finished editing the document, save it. You create 
the next document, the one named in the Append Sheet, just as 
you would any other. When you have finished entering the text 
for the second document, save it as you normally would using the 
name that you specified in the Append Sheet. See "Saving Your 
Document" earlier in this chapter for details. 

DELETING AN APPEND SHEET 
If you decide that a particular document should no longer be 
appended to another one, you can delete the Append Sheet. To 
delete an Append Sheet from a document: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Layout. 

3. You must position the cursor on the line that has the Append 
Sheet. You can do this with the Next option of the Layout 
menu. Selecting Next, moves the cursor to the next sheet in 
your document (Format Sheet, Ruler, Header/Footer Sheet, 
Append Sheet or Message Sheet). 

When an Append Sheet is found, the cursor rests on the first 
character of the line where the Append Sheet is. A theta (8) 
appears in the left border of that line. In the Layout menu, 
above N ext and Pre v, is a row of five hyphens. When the cur­
sor rests on the line that contains the Append Sheet, the 
fourth hyphen is replaced with an A, for example, ·--A-. 
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4. Continue selecting Next until you find the Append Sheet. 

5. Select Append. The editing screen clears, and the Append 
Sheet appears. Press ~ to use the menu. 

6. Select Delete. The options on the Append Sheet become blank. 

7. Press~. 

The editing screen appears. The theta symbol (8) no longer 
appears in the left border. 

EDITING AN APPENDED DOCUMENT 
You can edit an appended document in two ways, separately or in 
sequence. If you want to edit the appended document separately, 
you load each document just as you would load any document. 
For details, see "Loading a Document" earlier in this chapter. If 
you want to edit the entire appended document in sequence, 
follow these steps: 

1. From the Main menu, select Storage. The editing screen clears, 
and the storage screen appears. The storage screen shows you 
the Document Path, the Spool Path, and the current docu­
ment name. 

2. Select Load. Load the first document as you would load any 
other document. See "Loading Your Document" earlier in this 
chapter. 

3. Edit the document. When you are finished, save the first 
document as you would any other. See "Saving a Document" 
earlier in this chapter. After you save the document, the 
Storage menu appears. 

4. Select Append. The screen displays the name of the next 
appended document, any message you included, and asks if 
you are ready to continue. 

5. If you select No, the screen displays the Storage menu. If you 
select Yes, the document is loaded and the screen displays the 
Storage menu. 

6. Press ~ to return to the editing screen. 

The second document of the appended document appears on the 
editing screen. Continue with this process until you have edited all 
the documents in the appended document. 
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PRINTING APPENDED DOCUMENTS 
In general, you print an appended document just as you would 
print any other document. For information on printing 
documents, see Chapter 6. 

After the first document is printed, you are asked if you want to 
print the next one. If the next document is on another flexible 
disk, you should switch disks now. If you select Resume, the next 
document is loaded and printed. If you select Abort, printing ends 
immediately and the screen displays the Print menu. When all the 
parts of the appended document have been printed, the program 
displays the Print menu. Press ~ to return to the editing 
screen or select Quit to return to the Main menu. The last docu­
ment that was printed is the document in memory. 

WARNING: 

DO NOT REMOVE THE DISK CONTAINING THE 
APPENDED DOCUMENT UNTIL YOU ARE EXPLICITLY 
TOLD TO DO SO. IF YOU DO, YOUR DISK COULD BE 
DAMAGED. 
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UNIT 9 
INCLUDING ONE DOCUMENT 

WITHIN ANOTHER 

MENU PATH: VW/Storage/lnclude 

If you want to put one complete document inside of another, or 
add one document to the end of another, you can do so with the 
Include command. With this feature, you can put common infor­
mation into several documents, and create new files from existing 
ones. 

Note: 

You cannot include part of a document using the Include option, 
but you can put part of a document into another by using the 
Windows option and copying part of one document from one 
window to the other window. 

In the VisiWord program, every document must have a name 
which is used to identify the document to the computer. These 
names can have: 

• Up to 8 characters followed by a period (.) and an optional 3 
character extension. 

• Any letters a through z in upper, lower, or upper and lower 
case. 

• Any digits 0 through 9. 

Upper-case letters and lower-case letters are treated as the same 
letter. For example, Memo.ext and memo.ext refer to the same 
document. If you supply a name that contains too many 
characters, the program automatically corrects it for you. For 
example, if you give memorandum.out as your name, the pro­
gram corrects it to be memorand.out. 

To incorporate one document into another, follow these steps (for 
the purposes of these instructions, the file where you want to put 
the text is memol and the file to be inserted is memo2): 
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Note: 

Including memo2 into memo 1 does not erase memo2 in its original 
form. You do not have to save memo2 after you include it. 

1. Position the cursor at the place in memo 1 where you want the 
first character from mem02 to appear. This must be at the 
beginning of the document or the beginning of a line that 
immediately follows a required return. 

2. Press ~ to use the Main menu. 

3. From the Main menu, select Storage. The editing screen clears, 
and the storage screen appears. The storage screen displays 
the Document Path, the Spool Path, and the current docu­
ment name. 

4. Select Include. Verify that the cursor is correctly positioned by 
selecting Yes. 

5. Two options appear: List and Type-In. 

a) If you select List, use the CD and OJ keys to put the cur­
sor on the name you want from the list. Use the (P G UP) 
and ( P G D N ) keys to see a list that is longer than one 
page. Press GIl to choose a document, or press ~ to 
return to the menu without choosing a name. 

b) If you select Type-In, type the name of the document, and 
press GIl. 

All the text from mem02 is included into memo1, and the screen 
displays the Storage menu. 

You may want to rename the original memo 1 so that you can 
retain a version of the document without the text from mem02 
imder a different name. If you do, see "Renaming a Document" 
earlier in this chapter for details. 

The new document, memo 1 (which includes mem02), is not saved 
on disk. If you want to save the new document, see "Saving a 
Document" earlier in this chapter. 

If you want to delete either the old memo1 or mem02, see 
"Deleting a Document" earlier in this chapter. 

You can return to the editing screen from the Maintenance menu 
by pressing ~ or to the Main menu by selecting Quit twice. 
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UNIT 10 
USING A FORM DOCUMENT FREQUENTLY 

If you write letters that are on standard letterhead, weekly reports, 
or manuscripts with standard headers or footers, the VisiWord pro­
gram can save you time. You can create these form documents once 
and use them over and over again. 

A form document you use frequently is like any document, except 
that it has blank areas for entering special information. It may 
have text or only formats. You can enter text and use the format 
startup settings; you can enter text and change the format settings, 
including the Format Sheet, the Ruler settings, path settings, and 
printer model; or, if you wish, you can change only the format 
settings. 

You can save as many form documents with blank areas as you 
want by using the Save option of the Storage menu. You create a 
special document with blanks and save it. When you load the 
VisiWord program, select Revise, then List to view the list of 
documents you have on your disk. Choose the form document 
that you want to use, and it appears on your screen. 

To create a form document you want to use frequently: 

1. Enter the document as you would any document leaving 
blank areas as appropriate and setting formats to your needs. 

2. When you are finished, press ~ to use the Main menu. 

3. From the Main menu, select Storage. The editing screen disap­
pears, and the storage screen appears displaying the Docu­
ment Path, Spool Path, and the current file name. 

4. Select Save. Then save your document as described in "Saving 
Your Document" earlier in this chapter. This document then 
becomes one of several specially formatted documents that 
you can use frequently. 
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UNIT 11 
USING YOUR OWN STARTUP FORMAT 

MENU PATH: VW/Stora gelD efau It 

The VisiWord program gives you a startup format that you do 
not have to change. However, if you prefer other settings for your 
format and you want to use your format more frequently than the 
VisiWord format, you can change the VisiWord startup settings to 
suit your needs. Do this only when you are sure that you will use 
your special format more frequently than any other format. 

Start with a blank editing screen. 

1. Change the Format Sheet, Ruler, path or printer settings to 
your needs (see Appendix F if you need instructions). 

2. Press ~ to return to the editing screen. 

3. Press ~ to use the Main menu. 

4. Select Storage. 

s. Select Default. 

6. The message line asks if your document settings ate correct. If 
not, select No. The Storage menu appears. If they are, select 
Yes. 

You have saved your format settings on the program disk under 
the name the program supplies: A:defaults.vw. (If you installed 
the VisiWord program on a hard disk, that disk drive letter is 
substituted for the A.) Each time you load the VisiWord program 
and select Create, the screen displays your special format, which 
you can use immediately. You cannot have more than one startup 
format, but you can always change the current format to one that 
is more suitable. 

Note: 

If you have only flexible drives, you can have either a 
defaults.vw or a file containing new disk paths (see "Changing 
Disk Drive Paths" in Appendix F), not both. If you want to 
create a new defaults.vw or path file, delete the old file first, 
then create the new one. 
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You can change back to the VisiWord startup formats after you 
have loaded your own special format. Press (TIJD. Then, select 
Delete and Memory. The VisiWord startup settings are then in ef­
fect. You can start a new document using the VisiWord startup 
settings. 

Note: 

In this section, use your hard disk drive letter in place of A. For 
example, if you installed the VisiWord program on a hard disk 
drive whose letter is C, the format settings were saved under the 
file name C:defaults.vw. 

To switch back to your startup format from the VisiWord startup 
format, from the editing screen press (TIJD, then select Storage. 
Select Include, then Type-In. Type in the name A:defaults.vw 
(remember to substitute the hard disk drive letter for the A, if 
necessary) and press GIl. Your format settings will be in effect 
when you return to the editing screen. 

If you want to delete your startup format permanently, delete the 
document containing them. To do this, from the editing screen 
press (TIJD, then select Storage and Maintenance. Select Delete, 
then Type-In. Type the name A:defaults.vw, and press GIl. When 
you verify that you do want to delete the document, it is removed 
from the program disk. 
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UNIT 1 
MOVING THE CURSOR WITHIN 

DOCUMENTS 

The blinking underscore on the editing screen is called the editing 
cursor. The editing cursor indicates where the next character that 
you type appears. Whether you are creating a new document or 
revising an existing one, you have to know how to move the cur­
sor quickly from one point to another. In the VisiWord program, 
you can move the cursor on the editing screen using special 
cursor-moving keys. Figure 4-1 shows the position of the cursor­
moving keys on the keyboard. 

Tab 
key 

Cursor --___.... 
up 

End 
key 

Figure 4-1. Cursor-Moving Keys 

Page 
up 

Cursor 
right 

Page 
down 

Cursor 
down 
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When you first enter the editing screen, the cursor is in the top­
left corner of the screen, the Home position. When you return to 
the editing screen from a menu, the cursor returns to where it was 
when you left the editing screen. 

Table 4-1 shows the keys used to move the cursor. 

Table 4-1. Moving the Cursor 
Cursor Moves Cursor-Moving Key 

Up CD 
Down CD 
Left 

Right 

To the start of the line (HOME ) 

To the start of the screen (HOME)(HOME) 

To the start of the document ( HOME)( HOME) ( HOME) 

To the end of the line 

To the end of the screen 

To the end of the document 

To the next screenful of text ( PGDN) 

To the previous screenful of text ( PGU P) 

To tab position 
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Notes: 

The cursor moving keys do nothing but move the cursor. Cer­
tain other keys also move the cursor, but they perform a func­
tion at the same time. Do not use these keys unless you want to 
perform their special function: 

Space bar Moves the cursor to the right one 
space, but also inserts a blank space 
that will appear on the printed 
document. 

Moves the cursor to the beginning of 
the next line, but also ends text 
wraparound. 

ITAJ (Indent) Moves the cursor to the next stop, but 
also inserts blank spaces that will 
appear in the printed document. 

[ B K S P ) Moves the cursor to the left one space, 
but also deletes the character to the left. 

ct:JJ (Decimal Tab) Moves the cursor to the next stop, but 
when you type the next characters they 
are inserted to the left of the stop 
column. 
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UNIT 2 
ENTERING TEXT 

Entering text in the VisiWord program is simply a matter of typing 
on the editing screen. The editing screen appears when you select 
Create from the Initial menu, or when you load a document. You 
can go to the menu and return to the editing screen from a menu 
by pressing ~. 

TEXT WRAPAROUND 
When you enter text, the program automatically ends one line at 
the right margin and begins a new line. This is called text 
wraparound. You do not have to think about line formatting 
within paragraphs. 

When you are typing continuous text and you are on the bottom 
line of the screen, the text wraps as before. However, all text 
instantly moves up so that the last line of your document is at the 
middle of the screen. You now have more lines to type before the 
text moves up again. Don't worry, the text that moved off the top 
of your screen is still there. To see it, press the (P G UP) key. 

REQUIRED RETURNS 

THE ENTER KEY Q) 

A required return Q) forces one line to end and another line to 
begin on the line below it. When you want to end text 
wraparound, you insert a required return into the text by pressing 
Q). The required return appears as a symbol (,) in the right 
border. The line of text is broken where you insert the required 
return. 

If you mistakenly press Q), you can delete the required return 
using the Delete to End of Line key (LID. To delete only the 
required return, move the cursor to the end of the line that ends 
with the required return, and press (LID. When you delete a 
required return, the return symbol (,) disappears from the right 
border, and the text from that point to the next required return is 
reformatted. 
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Note: 

You can delete an entire line of text including a required return 
using the Delete Line key ~. If you delete a line by mistake 
you can retrieve it by pressing the Undelete key ~. 

Required returns do not automatically insert blank lines into your 
document. Pressing Gdl only moves the cursor to the beginning of 
the next line. If you want to insert a blank line into a document, 
press Gdl a second time. 

f~ required return ends the formatting started by an indent. When 
you press (ED, the Indent key, the text that follows is aligned on 
the left with the next stop on the Ruler, not the left edge of the 
screen. This temporary left margin is in effect until you press Gdl. 
See "Indenting Paragraphs" in Unit 5 of Chapter 5 for details. 

A required return must end each line in a column if you want to 
create columns in your text. Columns, in the VisiWord program, 
are any characters aligned vertically on two or more lines. 

INSERT AND OVER-TYPE 

THE o:::N:ID KEY 

When you load the VisiWord program, it lets you insert new text 
into an existing document without erasing existing text. You can 
insert text whenever the word INS E R T displays on the line above 
the menu. For example, if you want to insert text, position the 
cursor where you want to insert the text, and type. The existing 
text adjusts to the right as you type, no text is lost, and the docu­
ment automatically reformats. 
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If you press the c::r:N::ID key when INS E R T is displayed on the line 
above the menu, INS E RT disappears and is replaced by 0 V E R -TY P E. 
o V E R -TY P E lets you type over existing text and replace it. While 
o V E R -T Y P E is displayed, move to the character you want to type 
over. Type the new character. The new character replaces the old 
character, and the cursor moves to the next character. If you want 
to type over more characters, continue typing. Any character you 
type replaces the character typed over . To return to INS E R T, press 
c::r:N::ID again. 

Note: 

If you press (8 K S P ) when OVER·TYPE is displayed on the line 
above the menu, the character to the left of the cursor is replaced 
with a blank space. No reformatting is done. 
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UNIT 3 
DELETING AND RESTORING TEXT 

Deleting and restoring text are frequent editing tasks that let you 
print your documents letter perfect. You can remove unwanted 
text from a document, and in some cases you can restore text that 
has been mistakenly deleted. You do not have to worry about 
reformatting after deleting text; the text automatically adjusts to 
the current format. 

You can delete text in two ways: using single keys, or using the 
Delete menu. If you want to delete single characters or single 
lines, use the appropriate delete key described in Table 4-2. If you 
want to delete more than one line, use the Delete option in the 
Main menu. 

DELETE KEYS 
You can delete single characters, all characters from the cursor to 
the end of the line, or an entire line using the delete keys. Figure 
4-2 shows the position of these keys on the keyboard. 
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Delete 
line 

Delete 
key 

Figure 4-2. Delete Keys 
021-008 

Table 4-2 lists and explains how to delete text using the special keys. 

Table 4-2. Deleting Text 

Description 

(B K S p) 

Key 

Delete the character before 
the cursor 

Delete the character at the cursor 

Delete from the cursor to the end 
of line (including required return) 

Delete entire line (including 
required return) 
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Note: 

When you press ( B K S P ) and the line above the menu reads 
OVER-TYPE, the character to the left of the cursor is deleted but a 
blank space remains. No reformatting is done. 

DELETING TEXT AND COLUMNS 

MENU PATH: VW/Delete 

You can delete more than one line at the same time using the 
Delete menu. You can choose to delete text or columns. Text is 
any sequentially typed characters; columns are any characters 
aligned vertically on two or more lines with a required return at 
the end of each line. Each line in the column must end in a 
required return. Figure 4-3 illustrates the difference between 
deleting text and deleting columns. 
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(a) Mark text (a) Mark column 

(b) De(ete text 
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Figure 4-3. Deleting Text or Columns 

To delete text or columns: 

1. Move the cursor to the first character you want to delete. 

2. From the editing screen, press ~ to use the menu. 

3. From the,Main menu, select Delete. 

4. Select the appropriate option (Text or Column). 

5. You are prompted on the line above the menu to mark the 
end of what you want to delete. You can only move the cur­
sor forward. You can use any of the cursor-moving keys. Put 
the cursor on the character after the last character that you 
want to delete. Press ~. The area you want to delete appears 
in inverse video (dark characters on a light background). 
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Only the characters and the spaces between the characters 
appear in inverse video. Any spaces on the screen created by 
tabbing or indenting do not appear in inverse video. 
However, if these spaces are in the defined area, they are 
deleted along with the characters. 

6. Verify that you want to delete this material by selecting Yes. It 
is deleted; the text outside of the marked area is reformatted; 
and the cursor moves back to where the first deleted character 
was. If you do not want to delete this material, select No. The 
screen displays the editing screen and the Main menu. 

RESTORING TEXT 

UNDELETE KEY c:EID 
The Undelete key c:EID restores anything that you have mis­
takenly erased using the Delete Line ~ or Delete to End of Line 
~ keys. When something is deleted with the ~ or ~ 
keys, it is stored in a place in memory, called a buffer. 

The characters clear from the buffer when you delete again at a 
different cursor location. The newly deleted material replaces the 
old deleted material in the buffer. If you do repeated deletions at 
the same cursor position, the buffer is not cleared between dele­
tions. Pressing c:EID puts anything currently in the buffer into the 
document at the cursor position. 

WARNING: 

CHARACTERS THAT ARE DELETED USING THE 
( B K S P ) AND (]:liD KEYS DO NOT GO INTO THE 
BUFFER AND CANNOT BE RESTORED. 

CHARACTERS THAT ARE DELETED USING THE 
DELETE TEXT OR COLUMN OPTIONS ARE PLACED IN 
THE BUFFER ERASING ITS CURRENT CONTENTS. 
HOWEVER, THE CHARACTERS CANNOT BE 
RESTORED. 
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UNIT 4 
COPYING TEXT AND COLUMNS 

MENU PATH: VW/Copy 

You can copy sections of your document and insert them into 
other places in the same document or into another document. 
Copying does not erase any text. It simply duplicates that text in 
another place. 

Note: 

If you want to copy text from one document to another, you 
must first create two windows on the screen (see "Splitting the 
Screen into Two Parts" later in this chapter for details); then 
load the second document into one of the windows. 

You can choose to copy text or columns. Text is any sequentially 
typed characters; columns are any characters aligned vertically on 
two or more lines. Each line of the column must end in a required 
return. Figure 4-4 illustrates copying text and copying columns. 
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(a) Copying text (a) Copying columns 

(b) Text after copying (b) Columns after typing 

Figure 4-4. Copying Text and Columns 

Use the following procedure to copy text or columns: 

1. Move the cursor to the first character you want to copy. 

2. From the editing screen, press ~ to use the menu. 

3. From the Main menu, select Copy. 

4. Select the appropriate option (Text or Column). 

s. You are prompted to mark the end of what you want to 
copy. You can only move the cursor forward. You can use 
any cursor-moving key. Put the cursor on the character after 
the last character that you want to copy. Press GD. The area 
you are copying appears in inverse video (dark characters on 
a light background). 

Only the characters and the spaces between the characters 
appear in inverse video. Any spaces on the screen created by 
tabbing or indenting do not appear in inverse video. 
However, if these spaces are in the defined area, they are 
copied along with the characters. 

6. You are prompted to mark where you want the copy to 
appear. Put the cursor where you want the copy, and press 
GD. The copy is inserted; the text is reformatted, and the cur­
sor appears on the first character of the new copy. 
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UNIT 5 
MOVING TEXT AND COLUMNS 

MENU PATH: VW/Move 

You can move sections of your document from one place to 
another place in the same document or to another document. 
Moving a section deletes the section from the original place. You 
can choose to move text or columns. Text is any sequentially 
typed characters; columns are any characters aligned vertically on 
two or more lines. Each line of the column must end in a required 
return. Figure 4-5 illustrates moving text and moving columns. 

Note: 

If you want to move text from one document to another, you 
must first create two windows on the screen (see "Splitting the 
Screen into Two Parts" later in this chapter for details); then 
load the second document into one of the windows. 
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(a) Moving text (a) Moving a column 

(b) Text reformats (b) Columns reformat 
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Figure 4-5. Moving Text or Columns 

Use the following procedure to move text and columns: 

1. Move the cursor to the first character that you want to move. 

2. From the editing screen, press ~ to use the menu. 

3. From the Main menu, select Move. 

4. From the Move menu, select the appropriate option (Text or 
Column). 
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5. You are prompted to mark the end of what you want to 
move. Put the cursor on the character after the last character 
that you want to move. You can only move the cursor for­
ward. You can use any cursor-moving key. Press GJ). The 
characters to be moved appear in inverse video (dark 
characters on a light background). 

Only the characters and the spaces between the characters 
appear in inverse video. Any spaces on the screen created by 
tabbing or indenting do not appear in inverse video. 
However, if these spaces are in the defined area, they are 
moved along with the characters. 

6. You are prompted to mark where you want the characters to 
appear. Move the cursor to this position, and press GJ). 

The material is moved, the text is reformatted, and the cursor 
appears on the first character you moved. 
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UNIT 6 
LOOKING FOR CHARACTERS, WORDS, 

OR PHRASES 

MENU PATH: VW/Fi nd 

You can look for characters, words, or phrases in a document 
using the Find menu. Any sequence of characters is called a string. 
You can look for a string typed exactly as it appears in the docu­
ment, or in upper-case, lower-case, or both cases. When the string 
is found, the cursor rests on the first character. You can look for­
ward or backward for a string from any point in the document. If 
you want to find only words rather than character strings that are 
part of words, enter one space before you type the characters you 
are looking for. 

To look for text: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Find. 

3. You are prompted for the string you want to look for (the 
search string). If you have looked for a string once before 
during this editing session, and you want to look for the same 
string, press c:EID (the Undelete Key) and GIl. If you have not 
used this function or you do not want to use the same string, 
type the new string. If your search string includes spaces, you 
must enter the same number of spaces that appear in the text. 
Press GIl. 

4. Look at the line above the Find menu. CASE or NO-CASE 
appears. If you want to search for an exact string, you want 
the word CAS E to be there. If you want all occurrences of a 
word regardless of upper and lower case, you want NO-CASE. 

If you want CASE, select Exact. If you want NO-CASE, select 
Ignore. 

For example, you want to find the next occurrence of the 
word "hello", but you don't know if it was typed as "hello" or 
"Hello". You can search for both versions at the same time. 
Type the word either way. When you look at the Find menu, 
make sure that it reads NO-CASE. If it does, press GIl. If it 
doesn't, select Ignore from the menu. 

5. Select Next or Prev indicating which direction you want to 
look. Next looks forward from the cursor position and Prev 
looks backward from the cursor position. 
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When the string is found, the cursor rests on the first character of 
the string. The screen displays the Find menu. If you want to look 
for the string again, select Next or Prev. 

If the string is not found, a message flashes on the screen. Press 
GIl. The screen displays the Find menu. 

DOING REPEATED SEARCHES 
If you leave the Find menu, you can repeat the search as many 
times as you want in the same direction using the Again key, 
c:t::2J. To do this, follow the steps to look for a characters, words, 
or phrases. After the text is found, select Quit. The Main menu 
appears. Optionally, press ~ and move the cursor to another 
position in the document. If you press any key besides the initial 
~ or a cursor-moving key while you are on the editing 
screen, you cannot use the Again key c:t::2J. 

Press c:t::2J. If the text appears again in the document, the cursor 
is positioned on the first character. If it is not found, a message 
flashes on the screen. Press GIl to return to the editing screen. 
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UNIT 7 
REPLACING CHARACTERS, WORDS, 

OR PHRASES 

MENU PATH: VW/Fi nd/Next/Rep lace 
VW IF i n diP rev IRe p I ace 

You can replace any string (sequence of characters) with another 
string throughout a document. A string can be replaced one at a 
time throughout a document or for all occurrences. 

REPLACING ONE STRING AT A TIME 

If you want to replace one string one at a time: 

1. From the editing screen, press ~ to use the Main menu. 

2. From the Main menu, select Find. 

3. You are prompted for the string you want to look for (the 
search string). If you have used the Find option before, and 
you want to look for the same string, press the Undelete key 
~ and G:D. The string you previously typed appears as the 
search string again. 

If you have not used Find before or you want to look for a 
different string, type your text. If your search string includes 
spaces, you must enter the same number of spaces that appear 
in the text. Press G:D. 

4. Look at the line above the Find menu. CASE or NO·CASE is 
displayed. If you want to find only those occurrences in your 
text that are exactly as you typed the search string (capital let­
ters, etc. in the same places), the word CASE must be 
displayed. If you want to find all occurrences of the search 
string regardless of upper and lower case, then NO -CAS E must 
be displayed. 

If you want CASE, select Exact. If you want NO-CASE, select 
Ignore. 

For example, you want to find all the occurrences of the word 
"hello" throughout a document regardless of whether it was 
typed as "hello" or "Hello", and replace them with 
"Greetings". You can replace both versions of the word in the 
same steps. Type the word either way. When you look at the 
Find menu, make sure that it reads NO-CASE. If it does, press 
G:D. If it doesn't, select Ignore from the menu. 
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5. Select Define-replacement, and type the replacement string. 
Press GIl. 

6. Select Next or Prev indicating which direction you want to 
look. If the string is found, the cursor rests on the first 
character of the string. 

If the string is not found, a message flashes on the screen. 
Press GIl. The Find menu appears. 

7. If you want to replace the string, select Replace. Continue to 
look with Next or Prev replacing when necessary. 

REPLACING ALL OCCURRENCES 
If you want to replace all occurrences of the string from the cursor 
position to the end of the document, follow the previous list of 
instructions to find the first occurrence of the string. Replace the 
first occurrence of the string by selecting Replace. At that point, 
select All-replace from the Find menu. All occurrences of the string 
are replaced automatically. The screen displays the Main menu. 
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UNIT 8 
SPLITTING THE SCREEN 

INTO TWO PARTS 

MENU PATH: VW/Windows 

Splitting the editing screen into two parts, or windows, lets you 
vh;w two sections of the same document or two different 
documents at the same time. Although you can see both windows 
on the screen, you can enter or edit text in only one window at a 
time. The window in which you can enter or edit text is the active 
window. 

In the active window, you can do everything you normally do on 
the editing screen except create another window. You can load a 
document into the active window while another document is in 
the other window. You can move or copy text from one window 
to the other. If you do something that affects both windows, such 
as replacing all the occurrences of a character sequence when you 
are looking at two parts of the same document, the active window 
is updated first. The other window will be updated when it 
becomes active. 

CREATING WINDOWS 

MENU PATH: VW/Windows/Open 

When you create a second window from within a document or on 
a blank editing screen, the screen splits at the cursor. The text 
above the line containing the cursor is in the upper window. The 
line containing the cursor and all text below that line are in the 
lower window. To create a second window: 

1. From the Main menu, select Windows. 

2. Select Open. 

3. The program asks where you want the window to begin. You 
must have at least three lines in the window. Move the cursor 
using OJ or CD to where you want to split the screen, and 
press GIl. 
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The part of the screen enclosed by a border of inverse video is the 
active window. The document that was on the editing screen 
appears in both windows. This allows you to keep your original 
position in the document while you look for something elsewhere 
in the document. Figure 4-6 shows an example of a screen split 
into two windows. 

CD Inactive window 

CD Ruler 

® Menu 

CD Active window 

Figure 4-6. A Two-Window Screen 
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MOVING THE CURSOR FROM ONE WINDOW 
TO ANOTHER 

MENU PATH: VW/Windows/Switch 

When you first split the screen into two windows, the lower win­
dow is active, and the cursor appears in the lower window. The 
window containing the cursor is always the active window. You 
can move the cursor from one window to another using the 
Switch option. 
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To move the cursor to the other window: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Windows. 

3. Select Switch. 

The border around the active window disappears and reappears 
around the other window. The cursor moves to the last position it 
held in that window. If that window has never been active, the 
cursor moves to the upper-left corner of the active window. The 
screen displays the Windows menu. 

MOVING OR COPYING TEXT BETWEEN 
WINDOWS 

You can move or copy sections from one window to another. 
Copying simply duplicates the same section in another place. 
Moving deletes the section from its original place and puts it in 
another place. 

You can choose to move or copy text or columns. Text is a 
sequence of characters; columns are characters that are aligned 
vertically on two or more lines. Each line in the column must end 
with a required return. Figure 4-7 illustrates moving and copying 
text and columns between windows. 
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Figure 4-7. Moving Text and Columns Between Windows 

To move or copy text from one window to another: 

1. Make sure the section you want to move or copy is in the 
active window. If it isn't, select Switch. 

021·012 

2. Move the cursor to the first character you want to move or 
copy. 

3. Press ~ to use the menu. 

4. From the Main menu, select the appropriate option (Move or 
Copy). 

5. Select the appropriate option (Text or Columns). 

6. You are prompted to mark the end of what you want to move 
or copy. Move the cursor to the character after the last 
character that you want to move or copy. Press GIL The 
characters you are moving or copying appear in inverse video 
(dark characters on a light background). 

Only the characters and the spaces between the characters 
appear in inverse video. Any spaces on the screen created by 
tabbing or indenting do not appear in inverse video. 
However, if these spaces are in the defined area, they are 
moved or copied along with the other characters. 



Splitting the Screen Into Two Parts 4-27 

7. You are asked if you want to move or copy the information 
into the other window. If you do, select Yes. The other win­
dow becomes active. If you do not, select No. 

B. Move the cursor to where you want the text to appear. Press 
GD. 

The window to which you moved or copied information is active, 
and the cursor appears on the first character of the new material. 
For additional information on moving and copying see "Copying 
Text and Columns" or "Moving Text and Columns" earlier in this 
chapter. 

LOADING A DOCUMENT INTO A WINDOW 
You load a document into a window just as you load any docu­
ment. Loading a new document automatically clears the previous 
document in the active window. If you have done any editing, the 
program reminds you to save the document. For details on how to 
load or save a document, see the "Loading a Document" and 
"Saving a Document" sections in Chapter 3. 

CLEARING A DOCUMENT FROM A WINDOW 

MENU PATH: VW/Windows/Z= Clear 

To clear a document from the active window: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Windows. 

3. Select Z=Clear. If you have not saved the file in the lower 
window, the program reminds you that any edits after your 
last save will be lost. You can save the document using the 
Save option in the Storage menu. See "Saving a Document" in 
Chapter 3 for details. 

The document in the active window clears, the screen displays 
both windows (one containing a document and the other empty), 
and the Main menu. 

Note: 

The Delete/Memory option does the same task as the Win­
dow/Clear option. 
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CLOSING A WINDOW 

MENU PATH: VW/Windows/Close 

When you no longer need to view two windows at the same time, 
you can eliminate the lower window. The lower window does not 
have to be active to close it. To close the lower window: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Windows. 

3. Select Close. If you have not saved the file in the lower win­
dow, the program prompts you to save it before you close the 
window. If you don't save the document, any edits after your 
last save will be lost. You can save the document using the 
Save option in the Storage menu. 

The lower window is closed, and the document in the upper win­
dow remains on the full screen. 
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UNIT 1 
YOUR DOCUMENT FORMAT 

Deciding whether a document should be printed with single spac­
ing, whether the words on a line should be spaced so they reach 
the right margin - giving a block appearance, or deciding where 
tab stops should be set are all part of formatting a document. To 
help you make these formatting decisions, the VisiWord program 
has several methods for you to specify formats you want. 

The VisiWord program has preset (startup) format settings that 
were carefully chosen to apply to most document applications. 
Occasionally, you will need to change some of these format set­
tings for special documents or sections of documents. In the 
VisiWord program you can change format settings with four 
options on the Layout menu. 

o You can select Format to fill out a Format Sheet and change 
line spacing, right justification, character spacing per inch, 
lines per page, first page number, and send user setup strings 
to your printer. User setup strings deal specifically with your 
printer so they will not be explained here (see Chapter 6 for 
complete details). 

o You can select Ruler to set and clear stops for tabs, indents, 
and decimal tabs; to set the right margin; and to establish a 
temporary left margin by setting a required indent. 

o You can select Header to fill out a Header Sheet for headings 
that automatically print at the top of each page but do not 
display on the editing screen. 

o You can select Z=Footer to fill out a Footer Sheet for footer 
text that automatically prints on the bottom of each page but 
does not display on the editing screen. 

FORMAT STARTUP SETTINGS 
Table 5-1 shows the format settings that you start with whenever 
you create a new document. The Header and Footer Sheets are 
blank. The settings you see in Table 5-1 remain in effect for your 
entire document unless you change them. 
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Table 5-1. VisiWord™ Startup Layout Settings and 
Range of Possible Settings 

Startup Range of 
Category Value Possible Values 

Format Line Spacing single one-half, single, 
Sheet one-and-one-half, 
Settings double 

Right no yes, no 
Justification 

Characters 10 10, 12, and 15 
per inch 

Lines per page 50 any value between 
o and 10000 

First Page 1 any value between 
Number o and 9999 

Ruler Right Margin 65 any value between 
Settings 1 and 255 

Stops for Increments any position on the 
Tabs and of 5 Ruler to the left of 
Indents the right margin 

Format Sheet Descriptions 
Line 
Spacing 

Right 
Justification 

Characters 
Per Inch 

Choose the line spacing for the printed 
document. Whatever you choose only 
effects the document when it is printed. 
Your document is always single spaced 
when you view it on the screen. 

Choose to space each line so that it 
ends at the right margin - giving a 
block appearance; or end each line 
normally-giving a ragged edge along 
the right margin. Selecting Yes blocks 
paragraphs; selecting No causes a 
ragged right margin. Right justification 
appears on the screen when you view 
the document and on the paper when 
you print the document. 

Choose the number of characters you 
want to print per inch of space on the 
paper. You will not see any difference 
on the screen when you view the docu­
ment but there is a noticeable dif­
ference on the paper when you print 
the document. 



Lines per 
Page 

First Page 
Number 

Ruler Descriptions 
Right Margin 

Stops 

Required 
Indent 
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Choose the maximum number of lines 
of text (excluding any header or footer 
text) you want to print on one page. 
You will see a string of diamonds 
across the editing screen to indicate a 
new page that corresponds to your set­
tings. When you print the document, a 
new page will begin at the point in­
dicated by the line of diamonds. 

Choose the page number you want to 
print first. The page number only 
appears when you print the document 
and only if you have defined a Header 
or Footer Sheet and placed the page 
number symbol (#) on the appropriate 
line. See the unit "Setting Headers and 
Footers" later in this chapter for com­
plete details. 

Choose the column number for the 
right margin of your document. 

Choose the columns where you want 
the Tab key (3), the Indent key (IT) 
and the Decimal Tab key CE:D to 
stop. 

Choose the column where you want a 
required indent to start. 

You can change any of these settings for your entire document by 
changing the Format Sheet or Ruler settings while your cursor is 
on the first line of your document. 

You can also specify that format changes take effect on a par­
ticular line by placing your cursor on any line that immediately 
follows a required return, then selecting the appropriate option on 
the Layout menu and making the change. You can make format 
changes at the beginning of a document or on the line after a 
required return. Format changes affect all following text until they 
are changed again. 

Format changes do not affect previous lines. For example, if you 
make a format change starting on line 10 of your document, lines 
1 through 9 will not be affected. The format settings for lines 1 
through 9 remain in effect. 
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You can set as many different formats as you want, and you can 
make changes to existing formats as often as you want. A com­
plete description of how to make format changes is contained in 
the units that follow. 

Changes you make on a Format Sheet, Ruler, Header Sheet or 
Footer Sheet become a part of your document. You do not have 
to redo the formatting every time you load the document from 
disk. 

In addition to the formatting capabilities available on the Layout 
menu, you can make some temporary changes when you print 
your document. These format changes are only in effect when you 
print the document that time. For complete information on format 
changes you can make when you print, see Units 5 and 6 of 
Chapter 6. 

SEEING WHAT FORMATS ARE IN EFFECT 
Whenever you change the settings on the Ruler or Format Sheet, 
or define headers or footers, a theta (9) appears in the left border 
of the editing screen on the same line that you created the change. 

To see what specific settings take effect at the theta (9), put the 
cursor on the line with the theta (9) and select Layout. A row of 
hyphens appears on the Layout menu above the Next and Prev 
options. When the cursor is on a line that contains a Format Sheet 
change, the first hyphen is replaced by an F. When the cursor is 
on a line that has a Ruler change, the second hyphen is replaced 
with an R. Similarly, for a Header or Footer Sheet definition, the 
third hyphen is replaced by an H. You can have more than one 
format change on the same line. When you do, a hyphen is 
replaced with the corresponding letter. 

You can also create your own startup settings (see Appendix F for 
complete details). 
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UNIT 2 
USING THE FORMAT SHEET 

MENU PATH: VW/Layuut/Format 

The Format Sheet is a special screen that allows you to set line 
spacing, justification, characters per inch, lines per page, and the 
first page number. When you set a Format Sheet, it takes effect 
for the current document only and is saved and loaded with this 
document. 

The Format Sheet takes effect at the point you define it in the 
document. The format setting affects all following text. You can 
change this Format Sheet and it will affect all following text; or 
you can define another Format Sheet at a later point to affect only 
the text that follows the second Format Sheet; and so forth. 

For example, if you want to print your entire document double 
spaced, define a double spaced format at the beginning of your 
document. If you want only the last half of your document 
printed double spaced, define a double spaced format at the half­
way point in your document. 

Figure 5-1 shows a sample Format Sheet. 
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Figure 5-1. A Sample Format Sheet 
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Note: 

The "Changing Format Settings" section of this Unit contains 
general instructions for making format changes. If you need help 
on a particular format category, see the sections in this Unit that 
follow. 

CHANGING FORMAT SETTINGS 
Changing your document format is possible at the beginning of a 
document or on the line after any required return. A theta symbol 
(e) in the left border of the editing screen indicates that a new for­
mat setting takes effect on that line. You can insert Format Sheets 
while entering or editing text. 

To change or insert new format settings, put your cursor on the 
line where you want the new format settings to take effect (at the 
beginning or after any required return). Then, follow these steps: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Layout. 

3. Select Format. The editing screen clears and a Format Sheet 
appears in its place. The left side of the sheet shows the for­
mat categories and the right side shows the possible settings. 
The current format settings appear in inverse video (dark 
characters on a light background). 

4. You can now change or add settings. Using the CO and CD 
keys, position the cursor on the setting you want to change. 

5. You enter new values in three ways, depending on how the 
settings are displayed: 

a) If two or more possible settings are displayed, as in the 
line spacing option, use the G and G keys to highlight 
the option you want. The highlighted option is the setting 
that is in effect. 

b) If one value is displayed, as in the lines per page setting, 
type the new value over the old one. 

c) If no value is displayed, as in the user setup string setting, 
type the new one. (User setup strings are explained in 
Chapter 6.) 

6. When you finish setting format options, press ~ to 
return to the menu. 

7. Select Quit to return to the Layout menu or press ~ to 
return to the editing screen. 
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The Format Sheet disappears and the editing screen appears. A 
theta symbol (8) appears in the left border indicating where the 
format change starts. The format settings affect all following text 
until you change them again. 

DELETING FORMAT SETTINGS 

MENU PATH: VWILayout/Format/Delete 

If you decide that a particular format is not what you want for 
your document, you can delete the Format Sheet. To delete a For­
mat Sheet from a document: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Layout. 

. 3. You must move the cursor to the line in your document where 
the format change takes effect. You can do this from the 
Layout menu. If you want to go forward from the current 
cursor position, select Next. If you want to go backward from 
the current cursor position, select Prev. 

When a format change is found, the cursor rests on the first 
character of the line where that format takes effect. A theta 
(8) appears in the left border of that line. In the Layout menu, 
above N ext and Pre v, is a row of hyphens. When the cursor 
rests on a line that contains a Format Sheet, the first hyphen 
is replaced with an F. 

If no Format Sheet or other format change is found, the cur­
sor goes to the end of the document, and the editing screen is 
displayed. 

4. Continue selecting Next or Prev until you find the Format 
Sheet that you want to delete. 

S. Select Format. The editing screen clears, and the Format Sheet 
appears. 

6. Press ~ to move the cursor to the menu. 

7. Select Delete. The options on the Format Sheet return to those 
that are in effect for the previous Format Sheet, or if no For­
mat Sheet exists, the program startup settings. 

8. Select Ouit to return to the Layout menu or press ~ to 
return to the editing screen. 

The editing screen appears. The document is reformatted 
automatically with whatever settings are in effect for the previous 
section of text. 
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SETTING LINE SPACING 

MENU PATH: VW/Layout/Format 

When you load the VisiWord program, the line spacing for the 
printer is preset. If you have not changed the program startup set­
tings, the text is set to print single spaced. You can change the 
spacing at the beginning of a document or after a required return 
by changing the Format Sheet. The possible types of document 
spacing are: one-half, single, one-and-one-half, and double. 

To change the line spacing: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Layout. 

3. Select Format. A Format Sheet appears on the screen. 

4. Use the CD key to position the cursor on the line that reads 
Line Spacing. 

5. Use the G or G keys to position the cursor over the new 
spacing value. 

If you move the cursor by pressing CD or CD, an asterisk (*) 
appears next to Lin e Spa c i n g indicating you have changed this 
setting. 

6. Press ~ to move to the menu. 

7. Select Quit to return to the Layout menu or press ~ to 
return to the editing screen. 

A theta symbol (8) appears in the left border on the line where 
the Format Sheet takes effect. The new spacing remains in effect 
for that document until you change it with another Format Sheet. 



Using the Format Sheet 5-11 

JUSTIFYING TEXT (ALIGNING RIGHT) 

MENU PATH: VW/Layout/Format 

You can justify (align the right margin of your text) using Format 
Sheets. Figure 5-2 illustrates the difference between justified text 
and nonjustified (ragged) text. 
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CD Justified text: 
All text aligned on the right margin 

® Non-justified text: 
Ragged edge along right margin 

Figure 5-2. Justified Text vs. Nonjustified Text 

The justification occurs on the screen after the cursor moves from 
the current line. Any line that ends with a required return cannot 
be justified. 

Note: 

The spacing of justified text may look slightly different on the 
screen from justified printed text. 
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You justify text using a Format Sheet. You can insert the Format 
Sheet at the beginning of the document or after any required 
return. 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Layout. 

3. Select Format. A Format Sheet appears on the screen. 

4. Using the CD and CD keys, move the cursor to the line that 
reads Rig h t Jus t i f i cat ion. 

5. Using the G key, move the cursor to Yes. 

If you move the cursor by pressing CD or CD, an asterisk (*) 
appears next to the entry indicating a change. 

6. Press ~ to return to the menu. 

7. Select Quit to return to the Layout menu, or press ~ to 
return to the editing screen. 

A theta symbol (9) appears in the border indicating that a new 
Format Sheet takes effect on this line. The document will be right 
justified until you change the Format Sheet for Right Justification. 

SETTING CHARACTER SPACING 

MENU PATH: VW/Layout/Format 

When you load the VisiWord program, the character spacing for 
the printer is preset. If you have not changed the program startup 
settings, the text is set to print 10 characters per inch. You can 
change the spacing at the beginning of a document or after a 
required return by changing the Format Sheet. The possible set­
tings for character spacing are: 10, 12, and 15 characters per inch. 

To change the character spacing: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Layout. 

3. Select Format. A Format Sheet appears on the screen. 

4. Use the CD key to position the cursor on the line that reads 
Character Spacing Iper inch I. 

5. Use the G or G keys to position the cursor over the new 
spacing value. 

If you move the cursor by pressing CD or CD, an asterisk (*) 
appears next to Character Spacing indicating you have changed 
this setting. 
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6. Press (E S C) to move the cursor to the menu. 

7. Select Quit to return to the Layout menu, or press ~ to 
return to the editing screen. 

A theta symbol (9) appears in the left border on the line where 
the Format Sheet takes effect. The new spacing remains in effect 
for that document until you change it with another Format Sheet. 

SETTING LINES PER PAGE 

MENU PATH: VW/Layout/Format 

When you load the VisiWord program, the number of lines of text 
that will print per page is preset. If you have not changed the pro­
gram startup settings, this number is set to 50. This number does 
not include any header or footer lines - only the number of 
actual text lines. You can change the number of lines per page at 
the beginning of a document or after a required return. 

To change the number of lines per page: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Layout. 

3. Select Format. A Format Sheet appears on the screen. 

4. Use the CD key to position the cursor on the line that reads 
Lines per Page. 

5. Type the number you want for the new page length. 

If you move the cursor by pressing CD or W, an asterisk (*) 
appears next to Lines per Page indicating you have changed 
this setting. 

6. Press ~ to return to the menu. 

7. Select Quit to return to the Layout menu or press ~ to 
return to the editing screen. 

A theta symbol (9) appears in the left border of the editing screen 
on the line where the new Format Sheet takes effect. This number 
of lines per page remains in effect until you change the Format 
Sheet again. 
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SETTING THE FIRST PAGE NUMBER 

MENU PATH: VWILayout/Format 

When you load the VisiWord program, the page number that 
prints first is preset. If you have not changed the program startup 
settings, this number is set to 1. This means that the number 1 is 
the number that will print first, followed by 2 for the next page, 
and so on. You can change this setting so that the number that 
prints first is a different number. For example, changing the set­
ting to 3 will print 3 first, then 4 on the following page, and so 
on. You can change the first page number at the beginning of a 
document or after a required return on any page. 

Having a page number set does not mean that page numbers 
automatically print on a page. Page numbers only print if you 
specify them in a Header or Footer Sheet. For instructions on how 
to make page numbers print, see "Setting Headers and Footers" 
later in this chapter. 

To change the starting page number: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Layout. 

3. Select Format. A Format Sheet appears on the screen. 

4. Use the OJ key to position the cursor on the line that reads 
First Page Number. 

5. Type the number you want for the first page number. 

If you move the cursor by pressing OJ or CD, an asterisk (*) 
appears next to Fir s t P age N u m be r indicating you have 
changed this setting. 

6. Press ~ to return to the menu. 

7. Select Quit to return to the Layout menu, or press ~ to 
return to the editing screen. 

A theta symbol (e) appears in the left border of the editing screen 
on the line where the new Format Sheet takes effect. This first 
page number remains in effect until you change the Format Sheet 
again. 
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UNIT 3 
USING THE RULER 

MENU PATH: VWILayout/Ru ler 

The VisiWord Ruler at the top of the editing screen shows you 
where your margins and stops for the document are set. You can 
use the Ruler to change your right margin, set and clear stops, 
and set a required indent. 

Note: 

A required indent set from the Ruler is different from an indent 
set with the Indent key o:::AJ. A required indent set from the 
Ruler applies to all following text until you specifically delete or 
change it. Conversely, an indent set with the Indent key o:::AJ 
applies only until you press a required return. 

The Ruler marks each column of the screen with a period (.). As 
you move the cursor across the screen, a shadow cursor ( 1:1 ) 
moves across the Ruler showing the exact column where the cur­
sor rests. Figure 5-3 shows and explains the marks on the Ruler. 

L g!~:;:.::~ :':'m.' L'::~~~~~'~o 
' ... I .... I .... ~!~ .. ~.~. ! ..... ====.~.~!.~.~ .. ~!~ •• ~.~. !~ • .,. •. ~.5 ..••. WI •• 6 •..•• 

~ Sh.d,. '"""' \" G, .. , "Z,.:,' m •• '" 
Moves along ruler ruler Where lines end 
showing cursor and text wraps 
position 
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Figure 5-3. The Ruler 
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Like the Format Sheets, the Ruler has startup settings that are suf­
ficient for most documents. However, you can change the settings 
at the beginning of a document or after any required return. A 
theta symbol (e) appears in the left border of the editing screen on 
the line where the new Ruler settings take effect. 

Note: 

Ruler settings become part of your document and are saved with 
it each time you save it on disk. 

When you select Ruler from the Layout menu to change the set­
tings, the Ruler disappears from the top of the editing screen and 
reappears in the text on the line above the cursor position. Figure 
5-4 is an illustration of the Ruler within the text. 

Figure 5-4. The Ruler in Text 

Note: 

This section contains general instructions for changing Ruler set­
tings. If you need help on a particular item, see the sections in 
this Unit that follow. 
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To use the Ruler to change a setting: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Layout. 

3. Select Ruler. 

The Ruler appears within the text on the line above the cursor, 
pushing the text down one row. 

You move the cursor to the desired position and set or clear set­
tings by using the arrow keys and the Ruler keys: G, M, I, S, C, 
and D. When you finish changing settings, press ~. The 
Ruler disappears from the text and reappears on the editing 
screen. A theta symbol (8) appears in the left border marking the 
place where the Ruler settings start. 

MOVING THE CURSOR ON THE RULER 
(~, ~, or G=Goto) 

You can move the cursor along the Ruler in two ways: using the 
G and G keys or using the Goto Command (G = Goto). 

o If you use the G and G keys, the cursor moves one posi­
tion to the left or right each time you press a key . To move 
the cursor quickly, hold the G or G key down until you 
reach the column you want. 

• If you use the Goto command, press G for Goto. You are 
prompted for a number. 

a) If you want the cursor to move a number of spaces to the 
right, type + followed by the number of spaces you want 
to move. 

b) If you want the cursor to move a number of spaces to the 
left, type - followed by the number of spaces you want 
to move. 

c) If you want the cursor to move to a specific column on 
the Ruler, type the number of that column; do not use a 
+ or - sign before the number. 

When you have typed the correct number, press GIl. The cursor 
moves to the indicated column. 
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SETTING THE RIGHT MARGIN 
(M = MARGIN) 

MENU PATH: VW/Layout/Ru ler 

1. To get to the Ruler from the beginning of your document or 
after a required return, press ~; select Layout; then select 
Ruler. 

2. Position the cursor on the desired column (use the G or G 
keys, or the Goto Command). The maximum right margin is 
255. 

3. Press M. Inverse video on the Ruler shows the new right 
margin, and when you move the cursor an M appears on the 
Ruler marking the new right margin. 

4. If you want to return to the editing screen, press ~. 
Otherwise, change the other Ruler settings, then press ~. 

SETTING AND CLEARING STOPS 
(S - SET, C = CLEAR) 

1. To get to the Ruler from the beginning of your document or 
after a required return, press ~; select Layout; then select 
Ruler. 

2. Position the cursor on the desired column (use the G or G 
keys, or the Goto command). 

3. To set a stop, press S. The stop symbol (I) appears when you 
move your cursor. To clear a stop (I), press C. The stop sym­
bol (I) is gone when you move your cursor. 

4. If you want to return to the editing screen, press ~. 
Otherwise, change other Ruler settings, then press ( ESC 1. 



SETTING REQUIRED INDENTS 
(I - INDENT) 
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1. To get to the Ruler from the beginning of your document or 
after a required return, press ~; select Layout, then select 
Ruler. 

2. Press I. Type + if you want to set the required indent to the 
right of its current setting; then type the number for how 
many spaces to the right you want to set the required indent. 
Type - if you want to set the required indent to the left of its 
.current setting; then type the number for how many spaces to 
the left you want to set the required indent. 

3. Press GIl. An inverse video bar on the Ruler indicates where 
the required indent is set. 

4. If you want to return to the editing screen, press ~. 
Otherwise, change other Ruler settings, then press ~. 

Note: 

A required indent set from the Ruler applies to all following text, 
or until you specifically delete or change it. An indent with with 
the Indent key CEAJ applies only until you press a required 
return. 
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DELETING A RULER 
(0 = DELETE) 

If you decide that a particular Ruler is not correct for your docu­
ment, you can delete the entire Ruler. You must be on the line 
that contains the Ruler you want to delete. When you delete a 
Ruler, your document is automatically reformatted with whatever 
settings that are in effect for the previous Ruler or, if no previous 
Ruler exists, the program startup settings. 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Layout. 

3. You must position the cursor on the line in your document 
where the Ruler you want to delete is set. You can do this 
with the Next and Prev options on the Layout menu. If you 
want to go forward from the cursor position, select Next. If 
you want to go backward from the cursor position, select 
Prevo 

Next and Prev will stop the cursor at any format change 
indicated by a theta (9). If any format change is found, the 
cursor rests on the first character on the line where that for­
mat takes effect. In the Layout menu, above Next and Prev, is 
a row of hyphens. When the cursor rests on a line that con­
tains a Ruler, the second hyphen is replaced with an R. 

If no format change is found, the cursor moves to the end of 
the document, and the editing screen is displayed. 

Select Next or Prev until you find the Ruler that you want to 
delete. 

4. Select Ruler. The Ruler disappears from the top of the editing 
screen and reappears within the text. 

5. Press D for Delete. The settings on the Ruler return to those in 
effect for the previous Ruler, or if no previous Ruler exists, 
the program startup settings. 

6. Press~. The Ruler disappears from the text and reap­
pears at the top of the editing screen. The document is refor­
matted automatically. 
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UNIT 4 
ALIGNING COLUMNS OF NUMBERS 

DECIMAL TAB KEY CE::D 
A Decimal Tab key CE::D lets you align columns of numbers on 
the decimal point easily and neatly. The Decimal Tab key CE::D 
places the cursor on a Ruler stop and as you type a number, the 
decimal point of that number is aligned on the stop. Figure 5-5 
shows a sample document with columns of numbers aligned with 
the Decimal Tab key. 

1.70 
2. ()~j 
2.40 
1.50 
3.80 

Total 11. 45 

Figure 5-5. A Sample Table of Numbers 

Another feature of the Decimal Tab key is that it lets you right 
justify columns of text on a stop. For example, if you had a list 
of words and you wanted the last character of each word to be 
aligned on the same column, you can use the Decimal Tab key. 

To align columns on a stop: 

1. Position the cursor at the left edge of the screen where you 
want the first line of a column to appear. 

2. Press CE::D, the Decimal Tab key. The cursor moves to the 
first stop on the Ruler. Continue pressing CE::D until you 
reach the stop you want. 
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3. a) To align columns of whole numbers, simply type the 
number without a decimal point and the right-most digit 
will align on. the Ruler stop. 

For example, 

123 
456 
789 

b) To align columns of fractional numbers, simply type each 
number and the decimal point will align on the Ruler 
stop. 

For example, 

123.45 
678.9 

.05 

c) To align columns of mixed numbers (whole numbers and 
fractional numbers), type each number with the decimal 
point and the decimal point will align on the Ruler stop. 

For example, 

123.45 
456. 

1.78 

d) To right justify a column of text on a Ruler stop, simply 
type the text and the right-most character will align on the 
Ruler stop. 

For example, 

NAME 
ADDRESS 

PHONE 
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4. If you have additional columns for the same line, repeat steps 
2 and 3 above. Press GD after you type the last character on 
each line. In the VisiWord program, all columns must end 
with a required return if you want to move, copy, or delete' 
columns. 

5. Repeat the above steps for each line. 

Note: 

If you change the Ruler, the characters aligned on the decimal 
tab are not reformatted to reflect the new Ruler. If you want to 
change the Ruler stops, see "Setting and Clearing Stops" in Unit 
3 of this chapter. 
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UNIT 5 
INDENTING PARAGRAPHS 

TAB KEY G) 
INDENT KEY CED 

To indent only the first line of a paragraph, use the Tab key G) 
to move the cursor to the stop you want. If you want to change 
your stops, see Unit 3 on "Using the Ruler" earlier in this chapter. 

The Indent key CED sets a temporary left margin at the next stop 
on the Ruler. This temporary margin is in effect until you type a 
required return. An indent with the CED key does not change the 
settings on the Ruler. 

To indent complete paragraphs in your document, simply press 
CL4J. A ~ appears on the screen, and the cursor moves to the 
next stop to the right. All the following text until the next required 
return will be indented to this stop. 

You can put more than one indent on the same line of text, or you 
can put an indent in the middle of an existing line of text. An 
indent moves existing text to the indent stop, and left aligns all text 
following the indent until the next required return. Figure 5-6 shows 
the same paragraph before and after an indent was inserted. 
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Figure 5-6. An Indented Paragraph 

You can move the cursor across the blank spaces of the indent, but 
you cannot type in this space because the program considers an 
indent as one character. 

To remove an indent from your document, you can use either 
(B K S P ) or CJLIT). Pressing (B K S P ) removes the indent to the 
left of the cursor, and pressing CJLIT) removes the indent at the 
cursor. 

When you load the VisiWord program, it automatically sets stops 
on the Ruler. If you have not changed the program startup set­
tings, the Ruler stops are set at 5 character intervals starting with 
position 0. You can change the Ruler at the beginning of a docu­
ment or on the line after a required return. 
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Note: 

There is no difference between tab stops and indent stops on the 
Ruler. If you want to change the Ruler stops, see "Setting and 
Clearing Stops" in Unit 3 of this Chapter. 
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CENTERING TEXT 

CENTER LINE KEY CE:IQJ 
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You can center a line of text between the left and right margins of 
your document using the Center Line key CE:IQJ. There are two 
methods of centering text: 

• Type the text, then press the Center Line key CE:IQJ, or 

• Position the cursor on a line, press the Center Line key 
CE:IQJ, then type the text. 

The centered text is centered on the center mark (C) on the Ruler. 

You can return centered text to the left edge of the screen by posi­
tioning the cursor on the centered line and pressing the Center 
Line key CE:IQJ. 
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UNIT 7 
HIGHLIGHTING: BOLDFACE, UNDERLINE, 

SUPERSCRIPT, SUBSCRIPT, 
AND OVERSTRIKE 

MENU PATH: VWILayout/Char 

You might want to highlight certain words or phrases in a docu­
ment by underlining them, making them appear in boldface, using 
superscripts or subscripts, or creating special characters by typing 
two characters in the same space. The VisiWord program gives 
you these choices with the Character Attribute (Char) option in 
the Layout menu. Figure 5-7 shows samples of the different 
attributes available using the VisiWord program. 

}--I-- Regre&&ion: 

The Regression func:tion calculates an ordinary lealit-square5 
linear multiple regression, suc:h that: 

y(1) = 8 + mOl>: (il + m(2h: (1) ...... +m(S)x H) 
1 2 5 

2)--+-- B£9!:"~~iQr:L~!,E,!'.L~1·),i!;7.2:----'''-----....l.--------+----'.( 5 
The F Statistic is r-,-~~--------~~4 

2 2 2 
F(k-l,n-I:l = n-kll(-1 lR I1-R ) if R "1 a.nd k " 1 

CD Emphasized Text (Bold) 

CD Underline Text 

® Overstrike 

CD Superscript (Above) 

® Subscript (Below) 

Figure 5-7. The Character Attributes 

Note: 

Additional attributes are provided by some printers. For informa­
tion on using these attributes, see the "Sending Special Instructions 
(Setup Strings) to Your Printer" section in Chapter 6. 
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You can only give one attribute to one character at a time. For 
example, you cannot have a word appear underlined and in 
boldface. It can only be one or the other. If you attempt to apply a 
second attribute to a character, the first attribute is deleted and the 
second attribute applies. 

A character attribute itself (underline, superscript, ... ) does not dis­
play on the screen. You see the result only in the printed document. 

However, all characters that have an attribute appear in inverse 
video on the screen. When the cursor is on a character with an 
attribute, the name or an abbreviation of the attribute is displayed 
on the line above the menu. For example, if a character is 
underlined, it is displayed in inverse video; when the cursor rests 
on that character, the line above the menu displays U/L for 
underline. 

USING BOLDFACE (EMPHASIS) 

MENU PATH: VWILayout/Char/Emphasis 

Before you can apply an attribute to text, you must first type the 
text. 

1. Position the cursor on the character or the first character you 
want to appear in boldface. 

2. Press ~ to use the Main menu. 

3. From the Main menu, select Layout. 

4. From the Layout menu, select Char. 

s. Select Emphasis. The cursor moves back to your document, 
the Main menu appears, and one character appears in inverse 
video. 

If you want more than one character to have this attribute, press 
the Again key CE::2J. You can continue pressing CE::2J until all of 
the characters you want have the attribute. You can use the 
cursor-moving keys, then the Again key CE::2J, to continue giving 
this attribute to characters in other parts of your document. When 
you want to stop giving characters this attribute, press any key 
other than a cursor-moving key. 
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UNDERLINING TEXT 

UNDERLINE KEY C£ID 
MENU PATH: VWILayout/Char/Underline 

You can underline text while you are typing or editing your docu­
. ment by using the Underline key C£ID, or you can use the 
Underline menu option on the Character Attribute (Char) menu. 

Using the Underline Key C£ID 

1. Position the cursor on the character or the first character you 
want to underline. 

2. Press the Underline key C£ID. The character appears in 
inverse video. 

3. Continue pressing the Underline key C£ID until all of the 
characters you want have the attribute. 

Using the Underline Menu Option 

MENU PATH: VW/Layout/Char/Underline 

1. Position the cursor on the character or the first character you 
want to underline. 

2. Press c:e::s.ID to use the Main menu. 

3. From the Main menu, select Layout. 

4. From the Layout menu, select Char. 

5. Select Underline. The cursor moves back to your document, 
the Main menu appears, and one character appears in inverse 
video. 

If you want more than One character to be underlined, press the 
Again key CE:2J. You can continue pressing CE:2J until all of the 
characters you want are underlined. You can use the cursor­
moving keys, then the Again key CE:2J to continue underlining in 
other parts of your document. When you want to stop under­
lining, press any key other than a cursor-moving key. 
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USING SUPERSCRIPTS AND SUBSCRIPTS 
(ABOVE AND BELOW) 

MENU PATH: VW/Layout/Char/Above 
VW/La y a uti C h a riB e I ow 

1. Position the cursor on the character or the first character you 
want to superscript or subscript. 

2. Press ~ to use the Main menu. 

3. From the Main menu, select Layout. 

4. From the Layout menu, select Char. 

5. To use the superscript attribute, select Above. To use the 
subscript attribute, select Below. 

The cursor moves back to your document, the Main menu 
appears, and one character appears in inverse video. 

If you want more than one character to have this attribute, press 
the Again key CE:2J. You can continue pressing CE:2J until all of 
the characters you want have the attribute. You can use the 
cursor-moving keys, then the Again key CE:2J to continue giving 
this attribute to characters in other parts of your document. When 
you want to stop giving characters this attribute, press any key 
other than a cursor-moving key. 

CREATING SPECIAL CHARACTERS 
( OVERSTRIKE) 

MENU PATH: VW/Layout/Cha r/Overstr ike 

The Overstrike option on the Character Attributes (Char) menu 
lets you create special characters by overstriking a character with 
another character. If you overstrike a character with the same 
character, it gives a printed effect similar to but slightly different 
from boldface (Emphasis). 
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Before you can apply this character attribute to text, you must 
first type the text. 

1. Position the cursor on the character or the first character you 
want to overstrike. 

2. Press ~ to use the Main menu. 

3. From the Main menu, select Layout. 

4. From the Layout menu, select Char. 

5. Select Overstrike. 

6. A prompt appears in the lower left corner of your screen ask­
ing you to type the overstrike character. Type the overstrike 
character and press w. 
The cursor moves back to your document, the Main menu 
appears, and one character appears in inverse video. 

If you want more than one character to have this attribute, press 
the Again key c::E2J. You can continue pressing c::E2J until all of 
the characters you want have the attribute. You can use the 
cursor-moving keys, then the Again key c::E2J to continue giving 
this attribute to characters in other parts of your document. When 
you want to stop giving characters this attribute, press any key 
other than a cursor-moving key. 
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USING HYPHENS 

MENU PATH: VW/Layout/Char/Hyphen 
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Many compound words require a hyphen. Also if you break a 
word between two lines, it requires a hyphen. You type these 
hyphens into your text as you are entering your text. This type of 
hyphen is a required hyphen. Because text on the editing screen 
wraps automatically, you seldom need these hyphens. 

The VisiWord program provides another type of hyphen, called a 
ghost hyphen. You insert a ghost hyphen into a word to indicate 
where the word can be broken at the end of a line, if it is 
necessary. For example, suppose you are justifying your docu­
ment, and you have the word "forecast" in the text. You think 
that "forecast" will appear close to the end of a line when the 
document is printed. If you were typing the document on a 
typewriter, you would insert a required hyphen between the two 
syllables and break the word. You want the VisiWord program to 
do the same, only if it has to break the word. You can do this by 
inserting a ghost hyphen between the two syllables. 

To insert a ghost hyphen after the "e" in the word "forecast": 

1. Position the cursor on the character that immediately precedes 
where you want to put the hyphen, on the "e" in "forecast." 
Press ~ to use the Main menu. 

2. From the Main menu, select Layout. 

3. Select Char. 

4. Select Hyphen. 

The hyphen only appears on the screen when the word is broken. 
When you print your document, if the word "forecast" appears at 
the end of a line and has to be broken, it will appear as 
"fore-cast" on the page. If the word does not have to be broken, 
the program does not insert the hyphen in the printed version. 

You can delete a ghost hyphen only by deleting or typing over the 
character that contains the hyphen. 
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If you put a ghost hyphen on the wrong character, for example, 
forec-ast, you can delete it by typing over the character that con­
tains the hyphen. Make sure OVER-TYPE appears on the line above 
the menu before you attempt to type over a character. If INS E R T 
is displayed on the line above the menu, press a::N:.ID to display 
OVER-TYPE. 
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UNIT 9 
BEGINNING A NEW PAGE 

NEW PAGE KEY CDJ 

The VisiWord program sets page breaks automatically depending 
on the number of lines per page that are specified on the Format 
Sheet (see Unit 2 in this chapter). Unless you have changed the 
setting on the Format Sheet, the startup setting for the VisiWord 
program is 50 lines per page. You can, however, set your own 
page breaks while you are typing your document to force one 
page to end and another to begin. 

SETTING A PAGE BREAK 
To insert a page break in your document, press the New Page key 
CDJ. A row of diamonds appears across your document showing 
where a page break occurs. 

A row of diamonds also appears across your document when the 
lines per page limit set on the Format Sheet has been reached; 
however, you can tell the difference between the two. The row of 
diamonds extends into the left and right border of the editing 
screen when you set a page break with the New Page key CDJ. 
The row of diamonds only exists between the left and right 
borders when you reach the lines per page limit set on the Format 
Sheet. 

DELETING A PAGE BREAK 
To delete a page break that you have set with the CDJ key, put 
the cursor on the page break line (the row of diamonds) and press 
the Delete Line key (TIJ. 

Note: 

You cannot delete a page break that was set from the Format 
Sheet. To adjust these page breaks, you must change the Format 
Sheet. 
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UNIT 10 
SETTING HEADERS AND FOOTERS 

MENU PATH: VWILayout/Header 
VWILayout/Z= Footer 

You might want to create documents that require special text to 
be printed at the top and/or bottom of each page, for example, 
report titles at the top of each page and the document page 
number at the bottom of each page. You can do this with the 
Header and Z=Footer options on the Layout menu. Lines that 
appear at the top of the page are called headers and the lines that 
appear at the bottom of the page are footers. 

You can have up to three lines of text on each header and footer, 
and you can specify whether you want the text to appear at the 
left, center, or right of each line. Figure 5-8 shows a sample 
printed page with a header and a footer. 
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CONFIDENTIAL 

Operaticns Depart.ment Page :2 Appl"'Dved 

Caver-ed by the c:url"'ent plan. 

b. Above plan but 1n the cur-rently appl"'Dved 
fOl"'ocilost. 

Neither in the plan or the appl"'Dved 
-forocast. 

3. Capital Equipment EtlpendlturD1i (furniture, 
equipment. and software exceeding .2~O/item). 

Capital equipment expenditurE's aver- $1000 lQUat be 
i nl ti al ad by the Department Manager-. who i ndic: .. t.es 
on the requis.ition whether the pur-chase is covered by 
the current. "Mant.hly Approved Capital Equipmllnt 
List", The president apprcvell this list am:e oil month 
for each depill"'tmE!nt. All capital equipment purchases 
I!Q!.. an thi.s list must be appl"'Dved by the president. 

4. Royalty Advancements 

Royalty Advancementg must be initialed by the 
Manager-. The pr-oject code, nOLme and computer- type 
must be clear-ly stated on the Pur-c:hase Requisition 
and Pur-chase' or-der-. In addition, these document. mu.t 
OIl so r-efer-ence the Royal ty Contr-.ct number- or- a copy 
of the author-'s letter- out.lining spec:ificli of the 
contr-.ct, must acc:ompany the Pur-c:h.se Requisition and 
Pur-c:hase Or-der-. 

B. Pur-r:::hase Regut 51 ti g" fgr-ms 

All r-equests for- ser-vice and mater-ials in eMCe!lS of ,~() 
and not r-eadily .vailable within the company r-equir-e a 
Pur-chase ReQuiaition .nd 15ub&equent Pur-chall$e Or-der-. 
Accounting will Il.9t pay invoif::e5 r-ecaived without 
Pur-f::hase Or-der-s. The only exceptions in eMf::eliS of .:50 D.Q3;, 
r-equir-ing a Pur-chase Requiliition ilnd Pur-chase or-der- ar-. 
as follows: 

Pr-ofessional Fees 

A letter- specifying ser-vices an"d cost iii 
Iilppr-opr-10lte 1n lieu of pur-chase or-der-; cost of 
fees is subject to appr-oval by depar-tmant. manag.r­
and Accounting Manager-. After- appr-ovOll, il letter­
must be sent to Pur-chasing .nd Finance. 

Pur-cha!iii ng Pr-ocedur-e!! 
Tom Hor-n 

CONFIDENTIAL Cr-azy Computers, Inc. 
September- 17, 1982 

CD Header 

® Footer 

Figure 5-8. Printout With Header and Footer 

Note: 

Headers and footers do not appear on the editing screen. They 
only appear when you print the document. 

021·016 
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HEADER AND FOOTER SHEETS 
You set a header or a footer by filling out a Header Sheet or 
Footer Sheet, respectively. The two sheets are identical except for 
the title at the top. Figure 5-9 shows a completed Header Sheet 
and its resulting header. 

Monthly Report Production/Samples __ -+-' 
L+ __ Marketing Dept 

T.Harn _--+----1 

depend on the number of sa.mples that are required. Using the 
statIstics from Oper-ations, this number is 10,340. Although this 
IS higher than fHlrmal. the past month has been more productive 
than normal. 

Figure 5-9. Sample Header Sheet and Resulting Header 

on010lP 

021-017 
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Each sheet consists of the following information: 

Page Number The symbol you type on the text fields of 
Symbol: the Header or Footer Sheet (lLeft, lCenter, 

etc.) to print the page number in the 
header or footer. The VisiWord program 
uses the pound sign (#), but you can 
change this symbol to anything you want 
by simply overtyping the existing 
character. 

Note: 

If you intend to use the character defined as the page number 
symbol as text in your header or footer, you must change the 
page number symbol. Otherwise, the page number of the docu­
ment will appear in the header or footer instead of the symbol. 

Line Length: 

lLeft: 
lCenter: 
lRight: 

2Left: 
2Center: 
2Right: 

3Left: 
3Center: 
3Right 

The width of the header or footer in 
columns. When you first load the 
VisiWord program, this value is set to 65, 
which is the startup right margin setting. 
You can set the line length up to 255 col­
umns, which is also the maximum right 
margin you can set. 

The text fields of the Header and Footer 
Sheet where you type in the header and 
footer text. Typing text in fields lLeft, 
2Left, and 3Left lets you left justify text 
on the first, second, and third line of the 
header or footer, respectively. 

Typing text in fields lCenter, 2Center, and 
3Center lets you center text on the first, 
second, and third line of the header or 
footer, respectively. 

Typing text in fields lRight, 2Right, and 
3Right lets you right justify text on the 
first, second, and third line of the header 
or footer, respectively. 

You can enter up to 40 characters including 
spaces and punctuation in each of these 
fields. 
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Number of 
Single Spaced 
Lines ... 

You must be careful that you do not 
overlap text. For example, if you type 40 
characters in 1Left, 1Right, and 1Center 
and your Line Length is set to 65, the 
entire header or footer will not fit on one 
line, and it will overprint. 

The number of blank lines you want 
between the header and the body of your 
document, and the footer and the body of 
your document. You can have up to 10 
blank lines. 

WHERE TO DEFINE HEADERS AND FOOTERS 
IN YOUR DOCUMENT 

The placement of the cursor on your document when you fill out 
a Header or Footer Sheet directly effects where the header or 
footer will first appear when the document is printed. 

If you want the header to print on the first and all subsequent 
pages of your document, you must fill out the Header Sheet while 
the cursor is on the first line of your document. If you fill out a 
Header Sheet while the cursor is on any other line, the header will 
not print until the next page. 

If you want the footer to print on the first and all subsequent 
pages of your document, you can fill out the Footer Sheet on the 
first line of the document or the line after a required return on the 
first page of the document. 

Note: 

If you want headers and footers to print on the first and all subse­
quent pages, we recommend that you fill out Header and Footer 
Sheets while the cursor is on the first line of the document. 
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DEFINING HEADERS, FOOTERS, AND 
DOCUMENT PAGE NUMBERS 

1. Position the cursor at the beginning of a document or on a 
line following a required return. (See "Where to Define 
Header and Footer in Your Document" for instructions.) 

2. From the editing screen, press ~ to use the Main menu. 

3. From the Main menu, select Layout. 

4. Select Header or Z= Footer. The Header or Footer sheet 
appears on .the screen. 

5. Use the rn and rn keys to position the cursor over the field 
you want to fill-out or change. 

a) To change the Page number symbol or Line length, simply 
type over the existing value. The page number symbol can 
be any character you do not intend to use as text in the 
header or footer, and the line length can be any value up 
to 255. 

b) To define header or footer text, simply type your text in 
the appropriate fields ( 1Left, 1Center, etc.). If text exists 
in these fields and you want to change it, simply over 
type the existing text. You can type up to 40 characters 
including spaces and punctuation in each field. 

c) To have page numbers print in either the header or 
footer, type the Page number symbol in the field (lLeft, 
1Center, etc.) that you want the page number to appear. 
The page number appears in place of the page number 
symbol when the document is printed, and the page 
number increments on each page. 

You can also have text appear with the page number by 
typing the text in front of or in back of the page number 
symbol. For example: Page-I, or Page-lAo 

The value of the first page number that prints on your 
document is set on the Format Sheet. Unless you have 
changed this value, the VisiWord startup setting is 1. In 
other words, the first page number to print on your docu­
ment is 1. If you want some other number to print on the 
first page of your document, position the cursor on the 
first line of your document, then go to the Format Sheet 
and change the first page.number setting to whatever you 
want (see Unit 2 in this chapter for instructions). 

d) To change the number of single spaced lines between the 
header or footer and the text, simply over type the 
existing value. You can have up to 10 lines. 

6. Pre~s~; then select Quit to return to the Layout menu or 
press ~ twice to return to the editing screen. 
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When you return to the editing screen, a theta symbol (9) appears 
in the left border on the line where the Header or Footer Sheet 
takes effect. 

DELETING HEADERS AND FOOTERS 
If you decide that you no longer want a header or footer in your 
document, you can delete the Header IFooter Sheet. 

1. From the editing screen, press CTI1D to use the Main menu. 

2. From the Main menu, select Layout. 

3. You must position the cursor on the line that has the Header 
or Footer Sheet you want to delete . You can do this with the 
Next and Prev options of the Layout menu. If you want to go 
to forward from the cursor position, select Next. If you want 
to go backward from the cursor position, select Prev. 

When a format change is found, the cursor rests on the first 
character on the line where that format takes effect. A theta 
(9) appears in the left border on that line. In the Layout 
menu, above Next and Prev, is a row of hyphens. When the 
cursor rests on a line that contains a Header or Footer Sheet, 
the third hyphen is replaced with an H. 

If no format change is found, the cursor moves to the end of 
the document. 

Select Next or Prev until you find the Header IFooter Sheet 
that you want to delete. 

4. Select Header or Z = Footer. The editing screen clears, and the 
Header IFooter Sheet appears. 

S. Press CTI1D to use the menu, then select Delete. The fields on 
the Header/Footer Sheet return to those that are in effect 
when you load the program. 

6. Select Quit to return to the Layout menu, or press CTI1D to 
return to the editing screen. 
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UNIT 1 
PRINTING 

You can print your document in two ways: 

• By printing directly on your printer. 

Printing 6-3 

• By first sending the document (with its printer formats) to a 
text file; then from the text file to the printer. This method is 
called spooling. 

Using the first method allows you to print your document quickly 
without using unnecessary disk space. Using the second method 
allOws you to return to active editing while the document is print­
ing. Both methods print the document that is currently in 
memory. 

PRINTING DIRECTLY 

MENU PATH: VW/Print/Printer 

When you print a document directly on a printer, you save print­
ing time and disk space because the file prints immediately 
without intermediate steps. However, you cannot edit other 
documents while you are printing as you can when you spool. 
You do not have to save a document before you print it, but it is 
good practice to do so (see Chapter 3, Unit 2, "Saving a Docu­
ment" for details). To print directly: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Print. The editing screen clears, 
and the print screen appears. Your screen should look like 
Figure 6-1. 
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021·011!P 

Figure 6-1. The Print Screen 

The print screen shows the print format in effect, and what 
printer model and printer path are currently set [the printer 
path sends your document to a parallel printer (LPTl: or 
LPT2:) or to a serial printer (COMl: or COM2:)). If you 
want to change the print formats, see "Changing the Format­
ting for Printing" later in this chapter. If the printer model or 
printer path is incorrect, see Appendix A. 

If you have a printer that requires you to manually feed a 
single sheet of paper at a time, you must set the Wait at End of 
Page field on the print format screen to Yes. See "Changing 
Printer Format Specifications" (Unit 5) in this Chapter for 
instructions. 

If the values for the print format are what you want, and the 
printer model and printer path are correct, select Printer. 

3. If your document has not been saved, you are reminded that 
it can be lost if you are printing an appended document. If 
you want to save your document now, select No and go to the 
Storage menu. For details on saving documents, see "Saving a 
Document" in Chapter 3. If you do not want to save it, select 
Yes. 

The document begins printing immediately. A print message 
appears on the screen allowing you to stop printing at any time. 
To make the printer pause, select Pause. Select Resume to continue 
printing. Select Abort to stop the printing entirely. If you abort 
the printing, the program returns to the Print menu. 
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Note: 

If you have inserted a printer format to make the printer pause 
at the end of each page, the printer will stop and the print 
message appears. Select Resume to continue printing. Select 
Abort to stop printing entirely. 

When the specified number of pages is printed or you reach the 
end of the document, the· screen displays the Print menu. 

PRINTING WHILE EDITING (SPOOLING) 

MENU PATH: VW/Print/Spool 

WARNING: 

YOU CANNOT SPOOL USING A SINGLE DRIVE SYSTEM. 

When you spool a document, you can continue to create or revise 
other documents while the printer is printing. The program first 
copies the document to a temporary file, then prints from that 
file. When printing is finished, the file is deleted. 

To spool a document: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Print. The editing screen clears, 
and the print screen appears. Your screen should resemble 
Figure 6-1. 

The Print screen shows the print formats in effect, and what 
printer model and printer path are currently set [the printer path 
sends your document to a parallel printer (LPTl: or LPT2:) or to 
a serial printer (COMl: or COM2:)). If you want to change the 
print formats, see "Changing the Formatting for Printing" later in 
this chapter. If the printer model or printer path is incorrect, see 
Appendix A. 
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WARNING: 

IF YOU ARE SPOOLING A DOCUMENT FROM A FLEXIBLE 
DISK, DO NOT REMOVE THE FLEXIBLE DISK CONTAINING 
THE SPOOLED DOCUMENT FROM THE DRIVE UNTIL 
SPOOLING IS COMPLETED. IF YOU DO, YOUR DISK CAN 
BE DAMAGED. 

If the values for the print format are what you want and the 
printer model and printer path are correct, select Spool. 

The document is copied on a disk. You can stop the creation of 
the file by selecting Abort. When copying is complete, printing 
begins, and the screen displays the Print menu, allowing you to go 
on to other VisiWord functions. 

Note: 

The printer appears to turn on and off periodically while you are 
spooling a file. The disk drive light also goes on and off. To 
your computer, spooling is the secondary function. Therefore, it 
will process other functions before it completes spooling your 
file. However, the appearance of text on. the editing screen may 
be slower while you are printing. 

You can stop spooling at any time. If you are on the editing 
screen and decide you want to stop printing the document that is 
being spooled to the printer, press ~. Then follow these 
steps: 

1. Select Print. The editing screen clears, and the print screen 
appears. The print screen indicates that spooling is in 
progress. 

2. Select Spool. The program reminds you that you are already 
spooling. 

3. If you want to stop spooling, select Yes. The spooling file is 
deleted, and the screen displays the Print menu. If you do not 
want to stop, select No. Spooling resumes, and the screen 
displays the Print menu. 
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UNIT 2 
PRINTING A DOCUMENT ON A DISK 

MENU PATH: VW/Print/Disk 

You can print a document on a disk in the same format as that 
file would print on a printer. This allows you to use VisiWord 
documents with other VisiCorp products, such as the VisiFile™ 
program. You can also print on a disk a document that does not 
include printer format information. See "Printing as an IBM DOS 
File" at the end of this unit for details. 

In the VisiWord program, every document must have a name 
which is used to identify the document to the computer. These 
names can be: 

o Up to 8 characters followed by a period (.) and an optional 3 
character extension. 

o The letters a through z in upper, lower, or upper and lower 
case. 

• The digits 0 through 9. 

Upper-case letters and lower-case letters are treated as the same 
letter. For example, Memo.ext and memo.ext refer to the same 
document. If you type a name that contains too many characters, 
the program automatically corrects it for you. For example, if you 
type memorandum. out as your name, the program corrects it to 
be memorand.out. 

When you supply the name of a document, you must include 
where you want the document to be saved. If you include a drive 
name, for example, A:memo.ext, the document will be saved on 
the disk in that drive. If you do not include a drive name, the 
document is saved on the disk in the drive named as the Docu­
ment Path. If you loaded the program from the VisiWord pro­
gram disk, and if you have not changed the program startup set­
tings, the Document Path is drive B:. If you installed the program 
on a hard disk, the Document Path is the hard disk drive letter. 
For details on the Document Path, see Appendix F. 
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To print a document to a disk: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Print. The editing screen clears, 
and the print screen appears. 

3. Select Disk. 

4. If your document has not been saved, you are reminded that 
it can be lost if you are printing an appended document. If 
you want to save your document now, select No. If you do 
not, select Yes. 

5. You are prompted for a filename. Two options appear: List or 
Type-In. 

a) If you select List, put the cursor on the name you want 
from the list using the arrow keys to move the cursor up 
and down. Use the ( P G UP) and ( P G D N ) keys to see a 
list that is longer than one page. Press GIl to choose the 
name, and press ~ to return to the menu. 

b) If you select Type-In, type the name of the document, and 
press GIl. 

6. If a document exists with the name you chose, you must 
verify that you want to use the name. If you select No, you 
are returned to the Print menu. If you select Yes, the docu­
ment will be copied on the disk. 

You can stop the creation of the file 'by selecting Abort. When 
copying is complete, the screen displays the Print menu allowing 
you to go on to other VisiWord functions. 

PRINTING AS AN IBM DOS FILE 

MENU PATH: VW/Print/Model 

You can print a document to a file that can be used by IBM DOS. 
This file does not include headers, footers, and blank lines that 
form page boundaries or top of forms. This information is 
included when you print on a disk. 

To print a document to an IBM DOS file: 

1. From the Print menu, select Model. 

2. Using the arrow keys, move the cursor to the line that reads 
Pr in t as IBM 0 os f i I e and press GIl. 

3. Select Quit. 

4. Select Disk, and follow the steps for printing on a disk earlier 
in this unit. 
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UNIT 3 
STOPPING THE PRINTER 

When you are printing a document directly on a printer, a print 
message appears on the screen allowing you to stop printing at 
any time. To make the printer pause, select Pause. Select Resume 
to contihue printing. Select Abort to stop the printing entirely. If 
you abort the printing, the program returns to the Print menu. 

When you are spooling a document, you can stop the printing at 
two different times. When you spool a document, it is first copied 
to a temporary file, and then printed from that file. While the 
document is copied, a print message appears on the screen. You 
can stop the creation of the temporary file by selecting Abort. 

You can stop spooling at any time. If you are on the editing 
screen, and want to stop printing the document being spooled, 
press ~. Then follow these steps: 

1. Select Print. The editing screen clears, and the print screen 
appears. The print screen indicates that spooling is in 
progress. 

2. Select Spool. The program reminds you that you are already 
spooling. 

3. If you want to stop spooling, select Yes. The spooling file is 
deleted, and the screen displays the Print menu. If you do not 
want to stop, select No. Spooling resumes, and the screen 
displays the Print menu. 
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UNIT 4 
DISPLAYING MESSAGES 

WHILE PRINTING 

MENU PATH: VW/LayoutlMessage 

You can write messages, insert them into a document (they are 
not displayed on the editing screen), and display them on the 
screen while the document is printing. The printer stops printing 
until you respond to the message. For example, if you have to 
change print wheels in the middle of a document, you can insert a 
message to remind you. When it's time for the new wheel, print­
ing stops until you tell it to continue. 

You create messages and insert them into your text using a 
Message Sheet. Figure 6-2 shows a sample Message Sheet. 

Figure 6-2. Sample Message Sheet 

021-012/P 
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The message can have up to three lines of text. You can put a 
message at the beginning of a document or on the line after a 
required return. To create a message: 

1. Put the cursor on the editing screen where you want the 
message to appear. Press~. 

2. From the Main menu, select Layout. 

3. Select Message. The Message Sheet appears on the screen, with 
the cursor highlighting the first message line. 

4. Using the OJ and CD keys, position the cursor where you 
want to type the message. 

5. Type your message. You can put up to 60 characters on each 
line of the message. 

6. Press ~ twice to return to the editing screen. 

A theta (e) appears in the left border of the editing screen on the 
line where you inserted the Message Sheet. 

The message does not appear on the screen until you print the 
document. When the message appears on the screen, printing 
pauses. You can now do what your message prompts; then select 
Resume or Abort. If you select Abort, printing stops immediately 
and the print screen is displayed. If you select Resume, printing 
continues. 

If you are spooling your document and you go on to editing 
another document, the message still appears on your screen. When 
the message is detected, your current editing is interrupted, the 
printer stops, and the message is displayed. You must respond to 
the message before you can return to your editing. Select Resume 
to continue printing, or select Abort to stop the printing. The 
editing screen reappears. 

If you print your document on a disk, the message is not processed. 
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DELETING MESSAGES 
To delete a message from a document: 

1. Press ~ to use the menu. 

2. From the Main menu, select Layout. 

3. You must put the cursor on the line with the Message Sheet 
that you want to delete. You can do this from the Layout 
menu. Select Next or Prev depending on where the message 
appears in your document. If it appears after the cursor posi­
tion, select Next. If it appears before the cursor position, select 
Prevo 

When a format change is found, the cursor rests on the first 
character on the line where the format takes effect. A theta 
(8) appears in the left border on that line. In the Layout 
menu, above Next and Prev, is a row of hyphens. When the 
cursor rests on a line that contains a message, the last hyphen 
is replaced with an M, for example, ----M. 

If no format change is found, the cursor remains in its original 
position, and the editing screen is displayed. 

Select Next or Prev until the cursor rests on the line with the 
Message you want to delete. 

4. Select Message. The Message Sheet appears on the screen. 

s. Press ( ESC) to use the menu. 

6. Select Delete. 

The message is deleted from the document. 
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UNIT 5 
CHANGING PRINTER FORMAT 

SPECIFICATIONS 

MENU PATH: VW/Print/Format 

In addition to printing your document in the special formats set 
with the Layout menu options (for example, Format Sheet or 
RUler), you can also specify printing formats. Printer formats can 
be set just before you start printing. 

Normally, a document prints from the beginning to the end, using 
your specified paper lengths and margins. However, you can 
change the following instructions at print time without altering the 
formats already set in the document itself: 

• Where in the document to start printing. 

• How many pages to print. 

• How long the paper is. 

a Whether to pause after printing each page. 

• How far the from the top of the paper the first character 
prints (Top Margin). 

It How far from the left edge of the paper the first character 
prints (Printer Offset). 
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All of these values are listed on a print screen that appears when 
you select Print from the Main menu. If you have not changed any 
of the print settings, the print screen should look like Figure 6-3. 

021-011IP 

Figure 6-3. The Print Screen 

Each of the following format settings on the print screen affects 
the physical appearance of your printed document. 

S tart p r i n tin gat allows you to specify where in your document 
you want to start printing. Normally, you start at the beginning 
of the document. If you do want to start at the beginning, you do 
not have to change this setting. However, you are not required to 
start printing at the beginning. If your document has headers or 
footers, they will print regardless of whether the Header/Footer 
Sheets are in the section of the document you are printing. The 
text you print appears at the top of your paper but under the 
header. For example, if you start printing in the middle of a page, 
the first line appears at the top, the last line appears in the middle, 
and the rest of the paper is blank. The next page prints from the 
top of the paper as normal. You cannot start printing in the 
middle of a line. 

Number of pages to print allows you to print a specific number of 
pages at one time. For example, suppose you have a 10 page 
document, but you only want to print the first page. If you set the 
number of pages to 1, only the first page prints. You can print up 
to 9999 pages per document. 
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Wa ita ten d of p age allows you to stop printing at the end of each 
page of a document. The printer stops on the line you designate as 
the paper length. When the printer stops, you can continue print­
ing or stop printing entirely. If you want to continue, select 
Resume. If you want to stop, select Abort. If you select Abort, you 
are returned to the Print menu. 

Pap e r len g t h allows you to specify the length of your paper. The 
standard length of a page is 66 lines. However, this value can 
differ for special forms or legal paper. 

Top margin allows you to specify how many lines you want 
between the top of the paper and the first line of printed text. The 
standard number of lines is 2. If you have a header in your docu­
ment, the top margin is measured from the top of the paper to the 
first line of the header. 

Offset on printed page allows you to specify how many columns 
you want between the left edge of your paper and the first 
character of printed text. The standard offset is 5 columns. 
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Figure 6-4 shows a document printed using three of these printer 
formats. 

<D --
HelllO salllple ViaiCorp Handbook. 

Chapter 3 Page 5 

MIIIOI.'\RDUII 

DATE: Hovtlllbu 12, 1982 

TO: John Doe 

FROH: Henry Smith 

SUBJECT: Customer Support Listing8 

Attached is a copy of the new eu.tomer support liltingl by 
product for the month of Oetob'll' 1982. 

Review the listing for your products .nd return any COllllllenta 
to Jane Brown by the fifteenth. Pay particular attention to the 
COlllments on the VisiWord product. 

Hs/bk 

CONFIDENTIAL December IJ. 1982 

CD Paper offset (5 columns) 

® Space between header and text (3 lines) 

® Footer 

CD Space between text and footer (2 lines) 

CD Body of document 

® Header 

CD Top margin (2 lines) 

Figure 6-4. Sample Document with Top Margin, Offset, and 
Page Length Specified 

® 

}eD 

021-018 
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To change these format instructions: 

1. If you want to specify a starting point other than the begin­
ning of the document, position the cursor where you want 
printing to start. Press ~ to use the menu. 

2. From the Main menu, select Print. The editing screen clears, 
and the print screen appears. 

3. Select Format. 

4. Using the CD and CD keys, position the cursor over the in­
struction you want to change. 

5. You enter new values in two ways, depending on how the set­
tings are displayed: 

a) If two or more settings are displayed, use the G and G 
keys to position the cursor over the option you want. 

b) If one value is displayed, type the new value over the 
existing one. 

6. Continue with step 5 until all of the options are set as you 
want them. Press ~ to return to the menu. 

These format settings remain in effect until you reset them or you 
reload the program. However, none of the Format Sheets in the 
document itself are changed. 



6-18 Chapter 6. Printing Documents 

UNIT 6 
SENDING SPECIAL INSTRUCTIONS 
(SETUP STRINGS) TO THE PRINTER 

MENU PATH: VW/Layout/Format 
VW/Layout/Char/1 through 4 

You can take advantage of special capabilities provided by your 
printer using setup strings. A setup string is a sequence of 
characters that sends specific instructions to your printer. Each 
printer model uses different setup strings. To find out what the 
setup strings are for your printer, see your printer manual. 

Many setup strings contain nontext characters. For example, the 
string" AH0F" means "start printing compressed characters" to the 
IBM 80-Character-Per-Second Matrix Printer. Using the VisiWord 
program, you enter these nontext characters as normal characters. 
When the document is printed, the program interprets the string 
using the code defined in Table 6-1. 

J:able 6-1. Nontext Character Code for Printer Setup Strings 

Character Typed 

AC 

AE 

AH 

AR 

AL 

AA 

Meaning 

The Control Key 

The Escape Key 

The following number is 
hexadecimal 
Carriage Return 

Line Feed 

A 

For example if the setup string you want is "I\H0F" you would 
type I\HOF when defining your string (see the following section for 
details). The printer begins printing compressed characters when it 
comes to the instruction 1\. 

USING SETUP STRINGS 
You do not type your setup string directly into your document. 
To use the capabilities of your printer, you must do two things 
before printing: 

1. Define your setup string in a Format Sheet. 

2. Mark the text where the special printing format will take 
effect. 
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You define your setup strings using a Format Sheet. To do this: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Layout. 

3. Select Format. The editing screen clears and a Format Sheet 
appears. 

4. Using the CD or CD key, position the cursor on Use r set u p 
string 1. 

5. Type the setup string you need using the characters in Table 
6-1. The string can be up to 10 characters. 

6. Continue with steps 4 and 5 until all of the setup strings you 
want are defined. 

You define most setup strings in pairs: the first turns on the 
special printing feature and the second turns it off. The 
VisiWord program does not understand user-supplied setup 
strings. Therefore, your printer may not stop printing in the 
special format until you explicitly tell it to with another setup 
string. Consequently, you must define the pair of setup strings. 

7. Press ( E S C.l. 

The Format Sheet disappears, and the screen displays the Main 
menu. 

Having a setup string defined does not automatically start the 
printer printing with the special option. You must mark where 
you want the setup string to be in effect. To mark the text: 

1. Position the cursor in the text where you want the special 
printing feature to start. 

2. Press ~ to move to the Main menu. 

3. Select Layout. 

4. Select Char. 

5. Select the number which corresponds to the setup string you 
want. The first marked character appears in inverse video 
(dark characters on a light background) on the editing screen. 

6. If you want to continue this special feature over more than 
one character, press CE2J the Again key. The next character 
appears in inverse video. Continue pressing the CE2J until all 
the text you want to have special printing appears in inverse 
video. 

7. If you have to explicitly turn off the special formatting, you 
must go through this procedure again selecting the number 
which corresponds to the second setup string. 

You are now ready to print your document. 





CHAPTER 7 

Sample Applications 

This chapter provides three sample applications designed to show 
you how to format a variety of commonly used documents. You 
can use these formats as guidelines for your documents and for 
practice on formatting quickly. 

Each sample application has two parts: explanations and sample 
illustrations. On the right hand page is a printout of a sample 
document with circled numbers pointing to differences in format­
ting. On the left hand page, each format is explained to show you 
how the sample was produced. 

7-1 
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SAMPLE 1 

CD RIGHT JUSTIFY TEXT- Manual Reference: Chapter 5, Unit 2. 
Set general format. of memo to right justify. 
Press ~ and select Layout, then Format. 
Move cursor to Rig h t Jus t i fie a t ion. Use rn or CD key. 
Move cursor to Yes. Use G or G key. 
Press ~ twice. 

® CENTER TEXT- Manual Reference: Chapter 5, Unit 6. 
With cursor at the left edge of the screen, type MANUAL 
CONSULTING. INC. 
Press Center Line key CE:IID. 

® BOLDFACE TEXT- Manual Reference: Chapter 5, Unit 7. 
Move the cursor to the M in MA N U A L (press ( HOM E ) 
or use arrow keys to do this}. 
Press ~ and select Layout, then Char. 
Press GIl; then press Again key (TIJ to highlight whole 
title. 



® ~ MANUAL CONSULTING, INC. Gll 

IJ':±J ~ ~ cu:J cu:J cu:J ~ cu:J cu:J cu:J D ate: 9/ 1 3 / 8 2 Gll 
Gll 
To:cu:Jcu:J Writing Staff Gll 
Gll 
From: C£::I) T. E. Horn GJ 
Gll 
Re: C£I) Comments from TimeTron Cd) 

Gll 
Gll 

Sample 1 7-3 

As you know, TimeTron has returned the review copies of the 
Timing Board manuals. Their technical comments are minor. Please 
incorporate them as necessary_ They wrote some comments that 
refer to our approved specifications. So that we can finish their 
manuals on schedule, we have agreed to make only the following 
changes: GIl 
Gll 
c::E::1J a) CEAJ Rename all t1partsll as "Chapters", and all "Modules" 

as "Units". GIl 
Gll 
cu:J b) c::E::A)Include 

tables, 
descriptive captions for all photographs, 

and illustrations. CdJ 
Gll 
cu:J c) CEIl Include a glossary of terms in each manual. GIl 
Gll 
You should ignore any 
sending the manual for 
problems, see me. GIl 

other editorial comments. We are 
another review cycle. If you have 

not 
any 
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SAMPLE 2 

G) SET DOCUMENT HEADER - Manual Reference: Chapter 5, 
Unit 10. 
Press ~ and select Layout, then Header. 
Move cursor to: Type: 

1 Left Publications Process 
1 Right September 17. 1982 
2 C e n t e r CONFIDENTIAL 
3 Left Chapter 3: Printing 
3 Rig h t Thomas Horn 

Move the cursor to the line showing the number of lines 
following the header. Type 3. Press ~ twice. 

® CLEAR AND SET STOPS- Manual Reference: Chapter 5, Unit 3. 
Press ~ and select Layout, then Ruler. 
Type C at columns 5, 15, 20 30, 35, and 45. 
Type S at column 55. 

SET RIGHT MARGIN A T COLUMN 7fJ 
From the Ruler, type G. Type 70. Press GIl. Type M 
Press ~ twice. 

® CLEAR AND SET NEW STOPS- Manual Reference: Chapter 5, 
Unit 3. 
Press ~ and select Layout, then Ruler. 
Move the cursor to column: Type: 

25 C 
30 S 
40 C 
45 S 
55 C 
60 S 

CD UNDERLINE TEXT - Manual Reference: Chapter 5, Unit 7. 
Type the number on the sample (50, 5,000, or 3.80). 
Move cursor to first digit of the number (use G key). 
Press Underline key CEID until entire number is highlighted. 

® DOCUMENT FOOTER-Manual Reference: Chapter 5, Unit 10. 
Type ~ and select Layout, then Z=Footer. 
Move cursor to 1 Center and type Page 3-#. 
Move cursor to 3 Rig h t and type First Draft. 
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{
Publications Process 

(][) Chapter 3: Printing 

I 
® 

CONFl DENTI AL 
September 17, 1982 

Thomas Horn 

® 

When a manual is ready to print, bids are requested from at least 5 
vendors. When all the bids are received, they are evaluated and the 
contract is awarded according to the procedures outlined in Section 5. 
When printed manuals are received from the vendor, a Cost Summary is 
then prepared using the format outlined below. ~ 
G!l 
G!l 
G!l 
CBJ Five manuals were printed in the month of September. The 

following lists the manuals. the number of pages, the number 
of copies printed. and the cost of each manual ~ 

G!l 
G!l 
GJ MANUAL GJ PAGES/ea 
G!l 
GJ User's Guide CEIl 75 
GJ Reference CEIl 150 
GJ Tutorial CEIl 35 
GJ Ref. Card CEIl 10 
GJ Exercises CEIl 50 
G!l 
GJ TOTAL CEIl 
G!l 
GJ AVERAGE CEIl 
G!l 
G!l 
The Cost Summary 1s forwarded 
Action Required addressee and 
Accounting and Finance. ~ 

GJ 

CEIl 
CEIl 
CEIl 
CEIl 
CEIl 

Page 3-1 

QUANTI TY GJ COST/UNIT G!l 

10,000 CEIl 1. 70 G!l 
5,000 CEIl 2.05 G!l 

10 ,000 CEIl 2.40 G!l 
15,000 CEIl 1. 50 G!l 
5,000 CEIl 3.80 G!l 

CEIl G!l 

CEIl G!l 

® 
.. 

First Draft 
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SAMPLE 3 

CD SET DOCUMENT HEADER - Manual Reference: Chapter 5, 
Unit 10. 
Press ~ and select Layout, then Header. 
Move cursor to: Type: 

1 Left IBM PERSONAL COMPUTER 
1 Rig h t VISITREND/PLOT 
2 Left Reference 
2 Rig h t User's Guide 
3Center SAMPLE PAGE 

Move cursor to line showing the number of lines following the 
header. 
Type 3. 
Press ~ twice. 

® SUBSCRIPTS-Manual Reference: Chapter 5, Unit 7. 
Type the letter or number to be subscripted. 
Move the cursor back to the letter or number (use G key). 
Press ~ and select Layout, Char, then Below 
Continue typing document. 

® SUPERSCRIPTS-Manual Reference: Chapter 5, Unit 7. 
Type letters to be superscripted (th). 
Move cursor back to first letter to be superscripted (use G 
key). 
Press ~ and select Layout, Char, then Above. 
Press Again key ~ to superscript the second letter. 
Continue typing the document. 



Sample 3 7-7 

IBM PERSONAL COMPUTER 
Reference 

VISITREND/PLOT 
User's Guide 

SAMPLE PAGE 

~ The formulas used by the VisiTrend/Plot program in computing 
regressions are summarized here for you convenience. For 
additional information on these and related formulas. refer to 
current textbooks dealing with econometrics and statistics. ~ W ~~ ________ ~ _________ ~ 
~ The values in defined as fo.lows: ~ ~ 
W 
Gl Gl 
W 
Gl Gl 
W 
Gl Gl 
W 
W 

Let Xj(i) = ith data point from jth independent series. W 

m(i) ith coefficient. GTI 

y( 1) data point from dependent series. ~ 

~ calculates an ordinary least-squares 
linear multiple r gresslon. such that: GD 
W 
Gl y(i) D B + mel Xl(i) + m(Z)XZ(i) + + m(S)xS(i) W 
W 
(3) You must specif' ~'he dependen': variable and frc. u one to five 
independent variablts from the se ies in memory. If you select 
more than five seriel ~or indepenc.~nt variables, on~v the first 
gve are used. W \-"-_____ l-________ l-_____ ® 
~ The results of the regression include the name of the 
dependent variable, the range, and the number of data points. For 
each independent variable, the series name t coefficient, standard 
error, and t-statistic are displayed. GD 
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USING YOUR PRINTER 

Using Your Printer A-3 

The VisiWord program provides several options for you to print 
your documents. This appendix describes the supported printers 
and how to use them. 

SUPPORTED PRINTERS 
The startup printer for the VisiWord program is the IBM 
80-Character-Per-Second Matrix Printer. The Option Installation 
Instructions, packed with the printer describe how to unpack, 
install, and checkout this printer. It also describes how to control 
the output by sending setup strings (or control codes) to the 
printer. 

The VisiWord program also supports the following printers: 

Parallel: 
Epson 80-Character-Per-Second and 100-Character-Per-Second 
Matrix printers (with or without the Graftrax option) 
NEC Spinwriter ™ 7730 and 8023A printers 

Serial: 
QUME Sprint 9 printers 
Diablo 630 printer 
NEC SpinwriterTM 7710 printer 

Serial or Parallel: 
Okidata (Microline) 82A, 83A, or 84 printers 
QUME Sprint 11 Plus printers 

WARNING: 

THE VISIWORD PROGRAM SUPPORTS A PRINTER LISTED 
AS Any other printer. IF YOU SELECT THIS AS YOUR 
MODEL, THE CHARACTER ATTRIBUTES IN YOUR DOCU­
MENT WILL NOT BE PRINTED. THIS INCLUDES PRINTER 
SETUP STRINGS. IF YOU INCLUDE ANY ATTRIBUTES IN 
YOUR DOCUMENT, THEY ARE IGNORED, AND THE 
DOCUMENT IS PRINTED AS THOUGH THEY DID NOT 
EXIST. HOWEVER, THE VISIWORD PROGRAM ALSO 
SUPPORTS A PRINTER LISTED AS Any other printer with setup 
strings. IF YOU SELECT THIS AS YOUR MODEL, THE 
CHARACTER ATTRIBUTES ARE IGNORED BUT THE SETUP 
STRINGS WILL BE PRINTED. 
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If you are using one of the supported printers, follow the installa­
tion and checkout procedures in its manual. 

If your printer has a switch for performing auto line feeds, it must 
be set to OFF to be used with the VisiWord program. 

CHANGING PRINTER MODELS 

MENU PATH: VW/Print/Model 

The standard printer for the VisiWord program is the IBM 80 
Character-Per-Second Matrix Printer. When you initially load the 
program, this is the printer that is expected. However, you are not 
required to use this printer, and any supported printer can be 
selected as your printer. To select a different printer model: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Print. The editing screen clears, 
and the print screen appears showing the print formats in 
effect, and what the printer model and printer paths are. 

3. Select Model. A list of supported printers appears on the 
screen. The standard printer is highlighted by inverse video 
(dark characters on a light background) and is marked by an 
asterisk (*). 

4. Using the OJ and OJ keys, move the cursor to the printer 
model that you want. The asterisk remains in its original posi­
tion. 

5. Press the space bar. The asterisk moves to the model you 
chose. 

6. Press GIl to return to the menu. 

7. If you want to change the printer model for this editing ses­
sion only, select Quit. You return to the Print menu. If you 
want to change the printer model startup setting, select Save. 
The model you, chose is put on the program disk. 

If you want to return to the model that was selected when you 
first entered the Model menu, select Restore. If you want to use 
the model that was last saved to disk, select Load. Select Quit to 
return to the Print menu and the print screen. 
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CHANGING PRINTER PATHS 

MENU PATH: VW/Print/Z= Path 

When you load the VisiWord program, it sends all information to 
the LPT1: path. If your printer is not attached to that path, you 
can change it so that the information always goes to the right place. 

There are four printer paths available through the VisiWord pro­
gram: LPTl:, LPT2:, COMl:, and COM2:. If you are using a 
paraliel printer, you must use LPT1: or LPT2:. If you are using a 
serial printer, you must use COM1: or COM2:. 

To change the printer path: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Print. The editing screen clears, 
and the print screen appears showing the print formats in 
effect, and what the printer model and printer paths are. 

3. Select Z=Path. A list of printer paths appears on the screen. 
The expected path is highlighted with inverse video. 

4. Using the G or CD keys, move the cursor to the path that 
you want. 

s. Press ~ to use the menu. 

6. If you want to change the path for this editing session only, 
select Quit. You are returned to the Print menu. If you want 
to change the program startup settings, select Save. The new 
path is saved on the program disk. 

If you want to return to the path that was selected when you first 
entered the Path menu, select Restore. If you want to use the path 
that was last saved to disk, select Load. To return to the Print 
menu, select Quit. 
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Settings for Serial Printers 
If you are using a serial printer, in addition to having the printer 
attached to the correct path, you can also set the baud rate, 
number of bits to transmit, and parity. If you have not changed 
the program startup settings, when you first load the VisiWord 
program, the baud rate is set to 1200, the number of bits is set to 
7, and there is no parity. However, you are not required to use 
these settings. To change the settings: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Print. The editing screen clears, 
and the print screen appears, showing the print formats in 
effect, and what the printer model and printer paths are. 

3. Select Z=Path. The possible printer paths, baud rates, number 
of bits, and parities appear on the screen. 

4. Using the CD and CD keys, move the cursor to the option 
you want. 

5. Using the G and G keys, move the cursor to the value you 
want. 

6. Continue with steps 5 and 6 until all the options are set as 
you want them. Press ~ to use the menu. 

7. If you want to change these settings for this editing session 
only, select Quit. You are returned to the Print menu. If you 
want to change the program startup settings, select Save. The 
new baud rate, number of transmission bits, and parity are 
saved on the program disk. 

If you want to return to the settings in effect when you first 
entered the Path menu, select Restore. If you want to use the set­
tings that were last saved to disk, select Load. 
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APPENDIX B 
USING THE VISIWORD PROGRAM WITH 

THE VISIFILE™ PROGRAM 

You can use the VisiWord program together with the VisiFile™ 
program to create form letters. A form letter is a letter that can be 
sent to several people without substantial changes. To produce 
form letters, you use the VisiWord program to enter and edit the 
letter. Then, you can merge a VisiFile data file with the VisiWord 
document to create the finished letters. This appendix describes 
only how to create documents that can be used by the VisiWord 
program. 

FORM LETTERS 
A form letter is a special function of the VisiFile program. To the 
VisiWord program, however, it is just another document. To use 
the two programs effectively, you must understand the following 
terms as described in the VisiFile User's Guide: 

form letter skeleton: The basic text of the letter containing both 
the information that remains the same and the information that 
changes with each printing. 

fields: The name given to the information that changes with each 
printing that appears in the form. You enclose a field in less-than 
«) and greater-than (» symbols. For example, <name>. 

record: The actual information that changes with each printing. 

data file: A list of records corresponding to the fields in one 
skeleton. 

You can print one form letter for each record in the data file. 

CREATING A FORM LETTER 
You create the form letter skeleton using the VisiWord program. 
To do this: 

1. Load the program and create the document just as you would 
any other. For instructions, see "Creating a Document" in 
Chapter 3. 

2. Type the text as you want it to appear on the letter, until you 
want to enter a field. 
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Note: 

You cannot highlight characters using underline, emphasis 
(boldface), superscript, subscript, or overstrike. You can include 
these attributes in the file, but nothing will transfer to the actual 
form letter. 

3. Enter the field. Field names must be entered exactly as they 
are defined in the data file. Uppercase and lowercase letters 
are significant. Spaces within the field must be shown. For 
example, to use the field with the name "firstname", you type: 

Dear < firstname > . 
4. Continue typing the skeleton until all of the text and fields 

have been entered. 

You can now save your document. You do not have to do so. 
However, if you think you may want to revise the skeleton, you 
should. You save a form letter skeleton just as you would any· 
other document. For instructions, see "Saving a Document" in 
Chapter 3. 

SENDING A FORM LETTER TO A DISK FILE 
The VisiFile program takes the form letter skeleton, enters the 
specific data in place of the field names, and prints the form let­
ters. Before it can do any of these functions, you must make the 
skeleton an ASCII (American Standard Code for Information 
Interchange) file so that the VisiFile program can read it. To do 
this: 

1. Load the form letter skeleton just as you would load any 
other VisiWord document. See "Loading a Document" in 
Chapter 3 for details. 

2. Press ~ to use the menu. 

3. From the Main menu, select Print. 

4. Select Model. The list of available printer models appears on 
the screen. One of the models is highlighted with inverse 
video and marked by an asterisk (*). 

5. Using the CD or CD keys, move the cursor to the line that 
reads P r i n t a siB MOD S f i I e and press the space bar. An 
asterisk (*) appears on that line indicating a change. 
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6. Press GIl to return to the menu. 

7. Select Quit. The Print menu reappears. 

8. Select Disk. You are prompted for a file name. Do not use the 
same name that you saved the skeleton under. If you do, you 
will be unable to use that file again. 

9. Select Type-In. Type the new name of the document and press 
GIl. If the file is stored on a disk in a drive other than the 
drive indicated by the document path, you must include the 
disk drive in the name. For example, A:myfile. 

The document is copied onto the disk, and the print screen and 
Print menu appear. Your file is now in a form that can be used by 
the VisiFile program. For instructions on how to create the data 
file and print your form letters, see Chapter 6 in the VisiFile User's 
Guide. 

Note: 

The VisiWord program automatically inserts a form feed at the 
end of the letter. 
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APPENDIX C 
USING THE VISIWORD PROGRAM WITH 

THE VISICALC® PROGRAM 

You can include VisiCalc® spreadsheets in your VisiWord 
documents. You use the VisiCalc program to enter and calculate 
the data. Then, using the VisiWord program, you can merge the 
files together to create the finished document. This appendix 
describes how to create the VisiCalc file so that the VisiWord pro­
gram can use it, and how to put the files together to create the 
finished document. 

CREATING THE VISICALC FILE 
You create the VisiCalc file just as you would any other VisiCalc 
file. So that the VisiWord program can read the information, you 
have to print the VisiCalc file onto a disk using the Print com­
mand, as described in your VisiCalc manual. 

Note: 

The resulting VisiCalc file is an IBM DOS text file in ASCII 
(American Standard Code for Information Interchange) format, 
not a DIFM file. 
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USING THE VISICALC FILE 
Once you have printed the VisiCalc file onto a disk, you can use it in 
a VisiWord document. You can load the file or include it in another 
file, just like any other VisiWord document. For instructions on 
loading and including documents, see "Loading a Document" and 
"Including One Document Within Another" in Chapter 3. 

Note: 

The margins of your VisiCalc file may be longer than those set 
for the VisiWord document. To avoid incorrect line wrapping, 
insert a new Ruler with a right margin set to the same length as 
your spreadsheet line lengths before including or loading the file. 
For example, if your column width in the VisiCalc file is set to 9 
and your file has 10 columns, the line length of your VisiCalc 
sheet is 90. You would need to reset the line length (right 
margin) in the VisiWord document to 90. 



APPENDIX D 
ERROR MESSAGES 

Error Messages D-1 

This appendix lists all of the error messages that can appear when 
you are using the VisiWord program and explains how you can 
fix the problem or eliminate the error. In general, messages that 
refer specifically to flexible disks will not appear if you have a 
hard disk. Error messages, when incurred, display on the line 
above the menu. To make the message disappear, press GIl as 
instructed at the end of each error message. 

Append fi Ie not found. 

You have a document that is to have another file appended to it, 
but VisiWord cannot find the second file. Be sure you have 
entered the correct name on the Append Sheet and that the flex­
ible disk containing the second document is inserted in the correct 
drive. 

Cannot access data on drive XX. 

You tried to complete some process in drive XX; however, the 
VisiWord program cannot get to the data. Be sure there is a flex­
ible disk in that drive, that it is the correct disk, and that it is not 
write-protected. Try again.' 

Cannot append. No Append Sheet exists. 

You tried to load a file using Append, but no Append Sheet is 
defined at the end of the first file. You must reload the first file, 
insert an Append Sheet as its last line, and save the file. Try 
again. 

Cannot access data on drive XX. 

You tried to complete some process in drive XX; however, the 
VisiWord program cannot get to the data. Be sure there is a flex­
ible disk in that drive, that it is the correct disk, and that it is not 
write-protected. If you are on a hard disk system, be sure you are 
in the correct directory, as only documents in the current direc­
tory are accessed. Try again. 

Cannot delete the only window. 

You tried to close a window (Windows/Close) and you only had 
one window on the screen. Use Delete/Memory if you wish to 
clear the screen. 
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Cannot initialize disk. 

You tried to initialize a new flexible disk (Storage/Maintenance/ 
Initialize); however, the process could not be completed. Be sure 
there is no write-protect tab on the disk to be initialized. If 
necessary, use another disk. Try again. 

Could not access the spool fi Ie. 

Could not create the spool file. Check the disk. 

For both of these messages, your flexible disk is not ready to 
receive information, or it is full. Check your disk drive to make 
sure there is a disk, it is correctly inserted, and it is not write­
protected. Try the command again. If the error persists, your disk 
could be full. Insert another disk or delete some documents and 
try again. 

Could not find "search string." 

You entered a specific word or phrase to find in your document; 
however, the VisiWord program could not find it. Be sure all 
words are spelled correctly, all spacing is correct, and capitaliza­
tion is correct. Try again. 

Could not save in the control file. Check the disk. 

You tried to save new startup settings for printer paths or models. 
The file needed to do this, CONTROL.VW, is not in the drive 
that contains the VisiWord program. Check to see that your 
VisiWord program disk is in the correct drive. If it is, copy the 
CONTROL. VW to your program disk. The file can be copied 
from any VisiWord program disk. 

Default fi Ie cannot be saved. 

You created a default document that is too large to be saved on 
the VisiWord program disk. You must edit your document to 
make it smaller. If you are using flexible disks, be sure the pro­
gram disk is not write-protected. If you are on a flexible disk 
system, you may need to erase any previous DEFAULTS.VW file. 

Delete a sheet only after a required return. 

You tried to delete a Format Sheet, Ruler, Message Sheet, Append 
Sheet, or Header/Footer Sheet after text with no required return. 
Re-enter the editing screen and go to where you want to edit the 
format. Press GJJ to enter a required return. Then you can delete 
the sheet. 

De-spooling to the printer. Abort printing? 

You made a second spool request before the first request finished. 
Once spooling has begun, it must be completely finished before 
another spool request can be accepted. If necessary, you can stop 
printing the first document. 
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Disk error reading spool file. Retry? 

The spooler was unable to read from the spool file. The disk 
should be checked or replaced and another spool attempted. 

Document name for VisiSpel1 cannot be saved. Check the disk. 

You tried to use the VisiSpell program to check the spelling in 
your document; however, there is not enough space on your 
document disk for the VisiSpell file to be saved. You may need to 
delete some files or use a new disk. 

Drive does not exist. 

D r i v e XX i san imp rap e r d r i ve . 

Both of the above messages indicate you tried to read a document 
from or write a document on a disk in a drive that the program 
cannot find. First retype the command. If the error persists, you 
should check the document and spool paths that are listed under 
Storage/Maintenance/Path. 

Error while reading the append file. 

You tried to append a file to a current document, but the 
VisiWord program cannot read the file. Be sure you have the cor­
rect flexible disk inserted and that the file name is correct in the 
Append Sheet. Try again. 

File xxxxxxxx not saved. Insufficient disk space. 

Your disk is not ready to receive information, or it is full. Check 
your disk drive to make sure there is a flexible disk and it is cor­
rectly inserted. Try the command again. If the error persists, your 
disk or directory could be full. Delete some documents or insert 
another flexible disk and try again. 

Fi Ie xxx xxx xx cannot be accessed. Check the disk. 

You tried to access a file that the VisiWord program cannot find. 
Try again. Be sure you spell the filename correctly and indicate 
the correct drive. 

File xxxxxxxx cannot be read. Check the disk. 

You tried to read a file that the VisiWord program cannot use. 
You should return to IBM DOS to see what the file contains. 
Then try again. 

Fi Ie xxxxxxxx not accessed. VisiWord fi Ie format error. 

You tried to use a file that the VisiWord program can no longer 
use. This file was once in the correct format but is no longer. You 
cannot read the file using the VisiWord program. 
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File xxx xxx xx cannot be written. Check the disk. 

You tried to write a file that the VisiWord program could not 
write. Be sure you have the correct flexible disk inserted and that 
it is not write-protected. Then, try again. You may need a new 
disk. 

Fi Ie xxxxxxxx cou Id not be renamed. 

The VisiWord program cannot rename your file. Try to rename 
the file using IBM DOS. 

File xxxxxxxx exists, use another name. 

You tried to rename a file using a name of another file. Try to 
rename it again with a unique filename. 

File xxxxxxxx is too large, only partly included. 

You tried to include (StoragelInclude) a document that is too 
large for the VisiWord program. The program only includes as 
much of the document as possible. Although you cannot edit the 
rest of the document, the original text is not affected. You may 
wish to use Append, rather than Include. 

File xxxxxxxx is too large, only partly loaded. 

You tried to load a document that is too large for the available 
memory. This usually occurs when you have two windows open 
(Windows/Op~n). Close the lower window and try again. 

Fi Ie xxxxxxxx does not exist. 

You tried to use a file that the program cannot find. You should 
check the directory of the disk first using Storage/ 
Maintenance/List to see what files it contains. Then retype the 
command. The file you want may be on another disk. 

Fi Ie xxxxxxxx is an illegal fi lename. 

The filename is not a legal name. Re-enter the name; make sure it 
is spelled correctly and is from one to eight characters long. 

File xxxxxxxx not printed. Insufficient disk space. 

A disk error was detected while printing to disk or writing the 
spool file to disk. Your disk or directory is probably full. Delete 
some documents or use a new flexible disk, if appropriate. 
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Formatting of your document has caused out of memory. 
Abort printing? 

You have made a change to a Format Sheet, Ruler, Message 
Sheet, Append Sheet, or Header/Footer Sheet that causes the 
document to take up more memory than is available. This may 
cause improper formatting of the document on the printer. The 
file should be split into two files. 

Invalid number on Ruler. Try again. 

You tried to move the cursor past the left or right boundaries of 
the Ruler. A Ruler can only go from 0 on the left to 255 on the 
right. Note that the total of the required indent and the margin 
cannot be greater than 255. 

Insert the VisiWord disk. 

You attempted to perform a task that requires the VisiWord pro­
gram disk. Insert the VisiWord disk; then press GIl as prompted. 

May not create that small a window. 

You tried to create a window (Windows/Open) that contained less 
than three lines. Try again and make sure the window is at least 
three lines high. 

Modifya sheet only after a required return. 

You tried to edit or create a Format Sheet, Ruler, Message Sheet, 
Append Sheet, or Header/Footer Sheet after text with no required 
return. Re-enter the editing screen, and go to where you want to 
edit the format. Press GIl to enter a required return. Then you can 
modify the sheet. 

No Help file available. 

The HELP. VW file could not be read. Return to IBM DOS to be 
sure it is in the same drive as your VisiWord program. 

Only ten files at a time can be deleted. 

For the Delete command, you cannot choose more than 10 
documents at one time. Unmark one of the files by moving the 
cursor to a selected filename and pressing the space bar. 

One printer model must be selected. 

You do not have a printer model selected. Select one and try 
again. 



D-6 Appendices 

Only one window. 

You attempted to switch to a second window, but there is only 
one window on the screen. Select Windows/Open if you wish to 
create the second window. 

OUT OF SPACE. Please save document. 

You have no more document memory. You must save your docu­
ment immediately to avoid losing data or formatting. Refer to 
Appendix G for procedures to split your document before continu­
ing editing. 

Paths not saved. Check Program Disk. 

You tried to create or change document or spooling paths 
(Storage/Maintenance/Path), but the settings were not saved on 
the program disk. Check to be sure the disk is not write-protected. 
The disk may be full. You may need to delete the DEFAULTS.VW 
file (Storage/Default) or some documents, as the path settings 
must be on the program disk. 

Printer control fi Ie not found. 

You tried to print, but the required file, CONTROL.VW, is not in 
the drive that contains the VisiWord program. Your document 
will be printed without any formatting. You may wish to abort 
printing. Check to see if the VisiWord program disk is in the cor­
rect drive. If it is not, insert the disk and try again. If it is, you 
must copy CONTROL. VW back to your program disk. The file 
can be copied from any VisiWord program disk. 

Pri nter not ready. Retry? 

Your printer is not ready to receive information. Make sure that it 
is plugged in, attached to the computer, turned on, on-line and 
has paper. Then, try again by selecting Yes. 

Running Iowan space. Please save document. 

You are approaching the limit to document memory. If you are 
not finished editing, you should define an Append Sheet and save 
your document. Then continue editing a new file to append. Refer 
to Appendix G for more specific procedures. 

Spool fi Ie not found. Retry? 

The original flexible disk to which the document was spooled has 
been removed, or there is a disk error. Be sure the correct disk is 
inserted. 
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Spooling drive can't be the same as drive with VisiWord disk. 

You tried to send the spooling file to the same drive you are using 
for VisiWord program. It must be on a different drive. Spool the 
original document again, using a different drive. 

Spooling has been aborted. Invalid spool file. Try again. 

You switched flexible disks while spooling, but the program was 
not finished reading the temporary file into memory. The program 
found a temporary spool file on the new disk, but it is not the 
correct spool file for this document. You must spool the original 
document again. 

Spooling in progress, printer is busy. 

You tried to do a print operation while spooling. You can select 
Spool to abort the operation or wait until spooling is finished and 
try again. 

The document is too large and usage is not avai lable. 

You selected Storage/Maintenance/Usage for usage statistics, but 
there is not enough memory to do the calculations. Refer to 
Appendix G for procedures to split your document into two 
smaller files. 

You cannot put text on top of itself. 

You tried to copy text to an area within the highlighted box being 
moved. Try the copy again to outside the box. 

You cannot put a co lumn here.' 

You tried to put a copy of a column in an area where the line 
length is not long enough, where there is not enough space, in the 
middle of a paragraph, on top of itself, or on a page break. You 
should insert a Ruler that extends the right margin or insert a new 
line. Then try to do the copy again. 

You may replace only after a search. 

You tried to replace a character sequence before you looked for 
the search string. You must search using Next or Prev, then 
replace the string. 

Window a Iready opened. 

You attempted to open a third window (Windows/Open). Only 
two windows are allowed open at one time. You must Close the 
current second window, then Open a new one. 

XX is an improper drive. 

You tried to use a drive that cannot exist, for example, Z:. Retype 
the command and try again. 
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APPENDIX E 
PERTINENT FACTS ABOUT 
THE VISIWORD PROGRAM 

CI The editing screen is 78 columns wide by 20 columns long. 

• The program startup format settings are: 

Startup Range of 
Category Value Possible Values 

Format Line Spacing single one-half, single, 
Sheet one-and-one-half 
Settings double 

Right no yes, no 
Justification 

Characters 10 10, 12, and 15 
per inch 

Lines per page 50' any value between 
o and 9999 

First Page 1 any value between 
Number o and 9999 

Ruler Right Margin 65 any value between 
Settings 1 and 255 

Stops for Increments of 5 any position on the 
Tabs and Ruler to the left of 
Indents the right margin 

o The maximum right margin is 255. 

• A filename can be up to 8 characters long with a 3 character 
extension. 

• The startup printer used with the VisiWord startup settings is 
the IBM 80 Character-Per-Second Matrix Printer. 

• The startup path settings are: printer path - LPT1:, document 
path-B:, and spool path-B:. If you installed the VisiWord 
program on a hard disk, the document and spool paths are 
automatically changed to the hard disk drive letter. 
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APPENDIX F 
CHANGING VISIWORD STARTUP SETTINGS 

When you load the VisiW ord program, startup settings are pro­
vided in the following areas: 

• Format Sheets 

• Ruler 

• Program Path, Document Path, and Printer Path 

• Printer Models 

You can change one or many of these settings so that any time 
you load the VisiW ord program, your particular settings will be in 
effect. This appendix describes the standard startup settings, how 
to change them, and how to use them. 

STANDARD STARTUP SETTINGS 
Table F-l. VisiWord™ Startup Settings 

Startup Range of 
Category Value Possible Values 

Line Spacing single one-half, single, one-
and-one-half, double 

Right Justification no yes, no 

Characters per Inch 10 10, 12, and 15 

Lines per Page 50 any value between 0 
and 9999 

First Page Number 1 any value between 0 
and 9999 

Right Margin 65 any value between 1 
and 255 

Stops for Tabs and Increments of 5 any position on the 
Indents Ruler to the left of the 

right margin 
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Table F-l. VisiWord™ Startup Settings (Continued) 

Category 

Document Path (the 
drive the program uses 
for document opera­
tions such as saving 
and loading) 

Spool Path (the drive 
the program uses for 
spooling operations) 

Printer Path (the 
parallel [LPT] or serial 
[COM] printer or 
printer card the pro­
gram uses for the 
printing operations) 

Printer Model 

Startup 
Value 
Drive B:* 

Drive B:* 

LPT1: 

IBM 80 Character-Per­
Second Matrix Printer 

Range of 
Possible Values 
any valid disk drive 

any valid disk drive 

LPT1:, LPTZ:, CON 
or COMZ: 

Diablo 630, Epson 
MX-80 or MX-100 
with or without Gra 
trax, IBM 80 
Character-Per-Secon 
Matrix Graphics 
Printer, NEC Spin­
writer models 3550, 
7710, 7730, or 
PC-8Q'Z3A-C, Okida 
(Microline) 82A, 83} 
or 84, Qume Sprint 
9/45 or 9/55, Qume 
Sprint 11 Plus, any 
teletype equivalent a 
the IBM 80 CharactE 
Per-Second Matrix 
Printer 

*If you installed the VisiWord program on a hard disk (see the VisiWor, 
Setup Information Guide), the document and spool paths are initially sel 
to the drive letter of that hard disk. 

CREATING NEW STARTUP SETTINGS FOR 
FORMAT SHEETS OR RULERS 

MENU PATH: VW/Layaut/Farmat 
VW/Layaut/Ruler 
VW ISta ra gelD efa u It 

You change the startup settings for Format Sheets and Rulers by 
creating a blank document. This blank document has the format! 
that are saved with the Defaults option of the Storage menu and 
are put on the program disk. These formats will be loaded 
automatically when you start the VisiWord program. To do this: 
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1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Layout. 

3. Select Format or Ruler, depending on which settings you want 
to change. If you want to change both the Format Sheet and 
the Ruler, select one and set its formats, then select the other 
and set its formats. Change the settings as you would in any 
other document. (See Chapter 5 for details on changing For­
mat Sheets and Rulers.) 

4. Press ~ to use the menu and select Storage. The editing 
screen clears, and the Storage menu appears. 

5. Select Defaults. 

The document containing the Ruler and Format Sheet settings is 
saved on the program disk. When you load the program and 
select Create, these settings will be in effect. However, the docu­
ment you create may be too large to fit on the program disk. If 
this occurs, the program does not save the document either on the 
program disk or on a document disk. 

Note: 

If you clear a document from memory using Delete/Memory or 
Window/Clear options, the program will use its original startup 
settings, not the ones you set. To use the new settings, you have 
to use the Storage/Load option. The file name to load is 
A:defaults.vw unless you installed the program on a hard disk 
drive. In that case, substitute the hard disk drive letter for A in 
the file name. 

Note: 

If you have only flexible drives, you can have either a 
defaults.vw file or a file containing new disk paths, not both. If 
you want to create a new defauIts.vw or path file, delete the old 
file first, then create the new one. 
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CREATING NEW SETTINGS FOR MODELS 
OR PATHS 

MENU PATH: VW/Print/Model 
VW/Pri nt/Z = Path 
VW/Storage/Maintenance/= Path 

When you first use the VisiWord program, it expects you to be 
using the startup equipment. This means that you have two disk 
drives (drive A contains the program disk and drive B contains 
the document disk) and an IBM 80-Character-Per-Second Matrix 
printer. You are not, however, required to have this equipment. 
You can change the startup settings to reflect your equipment. The 
following sections describe how to do this. 

Note: 

If you installed the VisiWord program on a hard disk (see the 
VisiWord Setup Information Guide), the startup settings have 
already been changed for you. The program assumes the hard 
disk drive contains both the VisiWord program and the docu­
ment disk. 

Changing Disk Drive Paths 
A disk path is the location (the drive) where the VisiWord pro­
gram expects to send information for documents (saving, loading, 
etc.) and for spooling. For example, when you first load the pro­
gram, it expects all documents to be saved on the disk in drive B 
unless you specifically tell it to save the document somewhere 
else. There are two types of disk paths: document paths and spool 
paths. A document path is the drive where the program will 
automatically save documents or load documents. The spool path 
is where the program copies files before it prints them. To change 
these paths: 

1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Storage. The editing screen clears, 
and the storage screen appears. The storage screen tells you 
the Document Path, Spool Path, and current document name. 

3. Select Maintenance. 

4. Select Path. The disk path assignments appear on the screen. 

5. If you want to change the document path, type the new disk 
drive name. For example, C: if you have a third disk drive. If 
the document path is correct, press OJ. 
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WARNING: 

IF YOU HAVE ONLY FLEXIBLE DRIVES AND IF YOU 
CHANGE THE DOCUMENT PATH TO A:, BE SURE 
THAT YOUR DOCUMENT DISK IS IN DRIVE A WHEN 
YOU SAVE DOCUMENTS TO DISK. IF YOU SAVE A 
DOCUMENT TO DISK WHILE THE VISIWORD PRO­
GRAM DISK IS IN DRIVE A, YOU MAY PERMA­
NENTLY DAMAGE THE VISIWORD PROGRAM DISK. 

6. If you want to change the spool path, type the new disk drive 
name. For example, C: if you have a third disk drive. 

7. When you have changed the paths, press~. 

8. Select Save. 

The new disk paths are put on the program disk. 

If you want to put the values back to what they were when you 
first selected Z=Path, select Restore. If you want to put the values 
back to what currently resides on the disk, select Load. 

Changing Printer Paths and Models 
When you load the VisiWord program, it expects you to have an 
IBM 80 Character-Per-Second Matrix printer that receives its 
information through path LPT1: (a designation for a parallel 
printer). If you have a different kind of printer or you want to use 
a path other than LPT1:, you can do so using the Print option. 
For details, see Appendix A. 

SINGLE DRIVE SYSTEMS 
The VisiWord program startup settings assume that you have a 
system with at least two disk drives. If you have a single drive 
system (one disk drive), you must change the Document Path and 
Spool Path settings on the storage screen to reflect drive A. When 
you do this, the VisiWord program will save and load documents 
with the proper disk drive, and prompt you when it is necessary 
to swap the program disk and document disk. 

To permanently change the Document Path and Spool Path: 

1. Load the VisiWord program (see Chapter 2, Unit 1 for 
instructions). The Initial menu appears. 

2. Select Create from the Initial menu. Press ~. 
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3. Select Storage from the Main menu. The Storage menu 
appears. 

4. Select Maintenance; then select Path. The cursor highlights 
Document Path on the screen. 

s. Type A: then press the CO key. The cursor highlights Spool 
Path. 

6. Type A: again then press ~. The Disk Path menu 
appears. 

7. Select Save. The new settings are saved on the program disk. 

8. Press ~ to return to the editing screen. 

The new settings for Document Path and Spool Path will be in 
effect whenever you load the VisiWord program and select Create 
from the Initial menu. 
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APPENDIX G 
DOCUMENT SIZE CONSIDERATIONS 

The VisiWord™ program allows you to do a variety of word pro­
cessing activities such as writing memos, maintaining form letters 
on file to be used as needed, or creating longer documentation 
such as proposals or books. If you are producing a large docu­
ment (see next paragraph), we recommend that you write it in sec­
tions (chapters). These sections can then be stored as separate 
documents, but edited and printed sequentially (such as a book) 
using the Append feature of the VisiWord program. 

If you are using VisiW ord under DOS 1.1 in a 192K system, you 
have enough memory to create documents equivalent to 25 to 50 
typewritten pages (depending on the length of each page). If you 
have DOS 2.0 in a 192K system, you have space to create 
documents from 20 to 40 typewritten pages (depending on the 
page length). Any additional memory which you add on will be 
used for document space. As discussed previously, it is recom­
mended that you create smaller documents, and Append them 
rather than create one very large document. It is much easier to 
work with small documents than it is large ones, and you will also 
avoid any space problems. 

If you do create a large document which approaches the memory 
limits of your system, one of two messages displays on the screen. 
The first of these tells you that you are running out of space. As 
soon as you finish the sentence or paragraph you are working on, 
you should save your current document. If this is done, you will 
not lose any data nor any formatting you have entered for this 
document. 

The second message displays when there is no more space left for 
further entries. At this point, you are out of space to do more 
editing on your document. This is equivalent to running out of 
paper for your typewriter. You can no longer work on your docu­
ment until you solve the problem, i.e., get more paper. You must 
stop editing and save your document. If you are not at the end of 
the document, you must split it into two smaller documents if you 
wish to continue editing. 

Both of the memory conditions are explained below, along with 
the steps you need to take to save your document and continue 
processing. 
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LOW-aN-SPACE CONDITION 
When this condition occurs, the following message displays on the 
screen: 

WARNING: RUNNING OUT OF SPACE. Please save document. Press 
GIl. 

This message tells you that you are getting close to the end of the 
memory space you can use to work on this document. In general, 
the recovery procedure is to save the current document, delete 
memory, and create smaller documents if you wish to continue 
editing. The Append option of the Visiword program allows you 
to link several documents together as one. You create separate 
documents and connect them with an Append Sheet at the end of 
each. The amount of memory used is less than for the entire docu­
ment and therefore processing (editing, saving, printing, etc.) is 
faster. 

If You Have Completed Editing Your Document 
1. From the editing screen, press ~ to use the menu. 

2. From the Main menu, select Storage. 

3. Select Save. 

4. If the document you want to save was previously saved, its 
name displays on the screen. To use that name, select Yes; 
then select Yes again to overwrite the existing file. The current 
document is immediately saved. 

5. If no document name is displayed or if you don't want to use 
that name, you have two choices: List and Type-in. Use List 
to use a name that is already on file; use Ty p e -into enter a 

_ new name. 

6. If you select List, you must verify that you wish to use that 
name. If you select No, the document is not saved and you 
are returned to the Storage menu. If you select Yes, the docu­
ment is saved, and you are returned to the Storage menu. 

7. Press ~ to return to the editing screen, or select Quit to 
return to the Main menu. 

If You Have Not Completed Editing 
Your Document 

1. At the end of your line_or paragraph, press GIl to insert a 
required return. 

2. Press ~ to enter the Main menu. 
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3. Select Layout, then Append. The editing screen clears and an 
Append Sheet appears. The Append option of the Visiword 
program allows you to link documents together and move 
easily from one to another for editing or printing. The 
amount of memory required is only that necessary for the 
current document. 

4. Type the name of the next document you wish to edit. This 
document is appended to the first document. 

s. You can enter a message, a comment, or both preceding the 
appended document. Neither of these will appear in the 
printed document; they only display on the screen. The com­
-ment lines appear on the Append Sheet. The message appears 
on the editing screen before the second document is loaded 
and might indicate where the appended document is located. 

6. Press ~ to return to the Append menu. 

7. Select Quit twice to return to the Main menu. 

8. Select Storage, then Save to save your current document with 
the Append Sheet. 

9. Select Quit to return to the Main menu. 

10. Select Delete, then Memory to remove the current document 
from memory. 

11. You can now begin the new document you defined on the 
Append Sheet. 

OUT-Of-SPACE CONDITION 
When this condition occurs, the following message appears: 

ERROR: OUT OF SPACE. Please save document. Press GIl. 

This message tells you there is no more working space left in 
memory. You must immediately save your document at its current 
point. If you wish to continue editing, you can split your docu­
ment into two smaller documents that can fit into the memory 
space. The procedure to divide your document is summarized 
below. Detailed steps follow. 

• Save the entire current document (named DOC, for example). 

• Delete the second half of the document; create an Append 
Sheet for the remaining portion (the second half) using a name 
such as DOC2; save the first half with a new name (e.g., 
DOCl). 

• Create a new document (DOC2) containing the second half of 
the original document by reloading the original document into 
memory and deleting the first half. 
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The first half of the original document is now one document 
(DOC1); the second half of that original document is a second 
document (DOC2), appended to the first half. Both of these 
documents are small enough to be worked with in computer 
memory. 

When you get the "ERROR: OUT OF SPACE ... " message, follow 
the steps below to avoid losing any text or formatting data: 

1. Press the GIl key as prompted to return to the Storage menu. 

2. Select Save to save the current document (e.g., DOC) on disk. 
Respond Yes twice to replace the file on disk with the current 
document. 

3. Move the cursor approximately halfway through the docu­
ment, then delete the remainder of the document. If you can­
not delete text in blocks, use the ~ key to delete one line 
at a time until you have enough memory to delete blocks. 

4. Press the GIl key at the end of the document to insert a 
required return. Then define an Append Sheet: 

a. Press ~ to use the menu. 

b. From the Main menu, select Layout. 

c. Select Append. The editing screen clears and an Append 
Sheet appears. 

d. Type the name of the document you want to append (the 
next to be edited, e.g., DOC2). 

e. You can enter a message, a comment, or both on the 
Append Sheet. Neither of these will appear in the printed 
document; they are only displayed on the screen. The 
comment lines appear only on the Append Sheet. The 
message appears on the editing screen before the second 
document is loaded. 

f. Press ~ to return to the Append menu. 

s. Select Quit twice to enter the Main menu. 

6. Select Storage, then Save to save your document (e.g., 
DOC1) with the Append Sheet defined. 

7. Select Load to reload the original document (DOC). 

8. Press Quit to enter the Main menu. 
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9. Select Delete/Text to delete the first half of the original docu­
ment. The remaining text is the document (DOC2) to be 
appended to the first half (DOCl). If you cannot delete text in 
blocks, use the o:::ID key to delete one line at a time until you 
have enough memory to delete blocks. 

10. Select Storage/Save to save this document on disk. Use the 
Type-in option to assign the name you entered in the Append 
Sheet for this document (e.g., DOC2). 

You have now split your original document into two documents 
that are small enough to fit into memory. Continue to watch for 
the message warning you that memory space is running low. At 
that point, be sure to save your document and create another 
document that can be appended (see Low-on-Space Condition). 
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Special Characters 
> (greater than sign), 2-12 
< (less than sign), 2-12 
# (pound sign), 5-5, 5-39, 

5-41 
* (asterisk), 2-11 to 2-12, 

3-11, 5-10 
+ (plus sign), 5-17, 5-19 
- (hyphen), 5-6, 5-9, 5-33 to 

5-34 
(minus sign), 5-17, 5-19 

• (period or decimal point), 
3-5, 5-15, 5-21 to 5-23 

/\ (carat), 6-18 
> c:: (chevrons)' 2-12 
• (diamonds), 2-12, 5-35 

(exclamation point), 2-11, 
5-15, 5-18 

~ (paragraph symbol), 2-12, 
4-6 

e (theta), 2-12, 5-6, 
? (question mark), 2-9, 2-13, 

D-3 
? = help option, 2-7, 2-9, 

2-13, D-3 
~ triangle 2-11, 5-15 

A 
A:defaults.vw, 3-26 to 3-27, 

F-3 
About This Program, 1-1 
Above option, 5-28, 5-31, 7-6 

to 7-7 
active menu, 2-9 
active window, 3-15, 4-23 to 

4-28 
Again key CE:2], 1-6, 2-14, 

4-20, 5-28 to 5-32 

aligning, 2-14, 5-21 to 5-23 
fractional numbers, 5-22 
mixed numbers, 5-22 
right, 5-11, 5-22 
whole numbers, 5-22 

Aligning Columns of Numbers, 
5-21 

All-replace option, 2-7 to 2-8, 
4-21 to 4-22 

c:AI:D key, 1-6 
An Appended Document, 3-18 
append: To add one document 

to the end of another for 
loading or printing 
documents or parts of a 
document in sequence. 

append 
comment, 3-20 
message, 3-20 
option, 3-18 to 3-22 
sheet, 3-18 to 3-22 

Append option, 2-7 to 2-8 
Layout menu, 3-18 to 3-21 
Storage menu, 3-21 

Append Sheet: The screen on 
which you name the file 
that is appended to the 
current document. 

Append Sheet 
creating, 3-19 to 3-20 
defining, 3-19 to 3-20 
deleting, 3-20 to 3-21 
inserting, 3-19 to 3-20 

appended document, 3-18 to 
3-22, 6-4 

appending, 3-18 to 3-22 

1 
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Appending One Document to 
Another, 3-18 

Applications, 7-1 
Sample 1, 7-2 to 7-3 
Sample 2, 7-4 to 7-5 
Sample 3, 7-6 to 7-7 

arrow keys, xiv, 1-7, 4-3 to 
4-4 

down, 3-7, 3-20, 4-23, 5-8, 
5-10, 6-17 

left, 5-10, 5-17, 6-17 
right, 5-10, 5-17, 6-17 
up, 3-7, 3-20, 4-23, 5-8, 

5-10, 6-17 
ASCII file, B-2, C-1 
asterisk (*), 2-11 to 2-12, 3-11, 

5-10 
attribute: A special way of 

printing a character; 
for example, boldface, 
underline, superscript, 
subscript, or overstrike. 

attribute 

B 

boldface, 5-28 to 5-29, 7-2 to 
7-3 

emphasis, 5-28 to 5-29, 7-2 
to 7-3 

subscript, 5-28, 5-31, 7-6 to 
7-7 

superscript, 5-28, 5-31, 7-6 
to 7-7 

overstrike, 5-28, 5-31 to 
5-32 

underline, 2-14, 2-16, 5-28, 
5-30, 7-4 to 7-5 

backspace, xiv, 2-15, 4-5, 4-8, 
4-9 to 4-11 

Basic Information, 2-1 
baud rate, A-6 
Beginning a New Page, 5-35 
Below option, 5-28, 5-31, 7-6 

to 7-7 
( B K S P ) key, xiv, 2-15, 

4-5, 4-8, 4-9 to 4-11 
blank lines, 4-7, 5-10, 5-40 to 

5-41 
boldface, 5-28 to 5-29, 7-2 to 

7-3 

border: The frame of inverse 
video that surrounds the 
edi ting screen. 

border, 2-11 to 2-12, 5-6, 5-35 
buffer, 4-13 

C 
carat (1\), 6-18 
carriage return, 1-7, 2-9, 2-15, 

4-5, 4-6 to 4-7, 6-18, 0-1 
center: To move text to the 

middle of a line. 
center, 1-6, 2-12, 2-14, 

2-16, 5-27 
Center Line key CE::I:QJ, 1-6, 

2-12,2-14,2-16,5-27 
Center Mark, 2-11, 5-27 
Centering Text, 5-27 
Changing Disk Drive Paths, 

F-4 
Changing Format Settings, 5-8 
Changing Printer Format 

Specifications, 6-13 
Changing Printer Models, A-4 
Changing Printer Paths, A-5 
Changing VisiWord Startup 

Settings, F-1 
Char menu, 2-7 to 2-8, 

5-28 to 5-34 
Above option, 5-28, 5-31 
Below option, 5-28, 5-31 
Emphasis option, 5-28 to 

5-29 
Hyphen option, 5-33 to 

5-34 
Overstrike option, 5-28, 5-31 

to 5-32 
Underline Option, 5-28, 

5-30 
character 

attributes, 2-7 to 2-8, 5-28 to 
5-34, A-3, B-2 

spacing per inch, 3-3, 5-3 to 
5-4, 5-12 to 5-13, F-1 

string, 4-19 to 4-20, 4-21 to 
4-22, 0-4 

Character Attibutes, 5-28 
characters per inch, 3-3, 5-3 to 

5-4, 5-12 to 5-13, F-1 
chevrons « < > », 2-12 



clear 
command, 5-18 
computer memory, 3-4, 3-8, 

4-27 
document, 3-4, 3-8, 4-27 
option, 2-7 to 2-8, 4-27 
screen, 3-4, 3-8, 4-27 
stop, 5-18 
window, 2-7 to 2-8, 4-27 

Clear command, 5-18 
Clear option, 2-7 to 2-8, 4-27 
Clearing a Document From a 

Window, 4-27 
Close option, 2-7 to 2-8, 4-28 
Closing a Window, 4-28 
column: A set of characters 

aligned vertically with a 
required return at the end 
of each line. In the 
VisiWord program, you 
can delete, copy, 
or move columns. 

columns, 4-7 
aligning, 2-14, 5-21 to 5-23 
copying, 4-14 to 4-15, 4-25 

to 4-27 
deleting, 4-11 to 4-13 
moving, 4-16 to 4-18, 4-25 

to 4-27 
Column option, 2-7 to 2-8 

Copy menu, 4-14 to 4-15, 
4-25 to 4-27 

Delete menu, 4-11 to 4-13 
Move menu, 4-16 to 4-18, 

4-25 to 4-27 
COM1:, 6-4 to 6-5, A-5, F-2 
COM2:, 6-4 to 6-5, A-5, F-2 
command: An instruction to 

the program, usually 
given by pressing a key, 
to do a calculation, 
screen display or other 
function. 

computer memory, 1-4, 2-3 to 
2-4, 3-4, 3-8, 4-27 

copy: To duplicate text or 
columns, and put it in 
another place in the same 
document or another 
document. 
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Copy menu, 2-7 to 2-8, 4-14 to 
4-15, 4-25 to 4-27 

Column option, 4-14 to 
4-15, 4-25 to 4-27 

Text option, 4-14 to 4-15, 
4-25 to 4-27 

copying, 
a document on a disk, 6-7 to 

6-8 
columns, 4-14 to 4-15, 4-25 

to 4-27 
from one window to 

another, 4-25 to 4-27 
text, 4-14 to 4-15, 4-25 to 

4-27 
whole documents, 3-23 to 

3-24 
Copying Text and Columns, 

4-14 
Create option 2-7 to 2-8, 

3-3 to 3-4 
creating 

Append Sheet, 3-19 to 3-20 
documents, 3-3 to 3-4 
Footer Sheet, 5-36 to 5-42 
form documents, 3-25 
form letters, B-1 
Format Sheet, 5-7 to 5-14 
Header Sheet, 5-36 to 5-42 
Message Sheet, 6-10 to 6-11 
Ruler, 5-15 to 5-20 
special characters 

(overstrike), 5-28, 5-31 
to 5-32 

startup settings, 3-26 to 
3-27, F-1 to F-5 

VisiCalc files, C-1 
windows 4-23 to 4-24 

Creating a Form Letter, B-1 
Creating a New Document, 3-3 
Creating a Window, 4-23 
Creating New Settings for 

Format Sheets or Rulers, 
F-2 

Creating New Settings for 
Models or Paths, F-3 

Creating Special Characters 
(Overstrike), 5-31 

Creating the VisiCalc File, C-1 
( C T R L ) key, 1-6, 6-18 
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cursor: 1) The editing cursor: a 
screen character (blinking 
underscore) that indicates 
the position where the 
next character you type 
will appear. 
2) The menu cursor: a bar 
of inverse video high­
lighting a' menu option. 

cursor, 2-9, 2-11, 4-3 to 4-5 
cursor-moving key, 2-9, 4-3 to 

4-5 
Cursor-Moving Keys, 4-3 

o 
data disk, 2-17 to 2-18,3-17 
data file, B-1 
decimal point (.), 5-21 to 5-23 
decimal tab, 2-14, 3-3, 4-5, 

5-21 to 5-23 
Decimal Tab key CEIJ, 1-6, 

2-14, 4-5, 5-21 to 5-23 
default: A startup setting of 

the program. 
Default option, 2-7 to 2-8, 3-26 

to 3-27, F-2 to F-3 
Define-replacement option, 2-7 

to 2-8, 4-21 to 4-22 
defining 

Append Sheet, 3-19 to 3-20 
Footer Sheet, 5-36 to 5-42 
Format Sheet, 5-7 to 5-14 
Header Sheet, 5-36 to 5-42 
Message Sheet, 6-10 to 6-11 
page numbers, 5-40 to 5-41 
Ruler, 5-15 to 5-20 
setup strings, 6-18 to 6-19 
special characters 

(overstrike), 5-28, 5-31 
to 5-32 

startup settings, 3-26 to 
3-27, F-1 to F-5 

Defining Headers, Footers, and 
Document Page Numbers, 
5-41 

(][ED key, 1-7, 2-15, 4-9 to 
4-10, 4-13 

Delete Character key (][ED, 
1-7,2-15,4-9 to 4-10, 4-13 

Delete Command, 5-20 
Delete Keys, 4-9 
Delete Line key ~, 1-6, 

2-14, 4-9 to 4-10, 
4-13, 5-35 

Delete menu, 2-7 to 2-8, 3-4, 
3-26 to 3-27, 4-9 to 4-13 

Column option, 4-11 to 4-13 
Memory option, 3-4, 3-26 to 

3-27 
Text option, 4-11 to 4-13 

Delete option, 2-7 to 2-8, 3-11 
to 3-12 

Delete To End of Line key 
C£::]J, 1-6, 2-14, 4-9 to 
4-10 

deleting 
Append Sheet, 3-20 to 3-21 
columns, 4-11 to 4-13 
documents, 3-11 to 3-12 
Footer Sheet, 5-42 
format settings, 5-9 
Format Sheet, 5-9 
ghost hyphens, 5-33 to 5-34 
Header Sheet, 5-42 
Message Sheet, 6-12 
page breaks, 5-35 
required returns, 4-6 to 4-7 
Ruler, 5-20 
text, 4-11 to 4-13 

Deleting a Document, 3-11 
Deleting a Page Break, 5-35 
Deleting a Ruler, 5-20 
Deleting an Append Sheet, 

3-20 
Deleting and Restoring Text, 

4-9 
Deleting Format Settings, 5-9 
Deleting Headers and Footers, 

5-42 
Deleting Messages, 6-12 



Deleting Text, 4-11 
Deleting Text and Columns, 

4-12 
diamonds ( • ), 2-12, 5-35 
DIF file, C-1 
directory, 0-2 

of a document disk, 3-17 
disk, 1-4 to 1-5 

directory, 3-17 
document, 2-17 to 2-18, 3-17 
file, 6-7 to 6-8 
handling, 1-5 
option, 6-7 to 6-8, B-2 to 

B-3 
path, F-4 

Disk option, 2-7 to 2-8, 6-7 to 
6-8, B-2 to B-3 

displaying messages 
when printing, 6-10 to 6-11 
when spooling, 6-11 

Displaying Messages While 
Printing, 6-10 

document: Any text, including 
formats, on the VisiWord 
editing screen. 

document, 1-3 
appending a, 3-18 to 3-22 
creating a, 3-3 to 3-4 
deleting a, 3-11 to 3-12 
disk, 2-17 to 2-18, 3-17 
editing a, 4-1 
format, 5-3 
formatting, 5-1 
including a, 3-23 to 3-24 
loading a, 3-8 to 3-10 
name, 3-5 to 3-6, 3-15, 3-17 
path, 3-5 to 3-6, 3-16, 6-7, 

F-1, F-3 to F-5 
printing a, 6-1 
renaming a, 3-13 to 3-14 
saving a, 3-5 to 3-7 
size, 3-15 to 3-16 
statistics, 3-15 to 3-16 

Document Statistics Screen, 
3-15 

Doing Repeated Searches, 4-20 
double space, 5-4, 5-10, 

F-1 
down arrow, 3-7, 3-20, 4-23, 

5-8, 5-10, 6-17 
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E 
Editing an Appended 

Document, 3-21 
Editing Documents, 3-1 
editing screen: The area of a 

screen where you can 
enter and revise text. 
In the VisiWord 
program, the editing 
screen is 22 lines by 
78 columns beginning 
on line 2 and ending 
on line 23. 

editing screen, 2-11 to 2-12, 
4-3 to 4-5, 4-6 to 4-8, 
4-23 to 4-25 

Editing Screen Border 
Symbols, 2-12 

Emphasis option, 2-7 to 2-8, 
5-28 to 5-29 
~ key, 1-7, 2-15, 4-3 to 

4-4 
end of document marker, 2-11 
Enter key (GIl), 1-7, 2-9, 2-15, 

4-5, 4-6 to 4-7, 6-18, 0-1 
entering 

a menu, 2-9 to 2-10 
text, 4-6 to 4-8 

Entering and Leaving a Menu, 
2-10 

Entering Text, 4-6 
equipment 

optional, 1-5 
required, 1-4 to 1-5 
standard, 1-5, A-3, F-3 

Equipment You Need, 1-4 
error messages, 0-1 
~ key, 1-6, 2-10, 2-15, 

6-6, 6-18 
Exact option, 2-7 to 2-8, 4-19, 

4-21 
exclamation point (!), 2~11, 

5-15, 5-18 
exiting 

from a menu, 2-10 
from the VisiWord program, 

2-19 
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Exit menu, 2-7 to 2-8 
Exit-to-system option, 2-19 
Return-to-current-product 

option, 2-19 
Start-new-product option, 

2-19 
extension, 3-5 to 3-6, B-2 to 

B-3 

f 
CE:D key, 1-6, 2-14, 4-5, 5-5, 

5-21 to 5-23 
CTI:l key, 1-6, 2-14, 2-16, 

5-28 to 5-32 
c::E:Il key, 1-6, 2-12, 2-14, 5-35 
CEIl key, 1-6, 2-12, 2-14, 4-5, 

5-5, 5-15, 5-24 
c:E::]J key, 1-6, 2-14, 4-9 to 

4-10, 5-35 
CEID key, 1-6, 2-14, 4-6, 4-9 

to 4-10 
crD key, 1-6,2-16 
c::E::ID key, 1-6, 2-14, 2-16, 

5-30 
(£ID key, 1-6, 2-14, 4-13, 4-19 
CEJ::[) key, 1-6, 2-12, 2-14, 

2-16, 5-27 
field, B-1 to B-2 
field name, B-2 
file: Information, such as a 

document, that is stored 
on disk. 

file name: The name used to 
refer to documents loaded 
from or stored on a disk. 

file name, 3-5 to 3-6, 3-15, 
3-17 

Find menu, 2-7 to 2-8, 4-19 to 
4-22 

All-replace option, 4-21 to 
4-22 

Define-replacement option, 
4-21 to 4-22 

Exact option, 4-19, 4-21 
Ignore option, 4-19, 4-21 
Next option, 4-19 to 4-20, 

4-22 
Prey option, 4-19 to 4-20, 

4-22 
Replace option, 4-22 

first page number, 3-3, 5-3 to 
5-5, 5-14, F-1 

footer: Lines of text that 
appear at the bottom 
of each page in a 
printed document but not 
on the editing screen. 

footer, 5-3, 5-36 to 5-42, 6-14, 
6-16 

Footer option, 2-7 to 2-8, 5-3, 
5-36 to 5-42 

Footer Sheet: The scr~en on 
which you define the 
footer for a document. 

Footer Sheet, 5-3, 5-6, 6-14 
creating, 5-36 to 5-42 
defining, 5-36 to 5-42 
deleting, 5-42 
inserting, 5-40 

form document, 3-25 
form feed, A-4, B-3 
form letter skeleton, B-1 to B-3 
Form Letters, B-1 
format: The physical 

appearance of a printed 
document or a document 
on the editing screen. 

format 
disk, 2-17 to 2-18 
indicator, 5-6, 5-9 
option, 2-7 to 2-8, 5-3, 

5-7 to 5-14, 6-13 to 
6-19, F-2 to F-3 

sheet, 2-12, 5-3 to 5-14, 
F-2 to F-3 

startup settings, 3-3, 3-26 to 
3-27, 5-3 to 5-4, F-1 

Format option, 2-7 to 2-8 
Layout menu, 5-3, 5-7 to 

5-14, 6-18 to 6-19, 
F-2 to F-3 

Print menu, 6-13 to 6-17 
Format Sheet: A screen that 

allows you to set and 
change the physical 
appearance of a 
document. 



Format Sheet, 2-12, 5-3 to 
5-14, F-2 to F-3 

creating, 5-8 to 5-9 
defining, 5-8 to 5-9 
deleting, 5-9 
descriptions, 5-4 to 5-5 
inserting, 5-8 to 5-9 
settings, 3-3, 3-26 to 3-27, 

5-3 to 5-4, F-1 
Format Startup Settings, 5-3 
Formatting Documents, 5-1 
Function Key Overlay 1-6 
function keys 
CEJJ key, 1-6, 2-14, 4-5, 5-5, 

5-21 to 5-23 
CIT) key, 1-6, 2-14, 2-16, 

5-28 to 5-32 
o::::ID key, 1-6, 2-12, 2-14, 5-35 
CIT.) key, 1-6, 2-12, 2-14, 4-5, 

5-5, 5-15, 5-24 
c:EID key, 1-6, 2-14, 4-9 

to 4-10, 5-35 
(DJ key, 1-6, 2-14, 4-6, 4-9 

to 4-10 
(ED key, 1-6, 2-16 
CE::ID key, 1-6, 2-14, 2-16, 

5-30 
c::E[) key, 1-6, 2-14, 4-13, 4-19 
C£IQJ key, 1-6, 2-12, 2-14, 

2-16, 5-27 

G 
Ghost hyphen: A hyphen that 

does not appear on the 
screen, but will appear 
when printing if the 
printer breaks an 
end-of-line word 
at the syllable where 
the ghost hyphen is 
placed. 

ghost hyphen, 5-33 to 5-34 
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Goto 'command, 5-17, 7-6 
greater than symbol (», 2-12 

H 
Handling disks, 1-5 
header: Lines of text that 

appear at the top of each 
printed page of a 
document but not on 
the editing screen. 

header, 5-3, 5-36 to 5-42, 
6-14, 6-16 

Header option, 2-7 to 2-8, 5-3, 
5-36 to 5-42 

Header and Footer Sheets, 5-38 
Header Sheet: The screen on 

which you define the 
header for a document. 

Header Sheet, 5-3, 5-6, 6-14 
creating, 5-36 to 5-42 
defining, 5-36 to 5-42 
deleting, 5-42 
inserting, 5-40 

help instructions, 2-7 to 2-8, 
2-9, 2-13 

help screens, 2-7 to 2-8, 2-9, 
2-13 

hexadecimal, 6-18 
highlighting, 5-28 to 5-32 
Highlighting: Boldface, 

Underline, Superscripts, 
Subscript, and Overstrike, 
5-28 

( HOM E) key, 1-7, 2-15, 4-3 to 
4-4 

Home position: The upper-left 
corner of the editing 
screen. 

home position, 4-3 to 4-4 
hyphen, 5-6, 5~9, 5-33 to 5-34 
Hyphen option, 2-7 to 2-8, 

5-33 to 5-34 
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I 
IBM DOS. 1-4, 2-3, 2-17, 2-19, 

6-7 to 6-8, C-1 
IBM DOS Format command, 

2-17 
IBM Keyboard, 1-6 to 1-7 
Ignore option, 2-7 to 2-8, 4-19, 

4-21 
include: To incorporate a 

complete document within 
another document. 

Include'option, 2-7 to 2-8, 3-23 
to,3-24 

Including One Docment 
Within Another, 3-23 

indent: A temporary left 
margin set for a number 
of lines terminated by a 
required return. You insert 
a required indent by 
pressing c::EI). 

indent 
command, 5-5, 5-19 
key, 1-6,-2-12, 2-14, 4-5, 

5-5, 5-15, 5-24 
stop, 2-11 to 2-12, 2-14, 5-5, 

5-15, 5-18 
Indent command, 5-5, 5-19 
Indenting Paragraphs, 5-24 
Initial menu, 2-7 to 2-8 

Create option, 3-3 to 3-4 
Revise option, 3-9 

initialize: To prepare a disk to 
store documents. 

Initialize option, 2-7 to 2-8, 
2-17 to 2-18 

CINID key, 1-7, 2-15, 2-16, 
4-7 to 4~8 

insert: To add text without 
deleting existing text. 
In the VisiWord program, 
the new text is inserted 
to the left of the cursor 
pushing the existing text 
to the right. 

insert, 2-15, 2-16, 4-7 to 4-8 
Insert and Over-Type, 4-7 
Inserting an Append Sheet, 

3-19 

inverse video: Dark characters 
on a light background on 
the screen. 

inverse video, 2-9, 2-12, 4-12, 
4-15, 4-18, 5-8, 5-18, 
5-29,6-19 

J 
justification, 2-14, 5-11 to 

5-12, 5-22 
Justified Text vs. Nonjustified 

Text,5-11 . 
Justifying Text (Aligning 

Right), 5-11 

K 
keyboard, 1-6 to 1-7 
keyboard symbols, xiv 

L 
Layout menu, 2-7 to 2-8 

Append option, 3-18 to 3-21 
Char menu, 5-28 to 5-34, 
Footer option, 5-3, 5-36 to 

5-42 
Format option, 5-3, 5-7 to 

5-14, 6-18 to 6-19, F-2 to 
F-3 

Header option, 5-3, 5-36 to 
5-42 

Message option, 6-10 to 6-12 
Next option, 5-20 
Prev option, 5-20 
Ruler option, 5-3, 5-5 to 5-6, 

5-15 to 5-20 
Learning to Use the VisiWord 

Program, xi to xii 
leaving 
, a menu, 2-10 

the VisiWord program, 2-19 
Leaving the VisiWord 

Program, 2-19 
left arrow, 5-10, 5-17, 6-17 
left border, 5-6, 5-35 
left margin, 4-7, 5-3, 5-24 
less than symbol, 2-12 
line feed, A-4, B-3 
line length, 5-39, 5-41 



line spacing, 5-3 to 5-5, 5-lQ) , 
F-l 

lines per page, 5-3 to 5-5, 5-10, 
F-l 

List option, 2-7 to 2-8, 3-7, 
3-17 

listing document names, 3-17 
load: To put a program or 

document into computer 
memory. 

Load option, 2-7 to 2-8, 3-8, 
3-10 

loading 
appended documents in 

sequence, 3-21 
documents, 3-8 to 3-10 
documents into windows, 

4-27 
the program, 2-3 to 2-4 

Loading a Document, 3-8 
Loading a Document Into a 

Window, 4-27 
Loading the VisiWord 

Program, 2-3 
looking 

for strings, 4-19 to 4-20 
for format changes, 5-20 

Looking for Characters, 
Words, or Phrases, 4-19 

lower case letters, 3-13, 4-19, 
4-21 

LPT1:, 6-4 to 6-5, A-5, F-2 
LPT2:, 6-4 to 6-5, A-5, F-2 

M 
Main menu, 2-7 to 2-11 

Copy menu, 4-14 to 4-15, 
4-25 to 4-27 

Delete menu, 3-4, 4-9 to 
4-13 

Exit menu, 2-19 
Find menu, 4-19 to 4-20, 

4-21 to 4-22 
Layout menu, 2-7 to 2-8 
Move menu, 4-16 to 4-18, 

4-25 to 4-27 
Options menu, 2-7 to 2-8 
Print menu, 3-22, 6-3 to 

6-17, A-4 to A-6, 
B-2 to B-3, F-3 
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Storage menu, 2-17 to 2-18, 
3-5 to 3-17, 3-21, 
3-23 to 3-27, F-2 to F-5 

Windows menu, 4-23 to 4-28 
Maintenance menu, 2-7 to 2-8 

Delete option, 3-11 to 3-12 
Initialize option, 2-17 to 2-18 
List option, 3-17 
Path option, F-3 to F-5 
Rename option, 3-13 to 3-14 
Usage option, 3-15 to 3-16 

margin: The left and right 
boundaries in a document. 

Margin command, 5-18 
margins, 1-1 

left, 4-7, 5-3, 5-24 
right, 3-3, 4-6, 5-3 to 5-5, 

5-15, 5-18, 5-39, E-l 
marking 

columns, 4-11 to 4-18, 4-25 
to 4-27 

documents, 3-11 to 3-12 
text, 4-11 to 4-18, 4-25 to 

4-27 
text for setup strings, 6-18 

memory, 1-4, 2-3 to 2-4, 3-4, 
3-8, 4-27, G-l to G-5 

Memory option, 3-4, 3-26 to 
3-27 

menu: A list of program 
options. 

menu, 2-5 to 2-10 
Menus, 2-5 
Message option, 2-7 to 2-8, 

6-10 to 6-12 
Message Sheet, 2-12, 6-10 to 

6-12 
minus sign, 5-17, 5-19 
monitor: The video display 

unit of the computer. 
Model option, 2-7 to 2-8, A-4, 

B-2 to B-3 
move: To remove text from 

one place, and put it 
into another .place in 
the same document or 
another document. 
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Move menu, 2-7 to 2-8 
Column option, 4-16 to 

4-18, 4-25 to 4-27 
Text option, 4-16 to 4-18, 

4-25 to 4-27 
moving 

columns, 4-16 to 4-18, 4-25 
to 4-27 

text, 4-16 to 4-18, 4-25 to 
4-27 

the cursor, 2-9, 4-3 to 4-5 
the cursor between 

windows, 4-24 to 4-25 
the cursor on the Ruler, 5-17 

Moving or Copying Text 
Between Windows, 4-25 

Moving Text and Columns, 
4-16 

Moving the Cursor, 4-4 
Moving the Cursor From One 

Window to Another, 4-24 
Moving the Cursor on the 

Ruler, 5-17 
Moving the Cursor Within 

Documents, 4-3 

N 
name, 3-5 to 3-6, 3-15, 3-17 
New Page key (EID, 1-6, 2-12, 

2-14, 5-35 
Next option, 2-7 to 2-8 

Find menu, 4-19 to 4-20, 
4-22 

Layout menu, 5-20 
nontext character: A character 

sent to the computer by 
pressing a special key, 
such as the ~ 
key. 

nontext character, 6-18 
nontext character code, 6-18 
Nontext Character Code for 

Printer Setup Strings, 6-18 
(N U M L 0 C K) key, 1-7 

o 
offset, 6-13 to 6-17 
one-and-one-half spacing, 5-3 

to 5-5, 5-10, F-1 

one-half spacing, 5-3 to 5-5, 
5-10, F-1 

Open option, 2-7 to 2-8, 4-23 
to 4-24 

option: The choices available 
in a command or a menu. 

option, 2-5 
Options menu, 2-7 to 2-8 

VisiSpell option, 2-7 to 2-8 
optional equipment, 1-5 
Organization of the VisiWord 

User's Guide, xii to xiii 
overstrike, 5-28, 5-31 to 5-32 
overstrike character, 5-31 
Overstrike option, 2-7 to 2-8, 

5-28, 5-31 to 5-32 
over-type: To add text by 

typing directly over and 
deleting existing text. 

over-type, 2-15, 2-16, 4-7 to 
4-8 

Overview, 1-3 

p 
page break, 2-12, 2-14, 5-35 
page number, 5-40 to 5-41 
page number symbol, 5-5, 

5-39, 5-41 
paper length, 6-13 to 6-17 
paragraph symbol, 2-12, 4-6 
parallel printer, 6-4 to 6-5, A-3 

to A-6, F-2 
parity, A-6 
path: 1) The place (disk drive) 

to or from which 
information, documents, 
or data are being 
transferred. In the 
VisiWord program, there 
are document path, spool 
path, and printer path. 
2) The menu path is the 
set of options chosen to 
get to the current menu; 
for example, 
VW ILayoutiChar. 



path 
document, 3-5 to 3-6, 3-16, 

6-7 
menu, 2-9 
printer, 6-4, A-5 to A-6, 

F-2 to F-5 
program, F-1 
spool, 3-5, 3-10, F-1, F-3 to 

F-5 
Path option, 2-7 to 2-8 

Maintenence menu, F-3 to 
F-5 

Print menu, A-5 to A-6 
percentage of memory, 3-15 
period (.), 3-5, 5-15, 5-21 

to 5-23 
Pertinent Facts About the 

VisiWord Program, E-1 
"( P"""G"'D"'N") key, 1-7, 2-15, 3-17, 

4-3 to 4-4 
"( P"""'G"U"P'"') key, 1-7, 2-15, 3-17, 

4-3 to 4-4, 4-6 
plus sign (+), 5-17, 5-19 
Pocket Reference, xii 
pound sign (#), 5-5, 5-39, 5-41 
Preparing Document Disks 

(Initializing), 2-17 
Prev option, 2-7 to 2-8 

Find menu, 4-19 to 4-20, 
4-22 

Layout menu, 5-20 
print format, 6-13 to 6-17 
Print menu, 2-7 to 2-10 

Disk option, 6-7 to 6-8, B-2 
to B-3 

Format option, 6-13 to 6-17 
Model option, 6-8, A-4, B-2 

to B-3 
Path option, A-5 to A-6 
Printer option, 6-3 to 6-5 
Spool option, 6-5 to 6-6 

print message, 6-4, 6-10 to 
6-12 

print screen, 6-3 to 6-5, 6-14 
printer 

format, 6-13 to 6-17 
model, 6-8, A-4, B-2 to B-3, 
offset, 6-13 to 6-17 
option, 6-3 to 6-5 
path, A-5 to A-6 
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printer offset: The number of 
spaces between the edge 
of the paper and the 
first printed character. 

Printer option, 6-3 to 6-5 
printing 

an appended document, 3-22 
a document, 6-1 
on a printer, 6-3 to 6-6 
to a disk, 6-7 to 6-8 
to IBM DOS, 6-8 

Printing, 6-3 
Printing a Document on a 

Disk,6-7 
Printing an Appended 

Document, 3-22 
Printing Directly, 6-3 
Printing Documents, 6-1 
Printing to IBM DOS, 6-8 
Printing While Editing 

(Spooling), 6-5 
Printout with Header and 

Footer, 5-37 
program disk, 1-4, 2-3 to 2-4, 

2-19 
program path, F-1 
program startup settings, 3-3, 

3-26 to 3-27, 5-3 to 5-4, 
E-1, F-1 to F-5 

prompt: A question or 
comment written by the 
program that appears on 
the line above the menu 
or on the screen. 

prompt messages, 2-9 

Q 
question mark (7), 2-9, 2-13, 

0-3 
QuickStart Course, xii 
Quit option, 2-7 to 2-10 

R 
ragged right, 5-3 to 5-4, 5-11 
record, B-1 
Rename option, 2-7 to 2-8, 

3-13 to 3-14 
Renaming a Document, 3-13 
repeated searches, 4-20 
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Replace option, 2-7 to 2-8, 
4-22 

replacement string: The 
sequence of characters 
that replaces the sequence 
that was looked for in 
your document and 
found. 

replacement string, 4-22 
Replacing Characters, Words, 

or Phrases, 4-21 
required equipment, 1-4 to 1-5 
required hyphen, 5-33 
required indent: A temporary 

left margin set from the 
Ruler and terminated only 
by changing the setting 
on the Ruler; it 
differs from the indent 
key (c:E:D) in that 
it ignores required returns. 

required indent, 5-5, 5-15 
required return: A forced 

ending to one line 
that begins another line. 
You insert a required 
return by pressing GIl'-

required return, 1-7, 2-12, 
2-15, 4-5 to 4-7, 4-11, 
5-5, 5-8 

Required Returns, 4-6 
Restoring Text, 4-13 
return symbol, 2-12, 4-6 
Return-to-current-product 

option, 2-7 to 2-8, 2-19 
Revise option, 2-3, 2-7 to 2-8, 

3-9 
right arrow, 5-10, 5-17 to 5-18, 

6-17 
right justification, 5-11, 5-22 
right margin, 3-3, 4-6, 5-3 to 

5-5, 5-15, 5-18, C-2, F-2 
Ruler: 1) A line at the top of 

the editing screen that 
shows the columns, 
margins, and stops in a 
document. 
2) The line that lets you 
change the right margin, 
stops, and required 
indents. 

Ruler, 2-11, 3-3, 5-3 to 5-6, 
5-15 to 5-23, F-1 to F-3 

commands, 5-15 to 5-20 
descriptions, 5-5 
marks, 5-15 
option, 5-3, 5-5 to 5-6, 5-15 

to 5-20 
settings, F-1 
stop, 2-11 to 2-12, 2-14, 5-4, 

5-5, 5-15, 5-18 
Ruler commands 

5 

arrow keys, 5-17 
Clear command, 5-18 
Delete command, 5-20 
Goto command, 5-17 
Indent command, 5-19 
Margin command, 5-18 
Set command, 5-18 

Sample 1, 7-2 to 7-3 
Sample 2, 7-4 to 7-5 
Sample 3, 7-6 to 7-7 
Sample Append File 

Specification, 3-19 
Sample Applications, 7-1 
Sample Document with Top 

Margin, Offset, and Page 
Length Specified, 6-16 

Sample Format Sheet, 5-76 
Sample Header Sheet and 

Resulting Header, 5-38 
Sample Message Sheet, 6-10 
Sample Table of Numbers, 

5-21 
save: To store a document on 

a data disk for later 
retrieval. 

Save option, 2-7 to 2-8, 3-5 to 
3-7 

Saving a Document, 3-5 
screen: The video display of 

the computer. 
screen 

clearing, 3-3 to 3-5, 3-8, 4-27 
dimensions, 2-12 
editing, 2-10 to 2-12, 4-3 to 

4-8, 4-23 to 4-25 
symbols, 2-12 



search string: The 
sequence of characters 
you are looking for in 
a document. You type 
these characters after 
selecting Find. 

search string, 4-19 to 4-22 
Seeing What Formats Are in 

Effect, 5-6 
select: To choose a menu 

option: 1) by moving the 
cursor over the option and 
pressing GIl 2) or by 
pressing the first letter 
of the option. 

select, 2-9 to 2-10 
Selecting a Menu Option, 2-9 
self-loading, 2-19 
Sending a Form Letter to a 

Disk File, B-2 
Sending Special Instructions 

(Setup Strings) to the 
Printer, 6-18 

sequence of characters, 4-19 to 
4-22 

serial printer, 6-4 to 6-5, A-3 
to A-6, F-2 

serial printer settings, A-6 
Set command, 5-18 
set stop, 5-18 
Setting a Page Break, 5-35 
Setting and Clearing Stops, 

5-18 
Setting Character Spacing, 

5-12 
Setting Headers and Footers, 

5-36 
Setting Line Spacing, 5-10 
Setting Lines Per Page, 5-13 
Setting Required Indents, 5-19 
Setting the First Page Number, 

5-14 
Setting the Right Margin, 5-18 
Settings for Serial Printers, A-6 
setup string: Special 

instructions sent to a 
printer. 

setup strings, 6-18 to 6-19, 
A-I, B-2 
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shadow cursor, 2-11, 5-15 
sheet: One of the special 

screens in the VisiWord 
program that lets you 
change settings. 

sheet 
Append, 3-18 to 3-22 
Footer, 5-3, 5-6, 6-14 
Format, 2-12, 5-3 to 5-14 
Header, 5-3, 5-6, 6-14 
Message, 2-12, 6-10 to 6-12 

sheet indicators, 5-6 
single drive system, 1-4 to 1-5, 

6-5, F-5 
Single Drive System, F-5 
single space, 5-4, 5-10, 

F-l 
size percentage, 3-15 
skeleton, B-1 
space bar, 3-11, 4-5, A-4, B-2 
Special Function Keys, 2-14 
Splitting the Screen Into Two 

Parts, 4-23 
spool: To simultaneously print 

one document and edit 
another. Spooling 
temporarily saves a 
document on disk, then 
feeds it to a printer 
while you do other 
VisiWord functions. 

Spool option, 2-7 to 2-8, 
6-5 to 6-6 

spool path, 3-5, 3-10, F-l, 
F-3 to F-5 

spooling, 6-5 to 6-6 
spreadsheet, C-l 
standard equipment, 1-5, A-3, 

F-3 
Standard Startup Settings, F-l 

to F-2 
Start-new-product option, 2-7 

to 2-8, 2-19 
startup format settings, 3-3, 

3-26 to 3-27, 5-3 to 5-4, 
F-l 

startup setting file name, 3-27, 
F-3 
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stop: A mark(!) on the Ruler 
indicating the columns 
where the cursor will 
move to when you 
press Tab, Decimal Tab 
(CEJ]), or Indent (c:EI)). 

stop, 
printing, 6-4, 6-9 
spooling, 6-6, 6-9 
symbol, 2-11, 5-15, 5-18 

Stopping the Printer, 6-9 
store: To put (save) a 

document on a data disk 
for later retrieval. 

Storage menu 
Append option, 3-21 
Default option, 3-26 to 3-27, 

F-2 to F-3 
Include option, 3-23 to 3-24 
Load option, 3-8 to 3-10 
Maintenance menu, 2-17 to 

2-18, 3-11 to 3-17, 
F-3 to F-5 

Save option, 3-5 to 3-7 
storage screen, 3-6 
string: A sequence of 

characters. 
string, 4-19 to 4-22, 0-4 
subscript, 5-28, 5-31, 7-6 to 

7-7 
superscript, 5-28, 5-31, 7-6 to 

7-7 
Supported Printers, A-3 
Switch option, 2-7 to 2-8, 4-24 

to 4-27 

T 
tab: To move the cursor to the 

next stop (!) on the Ruler. 
In the VisiWord program, 
tabbing only moves the 
cursor on a line that 
contains text. On a blank 
line, tabbing inserts spaces 
into the text. 

tab, 2-11, 2-14, 3-3, 4-3 to 4-5, 
5-5, 5-15, 5-24 

Table of Special Function 
Keys, 2-14 

Tab key, 2-15, 4-3 to 4-5, 5-5, 
5-24 

tab stop, 2-11, 5-5, 5-15, 5-24 
temporary file, 6-5, 6-6 
temporary left margin, 4-7, 

5-24 
text: A set of characters. In the 

VisiWord program, you 
can delete, copy, and 
move text. 

text buffer: An area in 
computer memory that 
can contain lines of text 
deleted from the editing 
screen using the Delete 
Line key (CE[)) or 
Delete EOL key (a::ID). 

text 
buffer, 4-13 
copying, 4-14 to 4-15, 4-25 

to 4-27 
deleting, 4-11 to 4-13 
moving, 4-16 to 4-18, 4-25 

to 4-27 
wraparound, 4-6 

Text References to the 
Keyboard and the Screen, 
xiv 

Text Wraparound, 4-6 
theta (9), 2-12, 5-6, 
top margin, 6-13 to 6-17 
transmission bits, A-5 to A-6 
Type-In option, 2-7 to 2-8, 

3-7, 3-17 
typeover, 2-15 to 2-16, 4-7 to 

4-8 
Typical VisiWord Menu: the 

Print Menu, 2-9 

U 
undelete, 1-6, 2-14, 4-7, 4-13 
Undelete key C£:ID, 1-6, 

2-14, 4-7, 4-13 
underline, 2-14, 2-16, 5-28, 

5-30, 7-4 to 7-5, 
Underline key, 2-14, 2-16, 

5-28, 5-30 
Underline option, 5-28, 5-30 
Underlining Text, 5-30 



up arrow, 3-7, 3-20, 4-23, 5-8, 
5-10, 6-17 

upper case letters, 3-13, 4-19, 
4-21 

Usage option, 2-7 to 2-8, 3-15 
to 3-16 

Using a Form Document 
Frequently, 3-25 

Using Boldface (Emphasis), 
5-29 

Using Hyphens, 5-33 
Using Setup Strings, 6-18 
Using Superscripts and 

Subscripts (Above and 
Below), 5-31 

Using the Format Sheet, 5-7 
Using the Ruler, 5-15 
Using the Underline Key CEID, 

5-30 
Using the Underline Menu 

Option, 5-30 
Using the VisiCalc File, C-1 
Using the VisiWord Program 

with the VisiCalc 
Program, C-1 

Using the VisiWord Program 
with the VisiFile Program, 
B-1 

Using Your Own Startup 
Format, 3-26 

Using Your Printer, A-3 

V 
Viewing All Document Names 

on a Disk, 3-17 
Viewing Document Size, 3-15 
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VisiCalc program, 2-19, C-1 
VisiFile program, 6-7, B-1 
VisiSpell option, 2-7 to 2-8 
VisiWord Document, 1-3 
VisiWord Features and 

Benefits, 1-4 
VisiWord Learning Tools, xi 
VisiWord Menu Structure, 2-7 

to 2-8 
VisiWord Screen After 

Loading, 2-3 
VisiWord Startup Layout 

Settings and Range of 
Possible Settings, 5-4 

VisiWord Startup Settings, F-1 

W 
warnings, 0-1 
Where to Define Headers and 

Footers, 5-40 
window, 4-23 to 4-27 
Windows menu, 2-7 to 2-8 

Clear option, 4-27 
Close option, 4-28 
Open option, 4-23 to 4-24 
Switch option 4-24 to 4-27 

word processor, 1-3 
wraparound: Automatic 

movement of text from 
one line to the next 
line as it's being 
entered. 

wraparound, 4-6 

Y 
Your Document Format, 5-3 
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Please tell us how you rate this manual in the following areas: 
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VISIWORDTM SETUP INFORMATION GUIDE 

If you own the IBM® Personal Computer XT, you can load the VisiWord pro­
gram either from the flexible disk or from the fixed disk . The VisiWord 
QuickStart™ Course tells you how to load the program from the flexible disk . 
We recommend, however, that you install (copy) the VisiWord program onto 
the fixed disk and load the program from the fixed disk . The program will run 
faster and be more convenient to use. 

To install the VisiWord program on your fixed disk: 

1. Follow the instructions in the IBM Disk Operating System manual to ini­
tialize your fixed disk, and install and load the DOS 2.0 program onto the 
disk. 

2 . The C> prompt appears. If you installed the DOS program onto a different 
fixed disk drive (named d:, e:, or the like), that drive letter shows in place 
of the C. Substitute that drive letter for C on all of the remaining instruc­
tions in this guide . 

3 . If you want to put the VisiWord program in its own directory on the disk, 
use the MKDIR command to create the directory. Then use the CHDIR 
command to transfer into that directory. The MKDIR and CHDIR com­
mands are explained in the IBM Disk Operating System manual. 

4. Type a: and press w. 
5. Put the VisiWord program disk in the flexible disk drive . 

6. From the A> prompt, type install c:. (Remember to substitute the alternate 
drive letter if necessary.) Press w . 

7. Wait while the VisiWord files are copied to your fixed disk . When the pro­
cedure is finished, the message VisiWord installation completed appears . If 
the message VisiWord installation failed appears, repeat step 6, being careful 
to type the correct drive letter. 

Now that you have installed the program, store the VisiWord program disk in a 
cool, dry place for safekeeping. Load the VisiWord program by following the 
steps below: 

1. With the DOS A> prompt showing, type C:VW. Press w . If you installed 
the program in its own directory (see step 3 above), each time you load the 
program from now on you must first use the CHDIR command to transfer 
into the VisiWord directory. 

2. After a minute, the VisiWord screen appears. 

Now turn to the VisiWord QuickStart Course. Follow the step-by-step instruc­
tions to learn to use the VisiWord program. 

Throughout the VisiWord QuickStart Course and the VisiWord User's Guide, 
the IBM Personal Computer XT fixed disk is referred to as the hard disk. 
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